About Author and ITECS Staff

Ellen McDaniel, Ph.D.  Manager of User Services and Web Coordinator, College of Engineering, North Carolina State University

ITECS Staff  Information Technology and Engineering Computer Services, College of Engineering, North Carolina State University
Box 7901, 200 and 213 Page Hall
(919) 515-2458; eoshelp@ncsu.edu
http://www.eos.ncsu.edu

Thomas K. Miller III, Assoc. Dean, Distance Education/Information Technology
Keith Boswell, Director
Charles Hunt, Assistant Director
Tony Baumann, Computer Consultant, Student-Owned Computing
Billy Beaudoin, Systems Programmer
Gary Gatling, Systems Programmer
Rob Grau, Systems Programmer
Troy Hurteau, Web Programmer
Steven Jones, Systems Programmer
Robbie Little, Software Manager
Kathy Mayberry, Coordinator, Student-Owned Computing
Richard McLane, Systems Programmer
Chris Muller, Eos Lab Manager
Edie Nowell, Administrative Assistant
Lin Osborne, Systems Programmer
Jeremy Phillips, Applications Analyst/Programmer
Kristi Reich, Help Desk Manager
Josh Thompson, Systems Programmer
Only connect...
E. M. Forster, Howards End

No matter where you go, there you are.
Buckaroo Banzai

The Adventures of Buckaroo Banzai Across the Eighth Dimension
Contents

Introduction and Acknowledgments .................................................. xv

Chapter 1: Accounts and User Resources ........................................... 1

  Account Activation ................................................................. 1
  Account Deactivation ............................................................. 1
  Privileges .................................................................................... 2
  The Unity ID ............................................................................. 3
  Passwords .................................................................................. 3
  Account Security and User Policies .............................................. 4
  Getting Help .............................................................................. 4
  Using Your Own Computer to Access Your Account and Resources .. 5
  Sysnews, User Lookup, and Quota Manager .................................. 6
  Problem Tracking in Remedy ....................................................... 9
  What’s in a Name? Eos or Unity? .................................................. 9

Chapter 2: Labs and Policies ............................................................... 11

  Unity Lab Policies ....................................................................... 11
  Unity Lab Schedules, Workstations, and Printers ......................... 12
  Eos Lab Schedules, Workstations, and Printers ............................. 13
  Eos Lab Policies ....................................................................... 14
  Other Labs ................................................................................. 15
  Accessibility ............................................................................... 15
  College and Department Labs ..................................................... 16

Chapter 3: Logging In/Out ................................................................. 17

  Logging In .................................................................................. 17
  Logging Out ............................................................................... 17
  Why Log Out ............................................................................. 18
  How to Log Out ........................................................................ 18
  Shutting Down .......................................................................... 18
  Troubleshooting Login and Session Problems .............................. 19
  Can’t Login: Forgot Unity ID or Password .................................... 19
  Can’t Login: Restricted Labs ....................................................... 19
<table>
<thead>
<tr>
<th>Chapter 4: First Look: The User Interface</th>
<th>23</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphical User Interfaces and Windowing Environments</td>
<td>23</td>
</tr>
<tr>
<td>Sun Solaris: X, fvwm2, and Command Shell</td>
<td>24</td>
</tr>
<tr>
<td>Microsoft Windows XP and Novell</td>
<td>25</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux and GNOME</td>
<td>26</td>
</tr>
<tr>
<td>Common and Custom Configuration</td>
<td>27</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 5: Home Directory, or K: Drive</th>
<th>29</th>
</tr>
</thead>
<tbody>
<tr>
<td>User File Space</td>
<td>29</td>
</tr>
<tr>
<td>Location of User Home Directories</td>
<td>29</td>
</tr>
<tr>
<td>Accessing Your Home Directory</td>
<td>30</td>
</tr>
<tr>
<td>Command Line Access on Solaris and Linux</td>
<td>30</td>
</tr>
<tr>
<td>Drive and Folder Access on Windows and Linux</td>
<td>34</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 6: Software Applications</th>
<th>37</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solaris Applications</td>
<td>37</td>
</tr>
<tr>
<td>Application Menu</td>
<td>37</td>
</tr>
<tr>
<td>The add Command</td>
<td>38</td>
</tr>
<tr>
<td>Background and Foreground Processes</td>
<td>39</td>
</tr>
<tr>
<td>The realmlocate Command</td>
<td>40</td>
</tr>
<tr>
<td>Microsoft Windows Applications</td>
<td>40</td>
</tr>
<tr>
<td>Novell Application Launcher</td>
<td>40</td>
</tr>
<tr>
<td>The Start Menu</td>
<td>42</td>
</tr>
<tr>
<td>Fixing Applications with Verify</td>
<td>42</td>
</tr>
<tr>
<td>Processes and the Task Manager</td>
<td>42</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux</td>
<td>42</td>
</tr>
<tr>
<td>Documentation and User Manuals</td>
<td>44</td>
</tr>
<tr>
<td>Commercial and Non-Commercial Software</td>
<td>44</td>
</tr>
</tbody>
</table>
Symantec's Norton AntiVirus .................................................. 69
PureMessage ................................................................. 69

Chapter 9: Safe Computing ...................................................... 71
Do's and Don'ts of Safe Computing ......................................... 71
Know the Risks ................................................................. 72
Take Precautions .............................................................. 73
Keep Your Secrets ............................................................. 73
Stay Legal ........................................................................... 74
Where to Get Help ............................................................. 74

Chapter 10: Wolfware .............................................................. 75
courses.ncsu.edu ................................................................. 75
Finding Your Wolfware Classes and Links ................................. 76
Home Page ........................................................................ 77
Message Board ................................................................... 77
Submit Assignments ................................................................ 78
Wolfware Class Mail ............................................................ 80

Chapter 11: Directories and Paths ............................................ 81
Directories in AFS .................................................................. 81
Directories and Subdirectories .................................................. 81
Lockers: A Special Directory .................................................. 81
Paths: Absolute and Relative .................................................. 82

Chapter 12: Working with Directories and Folders ..................... 85
Directory Commands for Solaris and Linux ................................. 85
Make Directory (mkdir) ......................................................... 85
Change Directory (cd) .......................................................... 85
List Files in a Directory (ls) ..................................................... 86
Copy Directories .................................................................. 87
Remove Directory (rmdir) ....................................................... 87
The add and attach Commands ............................................... 87
Getting Technical: What Happens When You add and attach .... 88
Windows Directory Manipulation ............................................. 89
Windows Explorer .................................................................. 89
Make Folder ......................................................................... 89
Finding Folders ................................................. 90
Manipulating Folders and Shortcuts ......................... 90
Deleting Folders ............................................. 91
Linux Directory Manipulation ................................... 92

Chapter 13: Working with Files ................................. 93

UNIX Commands on Solaris and Linux ............................ 93
  Display File Commands (more, less) .......................... 93
  Concatenate Files (cat) .................................. 94
  Copy Files (cp) ........................................ 94
  Move Files (mv) ........................................ 95
  Remove Files (rm) ...................................... 95
Windows File Manipulation ........................................ 96
  Windows Explorer and Search ................................ 96
  Copy and Paste .......................................... 96
  Cut and Move ........................................... 97
  Rename Files ........................................... 97
  Remove/Delete Files ..................................... 97
  File Properties .......................................... 97
Linux File Manipulation ........................................ 97

Chapter 14: Working on UNIX ................................. 99

Operating Systems ............................................. 99
The UNIX Operating System ................................... 99
Command Options and Arguments ............................... 100
File Naming ..................................................... 100
Shortcuts and Operators ....................................... 102
  Copying and Pasting Between Windows ..................... 102
  Completing Command Entry with Typing .................. 102
  Repeating Commands with Typing ........................... 102
  Aliases ...................................................... 103
  Useful Key Combinations .................................. 103
  Wildcards and Metacharacters ............................... 104
  Redirection of Input and Output ............................. 104
  Pipes and Pipelines ....................................... 105
UNIX Man Pages .............................................. 105
The C Shell .................................................... 107
Setting Variables ............................................. 107
  Environment Variables (printenv, setenv) .................. 107
<table>
<thead>
<tr>
<th>Chapter 15: AFS File Sharing</th>
<th>111</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client/Server Computing</td>
<td>111</td>
</tr>
<tr>
<td>Distributed File Systems</td>
<td>111</td>
</tr>
<tr>
<td>Cells and Sites</td>
<td>112</td>
</tr>
<tr>
<td>Volumes and Mount Points</td>
<td>112</td>
</tr>
<tr>
<td>Volume Quotas</td>
<td>114</td>
</tr>
<tr>
<td>Cache Manager</td>
<td>114</td>
</tr>
<tr>
<td>AFS Security and Tokens Access Control Lists</td>
<td>115</td>
</tr>
<tr>
<td>UNIX and AFS</td>
<td>115</td>
</tr>
<tr>
<td>Access Control Lists</td>
<td>116</td>
</tr>
<tr>
<td>Levels of Access</td>
<td>116</td>
</tr>
<tr>
<td>Viewing ACL Permissions</td>
<td>118</td>
</tr>
<tr>
<td>Setting ACL Permissions</td>
<td>118</td>
</tr>
<tr>
<td>Sharing Information with Groups</td>
<td>119</td>
</tr>
<tr>
<td>AFS on Windows</td>
<td>121</td>
</tr>
<tr>
<td>OpenAFS</td>
<td>124</td>
</tr>
<tr>
<td>AFS Glossary</td>
<td>125</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 16: Publishing Your Web Pages</th>
<th>127</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the WWW Setup Utility</td>
<td>127</td>
</tr>
<tr>
<td>Creating a ~/www Directory and Setting Access Permissions</td>
<td>127</td>
</tr>
<tr>
<td>Grant lookup permissions to your home directory</td>
<td>128</td>
</tr>
<tr>
<td>Create a subdirectory in your home directory called www</td>
<td>128</td>
</tr>
<tr>
<td>Change directories to your www directory</td>
<td>128</td>
</tr>
<tr>
<td>Grant lookup and read permissions to your www directory</td>
<td>129</td>
</tr>
<tr>
<td>Create your HTML files in the www directory, or move them there</td>
<td>129</td>
</tr>
<tr>
<td>Shorthand Access to Your URL</td>
<td>129</td>
</tr>
<tr>
<td>Responsibility for Web Pages</td>
<td>129</td>
</tr>
<tr>
<td>Creating HTML Documents</td>
<td>130</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 17: Storage and Backup</th>
<th>133</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Platform</td>
<td>133</td>
</tr>
<tr>
<td>Solaris and Linux Platforms</td>
<td>134</td>
</tr>
<tr>
<td>Floppy Drives and mtools</td>
<td>134</td>
</tr>
<tr>
<td>Mounting Floppy Disks on Linux</td>
<td>136</td>
</tr>
</tbody>
</table>
Zip Drives .......................................................... 137
CD Drives ......................................................... 138
  Sun Solaris Lab Workstations .............................. 138
  Red Hat Linux Lab Workstations ......................... 139
USB Drives and Smart Card Reader .......................... 139
Tar and Compress Files .......................................... 141
Reallocating your AFS, IMAP, and Novell Storage Space ... 141
Restore from Backup ............................................. 142
  How and When Backups are Made .......................... 143
  Restoring Your Own Lost Files .............................. 143
Request a Restore ................................................ 145
Conserving Quota ................................................ 145

Chapter 18: Remote Access Services. .............................. 147
  ResNet .......................................................... 147
  Wireless Networking on Campus ............................. 147
  Remote Access Connections ................................ 149
  Web-based Resources ......................................... 149
  Remote Access Servers ....................................... 150
Secure File Transfer ............................................. 150
  From Linux and Macintosh .................................. 151
  From Windows ................................................. 151
Secure Access to Command-Line and Graphical UNIX/Linux Applications ... 152
  From Linux .................................................. 153
  From Macintosh OS X ....................................... 153
  From Windows ............................................... 154
Virtual Computing Lab .......................................... 156
  VCL Resources ............................................... 156
  How to Reserve an Application in VCL .................... 157
Batch Processing ................................................ 158
OpenAFS .......................................................... 159
Student-owned Computing ...................................... 160

Appendix 19: Command Summary ................................. 161

Appendix 20: Application Software: What Runs Where? ............ 165
  Vendor, Version, License, and Platform .................... 165
  Description, Availability, and Instructions for Use ........... 168
  Access Database Management, Microsoft Corporation .......... 168
Acrobat PDF Publisher, Adobe Systems Incorporated .......................... 169
ADAMS Mechanical System Simulation, MSC Software, Inc. .............. 169
Adobe Creative Suite 2, Adobe Systems Incorporated ...................... 170
AMPL Modeling Language, ILOG, Inc. ........................................ 170
ANSYS Finite Element Analysis, Mallett Technology, Inc. ................. 171
ARC/INFO Geographic Information System Toolkit, ESRI .................. 171
ArcView Geographic Information System Toolkit, ESRI ....................... 172
ARENA Simulation System, Rockwell Software, Inc. ......................... 172
AspenONE Engineering Suite, Aspen Technology, Inc. ....................... 173
AutoCAD Computer-Aided Design, Autodesk, Inc. ............................ 173
AutoMod Simulation Software, Brooks Automation, Inc. .................... 174
AVR Studio Microcontroller Development, Atmel Corporation ............... 174
Cadence Circuit Design Toolkit, Cadence Design Systems, Inc. .......... 175
CADRA Computer-Aided Design, SofTech, Inc. ............................... 175
COMSOL Multiphysics, COMSOL, Inc. ........................................ 175
COSMOS Design Analysis for SolidWorks, SolidWorks Corporation .... 176
CPLEX Linear Optimizer, ILOG, Inc. ............................................ 177
Data Explorer Visualization and Analysis, IBM, Inc. ......................... 177
Dreamweaver Web Editor, Adobe Systems Incorporated ...................... 178
Excel Spreadsheet, Microsoft Corporation ...................................... 178
Fireworks Web Graphics, Adobe Systems Incorporated ...................... 179
Flash Web Animation, Adobe Systems Incorporated ........................ 179
FORTRAN 90 and 95 NAGware Compilers, Numerical Algorithms Group ... 179
FrameMaker Word Processor and Publisher, Adobe Systems Incorporated 180
HSPICE Electronic Circuit Simulator, Synopsys, Inc. ......................... 181
Interactive Chemical Process Principles, Felder and Rousseau .......... 181
Java Development Kit (JDK), Sun Microsystems, Inc. ....................... 182
JMP Statistical Discovery Software, SAS Institute, Inc. ......................... 183
LIFT for Dreamweaver, UsableNet, Inc. ........................................... 183
LINDO/LINGO Optimization, LINDO Systems, Inc. .......................... 184
LSF Load-Sharing Facility, Platform Computing, Inc. ......................... 184
Maple Symbolic Math Computation, Maplesoft, division of Waterloo Maple, Inc. 185
Mathcad Calculation and Documentation, Mathsoft, Inc. ...................... 185
Mathematica, Wolfram Research, Inc. ............................................. 186
Mathtype Equation Editor for Office, Design Science, Inc. ................ 186
Microstation, Bentley Systems, Inc. ............................................... 188
Moldflow Plastics Advisers, Moldflow Corporation .............................. 188
NExS Scientific and Engineering Spreadsheet, GreyTrout, Inc. .......... 188
Office XP, Microsoft Corporation ................................................. 189
OPNET Network Management and Modeling, OPNET Technologies, Inc. 189
Photoshop CS2 Image Design, Adobe Systems Incorporated ............... 190
PowerPoint Presentation Graphics, Microsoft Corporation .................. 190
Primavera Project Planner, Primavera Systems, Inc. .......................... 191
Pro/ENGINEER Wildfire, Pro/MECHANICA Computer-Aided Design
Parametric Technology Corporation .............................................. 191
Project, Microsoft Corporation .................................................. 192
RSLogix Logic Programming, Rockwell Software, Inc. ...................... 192
SAS Data Analysis Applications, SAS Institute, Inc. ........................ 193
SlickEdit Editor, SlickEdit, Inc. .................................................. 193
SolidWorks Computer-Aided Design, SolidWorks Corporation ......... 194
StarOffice Office Applications, Sun Microsystems, Inc. ..................... 194
SuperPro Designer, Intelligen, Inc. .............................................. 195
SURFCAM Velocity II CAD/CAM, Surfware, Inc. ............................... 195
Symantec Norton AntiVirus Corporate Edition, Symantec Corporation 196
Synopsys Digital Circuit Synthesis - University Tools, Synopsys, Inc. 196
Tecplot Interactive Plotting, Tecplot, Inc. 196
Timberline Estimating Software, Sage Software 197
TK Solver Plus Equation Solver, Universal Technical Systems, Inc. 197
Visio Professional, Microsoft Corporation 197
VisualAge Smalltalk, IBM, Inc. 198
Visual MODFLOW Pro, Waterloo Hydrogeologic, Inc. 198
Visual Studio .NET Application Development, Microsoft Corporation 199
WaterCAD Computer-Aided Design, Haested Methods 199
Word Document Processor, Microsoft Corporation 200
X-WIN32 X Windows Application Server, Starnet Communications 200

Glossary of Terms for Eos/Unity Computing 201

Index 209
Introduction and Acknowledgments

Guide to Eos and Unity Computing, 2006-07 Edition for UNIX, Windows, and Linux is the principal user manual for the distributed academic computing environment at North Carolina State University. Formerly a College of Engineering system only, Eos was made available to other NCSU colleges in 1996 in a project called Unity. Today, all NCSU students, faculty, and staff receive accounts on a fully merged campus-wide system, or realm, often referred to as Eos/Unity.


The current guide, Guide to Eos and Unity Computing: 2006-07 Edition for UNIX, Windows, and Linux, introduces the Virtual Computing Lab (VCL) for remote access from labs, offices, and individually owned computers to software applications running natively on VCL computers.

This guide is written in collaboration with staff from the College of Engineering’s Office of Information Technology and Engineering Computer Services (ITECS), see About Author and ITECS Staff. In addition to being a general user manual for Eos/Unity, this guide also supports instruction in the lab course, E115: Introduction to Computing Environments taught by the Department of Computer Science. I would like to thank Tom Nelson and Jason Maners for their ongoing assistance.

Special thanks go to the College of Engineering (COE) Computer Committee, Thomas K. Miller, current Vice Provost for Distance Education and Learning Technology Applications, and William E. Willis, former Vice Provost for Information Technology, for their vision in building the original Eos system. Tom Miller and Sam Averitt, Vice Provost for Information Technology, also have my thanks.
for their ongoing support of this guide, along with Keith Boswell, Director of ITECS, and Charles Hunt, Assistant Director of ITECS.

I would also like to thank the staff of NCSU's Information Technology Division (ITD) for the information and assistance they provided, which helped to make this manual more complete and comprehensive. I can no longer name all the people who have helped; the list has grown too long over the years. Troy Hurteau has been my close partner in putting this guide online with our move to XML-based publishing. Thanks also to Tim Lowman for the original *Hitchhiker's Guide to the Eos System*, to Marshall Brain for the first online Eos tutorials, and to the CSC staff and lab TAs who maintain the *E115 Lab Manual*. These guides provided the first information on the system, and their authors' contribution to the education of our users is gratefully acknowledged.

Of course, the system would not exist at all without the creative and diligent work of IT staff across campus, particularly in ITD and ITECS. These people provide the vision, development, maintenance, and support for a system that changes daily.

The guide is written in Adobe *Framemaker 7.2*, which provides a structured authoring environment to produce XML. *DocFrame 2.0* from Scriptorium Publishing Services, Inc., is the book template the guide uses for structure, formatting, and XML import/export.

The cover for this book is the work of Lou Harrison. I am lucky to have his permission to use the compelling image, *Thru the Wall*, at http://lts.ncsu.edu/harrison/Artistic.html. I would also like to acknowledge the print, software, and web sources I used in the writing of this manual:


*Computing @ NC State*, Information Technology Division, http://www.ncsu.edu/it/essentials/


*E115 Lab Manual*, http://courses.ncsu.edu/e115/common/text/

Please contact me with any corrections or suggestions for the guide at mcdaniel@ncsu.edu.
1 Accounts and User Resources

Over 40,000 students, staff, and faculty have accounts on the NCSU Eos/Unity computing system, or *realm*. Before 1996, *Eos* (engineering) and *Unity* (NCSU) accounts were separate. Today, *Eos/Unity* is a fully merged network realm, requiring only a single account. What people call an Eos or Unity account is one and the same. However, because accounts are created at the university level, *Unity account* has become the preferred name and the one used in this guide.

**Account Activation**

NCSU Enrollment Management and Services (EMAS) and the Information Technology Division (ITD) create campus ID numbers and computer accounts for all users. A Unity account is created for an individual upon registration as a student or employment as staff or faculty.

New student accounts are generated before New Student Orientation and are fully activated before the beginning of the semester so students can register for classes. Accounts remain active as long as students are registered, including over summer if pre-registered for fall, and for four months after graduation.

New accounts for faculty and staff are automatically generated when their employee information appears in the Human Resources (HR) database. Accounts remain active for the duration of faculty and staff employment.

Time-limited guest accounts are authorized on a case-by-case basis by department heads and systems personnel.

**Account Deactivation**

Student accounts are deactivated on census day (the last day of drop-add) of the first semester that a student is not registered. Accounts are deleted one year after deactivation. For example, if a student is not registered by census day of the spring semester, his or her account will be deactivated. If that student is also not registered by the following fall semester's census day, the account is deleted. Summer sessions are not counted, only fall and spring semesters.

Accounts for faculty and staff are automatically deactivated when an individual is no longer on the University payroll. They are deleted one year after deactivation.
Users with deactivated accounts cannot log in to workstations, web pages, or remote servers, or have access to the files stored in their account. After one year of deactivation, the account is deleted and cannot be recovered. If users anticipate leaving the university for any period of time, they need to copy to alternative storage any files they wish to keep.

**Privileges**

Unity accounts provide users with access to many resources, including:

* 150MB of file space divided into three storage locations, 50MB in AFS home directory (K: drive), 50MB in IMAP mail, and 50MB in Novell (M: drive).
* 150MB additional storage for a total of 300MB allocated as the user wishes through the Quota Manager at [http://sysnews.ncsu.edu](http://sysnews.ncsu.edu).
* Nightly backup of the user storage locations.
* Email and instant messaging services.
* Delivery of personal web pages.
* High-speed wired and wireless Internet access on campus.
* Workstation labs with high-speed Internet in the library, residence halls, and academic buildings.
* Application software in labs, classrooms, and via remote access.
* Subscription academic resources, e.g., library databases, journals, newspapers, government documents, etc.
* Networked printing, see [http://print.ncsu.edu](http://print.ncsu.edu).
* Help desks ([help@ncsu.edu](mailto:help@ncsu.edu)) and support services.
* Remote access services.

If preregistered for fall, students also have access to all resources over summer without paying a fee. They also have free access to e-mail and AFS space for four months after graduation. See also:

[http://www.ncsu.edu/it/essentials/your_unity_account/loginid.html](http://www.ncsu.edu/it/essentials/your_unity_account/loginid.html)

For additional information on student accounts, see:


For additional information on faculty, staff and guest accounts, see:

The Unity ID

Once employed or admitted as a student, users are issued a unique Unity ID and password to use in logging in to secure campus web pages, lab workstations, and other computing resources. The Unity ID is referred to by many names, e.g., username, login name, login ID, userid, etc. The Unity ID is also used for the user’s NCSU email address, e.g., unityid@ncsu.edu.

The Unity ID is generally composed of a person’s first and middle initials and first six characters of his/her last name. For example, if the user's name is John Q. Public, his username would be jqpublic. Common names may have numbers added, e.g., jouser, jouser1, jouser2, etc.

To log in, the user types his or her Unity ID and password in the login and password fields of a workstation or web page without capitalization or spaces.

Users who do not know their Unity IDs should contact help@ncsu.edu, 515-HELP (4357), or come to the Help Desk in 208 Hillsborough Building.

Passwords

If you never used your Unity account before October 13, 2004, your initial (default) 8-digit password is the last four digits of your Campus ID number (follows the letters "NCSU" on your All Campus Card), plus the four digits of your birth month and day. For example, if your Campus ID number ends in 1234 and your birthday is January 31, your initial password is 12340131. If you used your Unity account before October 13, 2004, your password remains the same. However, if you ever need to have your password reset, it will be set to the new format.

To prevent unauthorized access to their files, users should change the initial Unity passwords they are given to passwords they choose themselves. Go to:

http://www.ncsu.edu/password/

Password changes take up to an hour to take effect. Follow the guidelines below in choosing a password and maintaining account security, see

http://www.ncsu.edu/it/essentials/antivirus_security/safe_computing.html

* Change your password regularly, at least once a semester.

* Choose a password that is 6-14 characters long. Use some combination of letters, numbers, special characters, and uppercase and lowercase letters. Passwords are case sensitive.
* Do not use names of family members, your Unity ID, words commonly associated with you, or anything that can be easily guessed or found in the dictionary.
* Do not write down your password but be sure to memorize it.
* Never tell anyone your password, which would enable them to access your account and mail. Account sharing is a policy violation, see http://www.ncsu.edu/policies/informationtechnology/REG08.00.2.php.

If you forget your password, go to the Help Desk in 208 Hillsborough Building (see Getting Help). Please have your NCSU ID with you. System administrators cannot find out your old password for you. Rather, they reset your password to a new one, which you must then change again to a password of your choosing.

If you are a distance student or faculty/staff member working too far away to visit campus, contact the Help Desk for the procedures they require for password resets.

**Account Security and User Policies**

Because campus computing facilities can only support the number of users they were designed for, access to Eos/Unity resources is restricted to NCSU faculty, staff, and fee-paying students only. **Users must never share the passwords to their accounts with anyone!** Users also need to stay aware of and follow the policies that protect individual and campus use of NCSU computing resources. Consult the published policies at the web sites below, taking particular note of the ramifications for policy violations.

http://www.ncsu.edu/it/rulesregs/
http://www.ncsu.edu/it/rulesregs/violations/itd-sop.html
http://www.ncsu.edu/it/essentials/antivirus_security/

**Getting Help**

There are a number of resources available to help users learn and use the Eos/Unity environment, from documentation to one-on-one support from campus IT staff.

The following are support services from the Information Technology Division (ITD), available to all NCSU students, faculty, and staff. Also listed are services provided by Information Technology and Engineering Computer Services (ITECS) in the College of Engineering.

Manual Guide to Eos and Unity Computing, in NCSU Bookstores
Also online at http://www.eos.ncsu.edu/guide/
Using Your Own Computer to Access Your Account and Resources

Because of the extensive computing resources on campus, which have been developed over many years, NCSU does not have a computer-ownership requirement for students. Students can access computers 24x7 in labs, residence halls, and other locations to run the academic and productivity software they need for their classes and projects.

However, more and more students come to campus with personal computers. A 2004 survey of incoming freshmen in engineering showed that 97% of them were bringing a computer, and more than 70% of these computers were laptops. These students want to know more about how to use their own computers to connect to campus resources. The following web site addresses what computers are recommended in the different colleges and how to use them to work from home or via the campus wireless network, see

http://www.ncsu.edu/it/essentials/your_computer/hardware_specs/

Students who have their own computers have some advantages over those who do not. They are able to run software bundled with textbooks, or which their instructors may distribute or require. They can also install software of their choosing, which is not permitted on university-owned computers. As more application software becomes available via remote-access services, students can work wherever they want without having to go to a lab. These students can also take their comput-
ers home with them during summer and holidays to stay connected to campus resources that are available year-round (see Remote Access Services).

For these reasons, the College of Engineering has recommended since 2001 that students own or have access to a personal computer. In fall 2006, the college expects all incoming undergraduate students to have a laptop computer that meets college specifications. The laptops that students bring need to run a current operating system. However, hardware vendors can vary because of the open platform model the college has adopted, see http://www.eos.ncsu.edu/soc/.

Special prices for laptops have been arranged with IBM, Dell, and Apple. These laptops are available for purchase by any NCSU faculty, staff, or student, not just engineering, see http://www.eos.ncsu.edu/soc/purchasing.php

Also this fall, E115: Introduction to Computing Environments, a required course for all COE students, will focus on students taking personal responsibility for their own computers, maintaining them, and interfacing effectively with campus resources. Using their own laptops, students will learn to use remote-access services, the Virtual Computing Lab, and other resources that support their classes.

Sysnews, User Lookup, and Quota Manager

NCSU maintains an IT systems news service at http://sysnews.ncsu.edu, which users should watch for information about the system. A list of Upcoming System Events is posted to let users know of major changes, outages, enhancements, etc.

You can also get announcements particular to your college or group by selecting the More Announcements button and choosing the group you want from the pull-down menu. In the following figure, ITECS, the support department for the College of Engineering, is selected with announcements culled from that group only.

The sysnews web site also provides tools and links to help you maintain your account and access resources. An important resource at this web site is the User Info Lookup tool at the top left of the page, see following figures. Log in to this tool to see the variety of information about your Unity account, address, quotas, etc. User Lookup is the one-stop shopping site for information about your account.

New this year at sysnews is the Quota Manager, which helps you allocate an additional 150MB to any of the 50MB base quotas you have for AFS, IMAP, and Novell. This additional quota was made available in spring 2005 with the acquisition of a new enterprise storage management system for campus. For more on disk quota, http://www.ncsu.edu/it/essentials/your Unity account/disk quota.html.
Chapter 1: Accounts and User Resources

System Announcements

- Jun 27 13:50 - Change to campus mail relay virus handling
- Jun 27 08:05 - WolfWare Summer 2 Rollover Day
- Jun 24 15:28 - VoIP Service Issues
- Jun 24 14:12 - Replacement Module for PostHub UPS
- Jun 24 08:00 - NC State University Help Desk phone system
- Jun 23 19:33 - CEASIS Office on Oberlin Rd Power outage
- Jun 22 15:29 - Changes to the Kennedy 5 NAL application
- Jun 22 15:03 - Lists new e-mail
- Jun 22 10:04 - College of Engineering general remote access service
- Jun 22 09:36 - unt05 Unity file server issues

Upcoming System Events

- Jun 27 - Change to campus mail relay virus handling
- Jun 28 - Campus Linux Services Meeting
- Jun 29 - Replacement Module for PostHub UPS
- Jun 30 - Discontinued of news (NNTP) services at NC State
- Jul 01 - End of Life, Adobe Illustrator/Photoshop for Solaris
- Jul 01 - College of Engineering general remote access service
- Jul 01 - WolfWare Summer 2 Rollover Day
- Jul 05 - time services to be moved
- Jul 07 - Discontinuation of asphyxiated messaging service

All ITECS Announcements

- Jun 22 10:04 - College of Engineering general remote access service
- Jun 22 09:23 - Engineering Remote Access Service
- Jun 21 13:45 - Ceptel 11 is default for Solaris
- Jun 21 03:00 - AMSYS 9.0 to be default on 6.21 for Solaris, Linux
- Jun 02 03:00 - Engineering services degraded - Page Hall Power outage
- Jun 01 16:54 - SSL certificates updated for ITECS hosted secure web sites
- Apr 29 11:11 - ITECS web servers upgraded to PHP 4.3.11

System Tools

- My Favorites
- APS/Carbaros/Haploid
- E-Mail Tools
- Microsys Tools
- Monitoring Tools
- Networking Resources
- Operation Tools
- Other Tools
- People and Groups
- Policies
- Printing System
- Security
- Server Tools
- Software Packages
- System News
- System Tools Setup
- Systems Documentation
- User Lookups
- User Manuals

Search
### User Information

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Username:</td>
<td>mcdaniel</td>
</tr>
<tr>
<td>Full Name:</td>
<td>Ellen McDaniel</td>
</tr>
<tr>
<td>Campus ID:</td>
<td>00006</td>
</tr>
<tr>
<td>Employee ID:</td>
<td>00006</td>
</tr>
<tr>
<td>AFS cell:</td>
<td>eos</td>
</tr>
</tbody>
</table>

#### Account added
Oct 8 1990 12:00AM

#### Last Krb login
Jun 23 2006 3:44PM

(Logged in today are not included)

### AFS Quota Information

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Server:</td>
<td>engr06f.eos.ncsu.edu</td>
</tr>
<tr>
<td>Partition:</td>
<td>k</td>
</tr>
<tr>
<td>Quota Allowed:</td>
<td>125,000 K</td>
</tr>
<tr>
<td>Space Used:</td>
<td>83,778 K</td>
</tr>
<tr>
<td>Space Free:</td>
<td>41,222 K</td>
</tr>
<tr>
<td>Percent Used:</td>
<td>67%</td>
</tr>
</tbody>
</table>

### NDS Information

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Name:</td>
<td>ELLEN MCDANIEL</td>
</tr>
<tr>
<td>Profile Path:</td>
<td>MCDANIEL</td>
</tr>
</tbody>
</table>
| Profile Volume: | .ITD_PROFILE35.Services.NCSU>
| Context: | .Active-3.users |
| Disabled: | FALSE |

#### Last NDS Login

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile Quota:</td>
<td>78,643,200 bytes (75 MB)</td>
</tr>
<tr>
<td>Space Used:</td>
<td>57,073,664 bytes (54.43 MB)</td>
</tr>
<tr>
<td>Space Free:</td>
<td>21,569,536 bytes (20.57 MB)</td>
</tr>
<tr>
<td>Percent Used:</td>
<td>72.573%</td>
</tr>
</tbody>
</table>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| NDS Groups: | .itecs.everyone.ITECS.COE. 
cccadm.Hesiod.Groups.use |

### Print Quota Information

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>WolfPrint Quota Balance:</td>
<td>$4.76</td>
</tr>
<tr>
<td>NDS Print Quota Balance:</td>
<td>$4.76</td>
</tr>
</tbody>
</table>

### Hesiod Group Membership

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>cccadm</td>
<td>CCC Administrators</td>
</tr>
<tr>
<td>ecostaff</td>
<td>ITECS Staff</td>
</tr>
<tr>
<td>engrstaff</td>
<td>Engineering Staff</td>
</tr>
<tr>
<td>ncsu</td>
<td>NCSU</td>
</tr>
<tr>
<td>ncsu_staff</td>
<td>General NCSU staff</td>
</tr>
</tbody>
</table>

### Email Information

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td></td>
</tr>
<tr>
<td>IMAP Server:</td>
<td>uni29map</td>
</tr>
<tr>
<td>Total Quota:</td>
<td>100.0MB</td>
</tr>
<tr>
<td>Space Used:</td>
<td>65.6MB</td>
</tr>
<tr>
<td>Space Free:</td>
<td>34.4MB</td>
</tr>
<tr>
<td>Percent Used:</td>
<td>65.6%</td>
</tr>
<tr>
<td>Last Check:</td>
<td>Mon Jun 27 16:13:15 2006</td>
</tr>
</tbody>
</table>

#### Mail Aliases

No aliases found

### Mail Forwarding

mcdaniel@unity.ncsu.edu is not forwarded
(No expired forward requests found)
Problem Tracking in Remedy

The **Remedy Action Request System** is the application NCSU uses to track your calls to help@ncsu.edu and other help mail addresses. Computing questions mailed to help@ncsu.edu enter the Remedy call-tracking system and are reviewed by consultants at the ITD Help Desk.

The help database at http://help.ncsu.edu was built with questions sent to help@ncsu.edu and has an easy-to-use interface for searching for answers to frequently-asked questions (FAQ).

A user who sends mail to help@ncsu.edu first receives an automatic reply from The Help Desk to let him or her know that the mail was received and how to check on the call using the call-tracking number assigned to it (http://help.ncsu.edu/call-info.html). If a call cannot be handled by the consultants, or is intended for another computing group on campus, the call is placed in the work queue of that group. That group is then responsible for resolving the call.

Users who need to contact specific support groups can also mail directly into their work queues in Remedy with the workgroup@help.ncsu.edu address, e.g., regrec@help.ncsu.edu, wolfware@help.ncsu.edu, etc.

Your call will be logged, tracked, and answered in a timely fashion. If you do not hear back in a reasonable time, reply to the mail you received or enter your call number at http://help.ncsu.edu/callinfo.html to check the status of your call. If you have lost your call number, write again and let the consultants know about your previous call, which they can find in Remedy using your name and Unity ID.

Users can expect prompt and helpful assistance from consultants, but there are several ways that tracking and communication can break down. Persist when you need help, but also supply ample information about the problem you are having, where you are logged in, when, error messages, pertinent URLs, etc., to make it easier for the consultants to solve your problem. If you are writing from a non-NCSU mail address, please provide your name and Unity ID.

What’s in a Name? Eos or Unity?

**Eos/Unity**, sometimes referred to as the realm, is an expansion of the College of Engineering's Eos system. The campus-wide implementation of Eos outside of engineering is called **Unity**. Faculty, staff, and students have only one realm account, which, because it is administered centrally, has come to be called the **Unity account**.
The word *Eos* is a proper noun, not an acronym. The Project Eos computing environment in engineering is named for Eos, the Greek goddess of the dawn. It was built with technologies from the MIT Athena Project and Carnegie-Melon’s Project Andrew. Students in the former Computers and Technology Theme (CATT) dorm chose the name hoping that the project would introduce new technologies and approaches to computing at NCSU.

Users have been interested in the source of this name. Because MIT's Project Athena provided the foundational technology for Eos, many assume that Eos must follow Athena in Greek mythology. She does not.

In Greek mythology, the world began when Gaea, the Earth, bore a son, Uranus. Their union produced the first race of gods, the twelve Titans, six brothers and six sisters. The union of two of these siblings, Hyperion and Theia, produced Eos (goddess of the dawn), Helios (god of the sun), and Selene (goddess of the moon). Two other Titans, Cronus and Rhea, gave birth to Zeus. It was from Zeus' head that Athena, the goddess of wisdom and war, sprang full grown.

Eos' marriage to Astraeus, the starry sky, produced the four winds. (The former instant messenger system on Eos was named for the west wind, Zephyr.) All was well with Eos until the god Ares fell in love with her, making the goddess Aphrodite jealous. In her anger, Aphrodite cursed Eos with a “fondness” for mortal men. From that time on, Eos fell for every man she saw.

One mortal, Tithonos, she liked especially well. Eos persuaded Zeus to make Tithonos immortal so that they could live together forever. Unfortunately, she forgot to ask Zeus to grant him eternal youth. In time, Tithonos grew so old and shriveled that Zeus finally turned him into a cicada. Through it all, the saffron-robed Eos rode daily through the heavens in her purple chariot, bringing the dawn to the human world below.

*Unity* as a name does not have the same kind of history. However, as a name, it has proven to be both appropriate and well-chosen. The efforts made by campus groups to expand Eos and add services and support have unified campus computing. The excellent collaboration of these groups is responsible for maintaining the “wherever you go, there you are” environment, which has defined the user experience on Eos/Unity since its beginning.

NCSU is committed to the ongoing development of Eos/Unity to provide a rich and unified computing environment that is easily accessible to all users.
Labs and Policies

There are more than 100 public labs on campus with over 2800 workstations, most of which are realm-configured computers. Labs are located in all the places you are likely to need them, the library, residence halls, and academic buildings. Not every lab on campus is an Eos or Unity lab, so this chapter serves to help you locate the main ones. Online information is available to help you find other labs in your college or department, see http://www.ncsu.edu/it/essentials/connections_labs/

All NCSU computer and network resources are governed by the policies described at http://www.ncsu.edu/it/essentials/rules_regs.html. The following provides lab policies for Unity and Eos labs, as well as schedules, locations, equipment, etc.

Unity Lab Policies

Unity labs, workstation information, printers, and schedules can be found in the table that follows.

1 All those who use University facilities are expected to take proper care of the equipment. Any equipment malfunction should be immediately reported to staff on duty or to the organization responsible for the facility. Users of computing facilities may not move, repair, reconfigure, modify, or attach external devices to the computing systems. No food or drink is permitted in University computing facilities.

2 Recreational use of workstations in University computing labs during periods of light usage is permitted. No one may play games or engage in other recreational activities on workstations when others are waiting to use them for academic purposes. It is the responsibility of game players to recognize when resources are needed and to give up their seats to other users. It should not be necessary for someone to ask them to move.

3 Users must realize that they are in an academic facility and refrain from noise, sound effects, violent motion, etc., which may disturb others in the facility.

Individual Unity computing labs (supported by ITD) and other University-owned computing labs may post additional operational rules and restrictions, which users are responsible for reading and following. See also http://www.ncsu.edu/it/rulesregs/labs/ and http://www.ncsu.edu/it/rulesregs/violations/itd-sop.html
# Unity Lab Schedules, Workstations, and Printers

<table>
<thead>
<tr>
<th>Unity Labs</th>
<th>Mon-Thurs</th>
<th>Friday</th>
<th>Saturday</th>
<th>Sunday</th>
<th>Windows</th>
<th>Mac</th>
<th>Solaris</th>
<th>Printers</th>
</tr>
</thead>
<tbody>
<tr>
<td>104 Avent Ferry 515-2269</td>
<td>24hrs</td>
<td>24hrs</td>
<td>24hrs</td>
<td>24hrs</td>
<td>40</td>
<td>1</td>
<td>20</td>
<td>afc-104-1, afc-104-2</td>
</tr>
<tr>
<td>2413 D.H. Hill Library 515-3364</td>
<td>24hrs</td>
<td>24hrs-10pm</td>
<td>9am-10pm</td>
<td>9am-24hrs</td>
<td>31</td>
<td>4</td>
<td>12</td>
<td>dhl-2413-1, dhl-2413-2</td>
</tr>
<tr>
<td>122 Bldg. P, E.S. King Village, 515-2430</td>
<td>8am-5pm</td>
<td>8am-5pm</td>
<td>Closed</td>
<td>Closed</td>
<td>10</td>
<td>0</td>
<td>0</td>
<td>kvp-122-1</td>
</tr>
<tr>
<td>Honors Village Lab, 2nd fl Honors Common, 515-2923</td>
<td>24hrs</td>
<td>24hrs</td>
<td>24hrs</td>
<td>24hrs</td>
<td>14</td>
<td>1</td>
<td>0</td>
<td>hvc-206-1, hvc-206-2</td>
</tr>
<tr>
<td>109 Language &amp; Computer Labs (Laundry)</td>
<td>24hrs</td>
<td>24hrs-12am</td>
<td>8am-6pm</td>
<td>1pm-24hrs</td>
<td>63</td>
<td>4</td>
<td>17</td>
<td>lau-109-1, lau-109-2, scanner</td>
</tr>
<tr>
<td>119 North Hall 515-3651</td>
<td>24hrs</td>
<td>24hrs</td>
<td>24hrs</td>
<td>24hrs</td>
<td>19</td>
<td>1</td>
<td>8</td>
<td>nd-119-1, nd-110-2</td>
</tr>
<tr>
<td>103 Sullivan Hall 515-6886</td>
<td>24hrs</td>
<td>24hrs</td>
<td>24hrs</td>
<td>24hrs</td>
<td>22</td>
<td>1</td>
<td>10</td>
<td>sul-103-1, sul-103-2</td>
</tr>
<tr>
<td>1004 Tucker Hall 515-8648</td>
<td>24hrs</td>
<td>24hrs</td>
<td>24hrs</td>
<td>24hrs</td>
<td>23</td>
<td>1</td>
<td>10</td>
<td>tuc-1004-1, tuc-1004-2</td>
</tr>
</tbody>
</table>

| Total 238 | 14 | 82 | Total 334 |

**WORKSTATIONS AND PRINTERS**
## Eos Lab Schedules, Workstations, and Printers

<table>
<thead>
<tr>
<th>Engineering Eos Labs</th>
<th>Mon-Thurs</th>
<th>Friday</th>
<th>Saturday</th>
<th>Sunday</th>
<th>Windows</th>
<th>Linux</th>
<th>Solaris</th>
<th>Printers</th>
</tr>
</thead>
<tbody>
<tr>
<td>200 Daniels COE</td>
<td>24 hrs</td>
<td>24 hrs</td>
<td>24 hrs</td>
<td>24 hrs</td>
<td>0</td>
<td>18</td>
<td>0</td>
<td>dan-203-1</td>
</tr>
<tr>
<td>201 Daniels COE</td>
<td>24 hrs</td>
<td>24 hrs</td>
<td>24 hrs</td>
<td>24 hrs</td>
<td>0</td>
<td>31</td>
<td>0</td>
<td>dan-203-2</td>
</tr>
<tr>
<td>204 Daniels COE</td>
<td>24 hrs</td>
<td>24 hrs</td>
<td>24 hrs</td>
<td>24 hrs</td>
<td>4</td>
<td>26</td>
<td>8</td>
<td>dan-203-color1</td>
</tr>
<tr>
<td>255 Daniels COE</td>
<td>24 hrs</td>
<td>24 hrs</td>
<td>24 hrs</td>
<td>24 hrs</td>
<td>0</td>
<td>35</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>226 Daniels COE</td>
<td>24 hrs</td>
<td>24 hrs</td>
<td>24 hrs</td>
<td>24 hrs</td>
<td>0</td>
<td>67</td>
<td>0</td>
<td>dan-226-1</td>
</tr>
<tr>
<td>242 Daniels COE</td>
<td>7:30-10:30</td>
<td>7:30-10:30</td>
<td>24 hrs</td>
<td>24 hrs</td>
<td>24</td>
<td>0</td>
<td>0</td>
<td>dan-242-1</td>
</tr>
<tr>
<td>306 &amp; 320 Mann CE</td>
<td>8am-10pm</td>
<td>8am-6pm</td>
<td>1pm-6pm</td>
<td>1pm-10pm</td>
<td>32</td>
<td>20</td>
<td>7</td>
<td>mn-320-1 mn-320-color1</td>
</tr>
<tr>
<td>1403 Broughton MAE</td>
<td>8am-5pm</td>
<td>8am-5pm</td>
<td>Closed</td>
<td>Closed</td>
<td>51</td>
<td>5</td>
<td>0</td>
<td>br-1403-1</td>
</tr>
<tr>
<td>2408 Broughton MAE</td>
<td>8am-5pm</td>
<td>8am-5pm</td>
<td>Closed</td>
<td>Closed</td>
<td>45</td>
<td>0</td>
<td>0</td>
<td>br-2408-1</td>
</tr>
<tr>
<td>4231 Broughton MAE</td>
<td>8am-5pm</td>
<td>8am-5pm</td>
<td>Closed</td>
<td>Closed</td>
<td>0</td>
<td>0</td>
<td>27</td>
<td>br-4231-1</td>
</tr>
<tr>
<td>2114 Burlington NE</td>
<td>8am-5pm</td>
<td>8am-5pm</td>
<td>Closed</td>
<td>Closed</td>
<td>9</td>
<td>0</td>
<td>2</td>
<td>bu-2114-1</td>
</tr>
<tr>
<td>106 Park Shops IE</td>
<td>8am-5pm</td>
<td>8am-5pm</td>
<td>Closed</td>
<td>Closed</td>
<td>24</td>
<td>0</td>
<td>0</td>
<td>ps-106-1</td>
</tr>
<tr>
<td>122 Weaver BAE</td>
<td>8am-5pm</td>
<td>8am-5pm</td>
<td>Closed</td>
<td>Closed</td>
<td>14</td>
<td>0</td>
<td>5</td>
<td>dsw-122-1</td>
</tr>
<tr>
<td>1008 EB1* ChE</td>
<td>8am-5pm</td>
<td>8am-5pm</td>
<td>Closed</td>
<td>Closed</td>
<td>35</td>
<td>0</td>
<td>2</td>
<td>ce1-1008-1 ce1-1008-color1</td>
</tr>
<tr>
<td>3003 EB1* MSE</td>
<td>8am-5pm</td>
<td>8am-5pm</td>
<td>Closed</td>
<td>Closed</td>
<td>32</td>
<td>2</td>
<td>2</td>
<td>ce1-3003-1</td>
</tr>
<tr>
<td>1203a EB2* COE 513-0816</td>
<td>8am-10pm</td>
<td>8am-8pm</td>
<td>Closed</td>
<td>Closed</td>
<td>8</td>
<td>70</td>
<td>8</td>
<td>n/a</td>
</tr>
<tr>
<td>300 MRC* ECE</td>
<td>8am-5pm</td>
<td>8am-5pm</td>
<td>Closed</td>
<td>Closed</td>
<td>3</td>
<td>0</td>
<td>3</td>
<td>egrc-300-1</td>
</tr>
<tr>
<td>1906 Student Health</td>
<td>8am-5pm</td>
<td>8am-5pm</td>
<td>Closed</td>
<td>Closed</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>none</td>
</tr>
</tbody>
</table>

**Eos Help Desk:** 200 Page Hall, 515-2458  
Operator for Daniels Labs: 203 Daniels, 515-3923  
* On Centennial Campus. All other labs are on main campus.

<table>
<thead>
<tr>
<th>Total</th>
<th>Windows</th>
<th>Linux</th>
<th>Solaris</th>
<th>Printers</th>
</tr>
</thead>
<tbody>
<tr>
<td>282</td>
<td>275</td>
<td>65</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Total 622**
Eos Lab Policies

The following are policies enforced in the College of Engineering Eos labs, see also http://www.eos.ncsu.edu/policy.html

1. You may not allow any other person to use your password or share your account. It is your responsibility to protect your account from unauthorized use by changing passwords periodically and using passwords that are not easily guessed.

2. Any attempt to circumvent system security, guess other passwords, or in any way gain unauthorized access to local or network resources is forbidden.

3. Transferring copyrighted materials to or from the Eos system without express consent of the owner is a violation of federal law. In addition, use of the Internet for commercial gain or profit is not allowed from a .edu site.

4. You are expected to take proper care of the equipment in Eos facilities. Report any malfunction to the Eos operator on duty, or contact the Eos help desk by calling 515-2458 or by sending an email to eoshelp@ncsu.edu. Do not attempt to move, repair, reconfigure, modify, or attach external devices to the systems. (Headphones, USB storage devices, and accessibility equipment are exceptions to this rule.)

5. Recreational use of Eos workstations during periods of light usage is permitted. However, you may not play games or engage in other recreational use of some resources if other users are waiting to login. Use of some services for recreational use, such as remote access servers, may be prohibited altogether.

6. Use of electronic mail and other network communications facilities (such as zephyr) to harass, offend, or annoy other users of the network is forbidden.

7. Food, drink, and smokeless tobacco products are not permitted in any Eos labs. This policy is closely related to policy #4.

8. Individual Eos labs can post additional operational rules and restrictions that are considered part of the Eos User Policy. Users are responsible for reading and following these rules.

9. Owners of cell phones should exercise courtesy to those around them by taking personal calls that are longer than 15 seconds to an area away from computing facilities, preferably outside the building or in lounge areas. Ringers should be set on the lowest setting or on vibrate. Voices should be kept low when speaking so that the labs remain conducive to work and study.
Violations of policy will be treated as academic misconduct, misdemeanor, or felony as appropriate. As a standard rule, a warning will be issued upon a user's first policy violation. The user will then be asked to sign a copy of this policy statement to document that he or she understands and is willing to comply with the above policies. In general, a second violation will be referred to the Office of Student Conduct, 1115 Pullen Hall, Box 7321, at which point the user will work with persons from the Office of Student Conduct to resolve the policy violation.

Vandalism, theft, harassment, security violations, and misuse of computing resources are grounds for dismissal from the University. Computers are for academic use only. No commercial use of resources is permitted.

Other Labs

Several colleges and departments maintain computing labs for their students, which may or may not be available to the campus at large. You will need to contact the college or department to find out if you can use the lab.

http://www.ncsu.edu/it/essentials/connections_labs/campus_computer_labs/campus_labs.html

The following figure is a snapshot of the page above, but consult the web page or the department for the most current information.

Accessibility

For current information about technologies and computing labs available on campus to persons with disabilities, see:

http://www.ncsu.edu/it/dss/at.html

For information, workshops, consulting services, and other resources to help faculty, IT staff, and others provide accessible IT resources and web content, see:

http://www.ncsu.edu/it/access/
<table>
<thead>
<tr>
<th>College and Department-based Computing Labs Location and Contact</th>
<th>Total Labs</th>
<th>Number of workstations</th>
<th>Total Seats</th>
<th>Available to all students or for college only</th>
</tr>
</thead>
<tbody>
<tr>
<td>College of Agriculture and Life Sciences - CALS</td>
<td>22</td>
<td>0 315 90 0 405</td>
<td>All</td>
<td></td>
</tr>
<tr>
<td><a href="mailto:CAAT_help@ncsu.edu">CAAT_help@ncsu.edu</a> (919) 515-6717</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>College of Design</td>
<td>9</td>
<td>0 47 56 0 103</td>
<td>College only</td>
<td></td>
</tr>
<tr>
<td><a href="mailto:design_help@ncsu.edu">design_help@ncsu.edu</a> (919) 515-8318</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>College of Education - CED</td>
<td>6</td>
<td>0 110 29 0 139</td>
<td>All</td>
<td></td>
</tr>
<tr>
<td><a href="mailto:cep_help@ncsu.edu">cep_help@ncsu.edu</a> (919) 513-1178</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>College of Natural Resources - CNR</td>
<td>2</td>
<td>1 58 0 0 59</td>
<td>All, but college preferred</td>
<td></td>
</tr>
<tr>
<td><a href="mailto:cnr_help@ncsu.edu">cnr_help@ncsu.edu</a> (919) 515-9506</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>College of Humanities and Social Sciences - CHASS</td>
<td>9</td>
<td>0 213 26 0 239</td>
<td>All, but college preferred</td>
<td></td>
</tr>
<tr>
<td><a href="mailto:chasscs@chass.ncsu.edu">chasscs@chass.ncsu.edu</a> (919) 515-3512</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>College of Management - COM</td>
<td>5</td>
<td>0 151 0 0 161</td>
<td>College only</td>
<td></td>
</tr>
<tr>
<td><a href="mailto:scm_it_help@ncsu.edu">scm_it_help@ncsu.edu</a> (919) 515-5554</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>College of Physical and Mathematical Sciences - PAMS</td>
<td>18</td>
<td>137 240 22 125 524</td>
<td>All students in PAMS classes</td>
<td></td>
</tr>
<tr>
<td><a href="mailto:pacs@pams.ncsu.edu">pacs@pams.ncsu.edu</a> (919) 515-6614</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>College of Textiles - COT</td>
<td>8</td>
<td>0 107 4 10 181</td>
<td>2 labs for all, 6 labs for college only</td>
<td></td>
</tr>
<tr>
<td><a href="mailto:texco@listerv.ncsu.edu">texco@listerv.ncsu.edu</a> (919) 515-1528</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>College of Veterinary Medicine - CVM</td>
<td>3</td>
<td>1 39 3 0 43</td>
<td>College only</td>
<td></td>
</tr>
<tr>
<td><a href="mailto:vethelp@ncsu.edu">vethelp@ncsu.edu</a> (919) 513-6877</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
3 Logging In/Out

Once you have an account and know your Unity ID and password, you are ready to connect to the campus computing environment. This chapter explains how you log in to Eos/Unity from various lab workstations on campus, Solaris/UNIX, Linux, and Windows. Although all of these computers access a common network, file system, and services, their interfaces and hardware vary widely. You have to work differently on each to take advantage of (a) what is unique to the platform, e.g., software applications and utilities, and (b) what it has in common with the other platforms, e.g., file system (AFS) and printing.

Logging In

Logging in is a user-initiated process of gaining access to the Eos/Unity system. You identify yourself to the system with your Unity ID and password. The Hesiod and Kerberos campus databases verify that you are who you say you are and grant you access to services. When you are authenticated by this means, you are authorized to work on the system for a fixed period of time, or session, after which you must authenticate again in order to continue using resources.

Lab workstations stay powered on, but check the indicator lights on the monitor and system to make sure. If the screen is dark, move the mouse or press any key to bring the monitor out of sleep mode and display the opening login screen.

To log in, enter your Unity ID and password in the fields provided. Login screens will vary slightly from platform to platform, but all require your Unity ID and password to be entered. Use lowercase letters when logging in and do not add spaces or dashes. If you are logging in to Eos/Unity from off campus or remotely, see Remote Access Services.

Security note: Do not give anyone your Unity ID and password to use. This is a violation of NCSU computing policy. If you know that someone else has your password, change it immediately at http://www.ncsu.edu/password/.

Logging Out

Logging out is a user-initiated process that shuts down processes, prompts the user to save work, and puts away files in a managed way that protects your account and data. It is very important to log out, whether you are in a public lab or on a personal
computer connected to the network. **Before you log out, remember to save your files and close down applications so you do not lose any work.**

**Why Log Out**

If you leave a lab workstation without logging out, the next person who sits down has full access to your account, to read and send e-mail, change or delete files, alter directory permissions, etc., a security risk you do not want to take. Always log out!

Logging out of your personal or office computer is just as important. Logging out clears the memory and cleans up programs, making your system run more efficiently.

**How to Log Out**

In campus labs, logout varies by platform:

* **Windows (Dell) Log Out.** Select the **Start** menu and **Log Off.** Or, type **Ctrl+Alt+Delete** and select **Logoff.**

* **Solaris (Sun) Log Out.** Bring up the **Root Menu** by holding down the third mouse button in the root window of your screen. Drag to **Logout.** Or, type **logout** in any Xterm window on the screen.

* **Linux (Dell) Log Out.** Select the Red Hat icon at the bottom left of the screen and choose **Log Out.** Or, type **Ctrl+Alt+Delete** and select **Log Out.**

Wait until the opening login screen comes up before you leave the workstation to make sure that the logout procedure finishes and is not interrupted.

If you are logged in remotely, you are probably connecting to a UNIX or Linux computer. To log out, type **logout** in any Xterm window on the screen.

**Shutting Down**

Any computer connected to the Internet is vulnerable to scanning and attack. If you are on an office computer, whether it is an Eos/Unity computer or not, you should shut it down and take it off the network when you are not using it, particularly over night. This keeps malicious users and machines from finding your computer and exploiting it, possibly posing as you in e-mail or masquerading as your machine to launch network attacks against other people or computers.

**Do not shut down or turn off workstations in labs!** Workstations should remain on for the convenience of other users. They are rebooted nightly anyway via an automated process to clean up memory/processes and run security programs.
Troubleshooting Login and Session Problems

At some time or another, nearly everyone has problems logging in, saving files, or timing out of a session. The most common problems are listed here to troubleshoot before you seek help from Help Desk staff.

Can’t Login: Forgot Unity ID or Password

Most people cannot log in because they are entering the wrong Unity ID and password. Make sure the Caps Lock is off—your Unity ID is lowercase—and do not add capitalization or spaces when typing it in. If you have forgotten your password, you will need to go to the Help Desk in the Hillsborough Building (COE faculty and students can go to 200 Page Hall) and have them reset your password. Take your NCSU ID!

Can’t Login: Restricted Labs

Anyone with a Unity ID can log in to the Unity lab workstations on campus. Unity labs are generally in the library and dorms, see locations in Labs or at http://www.ncsu.edu/it/essentials/connections_labs/.

However, individual colleges may have realm-based labs that are restricted to their users only. For example, College of Engineering students pay a separate Eos fee, which gives them access to engineering-only software and labs. Non-COE users cannot log in to the workstations in these labs, see locations in Labs. Because equipment and services can be restricted or clustered in this way for specific groups, your inability to log in may have to do with this.

For example, the following is from a user’s Hesiod database record and shows the group list for an engineering student enrolled in the fall semester.


The engr_fall identifier, or flag, is what allows this student to log in to Eos labs in the current fall semester. Without this flag, you cannot log in to workstations in engineering buildings. You can check your Hesiod record at https://sys-news.ncsu.edu/tools-bin/user-lookup (or, type at a unity% prompt, hes unityid).

Can’t Login: Misconfigured Dotfiles

If you cannot log in to a Sun or Linux computer, it may be because of errors you made in configuring dotfiles that customize your user environment, e.g., .mylogin, .mycshrc, Xstartup, Xdefaults, etc. If you think this might be the case, take advan-
tage of the special options on the opening login screen under **Session** on Linux and **Session Type** on Solaris. You can choose the **Default Environment**, which bypasses your dotfiles and makes the session look exactly as it did the first time you logged in. Or, you can choose **Repair Dotfiles**, which tries to fix errors in these files. Once in, you can diagnose these files yourself and fix any errors you might have made.

**Can’t Work/Save: On the System Too Long**

If you work more than 12 hours in a session, your *Kerberos* tickets, which permit you to access computing services, will expire. You can log out/in again, or, on UNIX/Linux platforms, type **kreset** in a terminal window and enter your password. On Windows realm workstations, double-click the AFS icon on your Desktop and select **Renew Auth** or **Authenticate** in the dialog box.

**Can’t Work/Save: Over Quota**

If you suddenly have difficulty saving files or working in an application, you may have filled up your allotted file storage quota. You will need to check your quota at [https://sysnews.ncsu.edu/tools-bin/user-lookup](https://sysnews.ncsu.edu/tools-bin/user-lookup) (or, type at a `unity%` prompt, `quota`). If over quota, you will need to move or remove files from the space so you can continue working.

Other trouble-shooting suggestions are at [http://www.ncsu.edu/it/essentials/troubleshooting/basic_unity_trouble.html](http://www.ncsu.edu/it/essentials/troubleshooting/basic_unity_trouble.html). Also, check [http://sysnews.ncsu.edu/](http://sysnews.ncsu.edu/), which alerts users when servers are down or there are network difficulties or other problems that may affect users. Finally, keep a watch on your own account via **User Lookup** at [https://sysnews.ncsu.edu/tools-bin/user-lookup](https://sysnews.ncsu.edu/tools-bin/user-lookup).

**Getting Technical: System Activation at Log In**

The following provides more detail about what actually happens on the system side after the user enters his/her Unity ID and password to log in to Eos/Unity. However, there are some differences in the Solaris/Linux and Windows logins.

**Solaris/UNIX and Linux Login**

The following is the procedure for system activation after login to a Sun Solaris or Dell Linux workstation:

1. User enters Unity ID and password.
2. The Hesiod database authorizes user to use the workstation.
3. The Kerberos database checks the password and provides the authenticated user with session tickets.
4. The user's account is added to a password file.
5. AFS gets tokens for the user's home cell (Eos or Unity).
6. The user's home directory attaches.
7. System and user files configure the session. Mail, fvwm, aliases, and other processes run.
8. The console, xterm, and window managers (fvwm2, GNOME) are started giving access to applications.

**Summary:** The Hesiod database for name services authorizes the user to use the workstation. The Kerberos database authenticates the user's password and gives him/her a ticket file to access system services. AFS tokens are granted for the user's home AFS cell (Eos or Unity), and the user's home directory is attached. The session is configured, adding on any user customizations and settings, and applications and services are made available. The user is authorized and connected to services and file space and is now able to work on the system.

**Windows Login**

The Windows XP environment uses additional technologies from Novell, including NDS (Novell Directory Services), ZENWorks for Desktops, and the Novell Application Launcher. The following is the procedure for system activation after login to a Dell Windows workstation:

1. User enters Unity ID and password at the Novell Login Screen.
2. The user's Novell Directory Services (NDS) password is checked.
3. The user is authenticated to NDS.
4. The WolfCall Auto-Login service uses the userid and password to request Kerberos tickets from the campus UNIX Kerberos cell.
5. The Kerberos database provides the authenticated user with session tickets.
6. The user's roaming profile is copied from the network.
7. The Novell Login Script is started, which sets any needed local machine and user settings and maps any Novell drives that are needed, such as the M: (application settings) and L: (application files) drives.
8. WolfCall is started with parameters telling it to finish the AFS/Kerberos login. This maps the K: (user's home directory) and J: (AFS root) drives.
The Novell Application Launcher (NAL) is started, containing Windows applications.

**Summary:** The user logs in to Novell Directory Services (NDS) with the Unity ID and password. A local account is dynamically created for him/her on the workstation, and the password is matched to NDS/Unity password to log the user in. A user profile is set up so the user can use the Windows software and services stored locally; the Novell M: drive stores these settings. Additionally, the user is authenticated through Kerberos to AFS to use Eos/Unity realm software, file space, and services. The K: drive on Windows is mapped (shortcut) to the user's home directory in AFS.

**Note:** Extensive changes are being made to the Windows lab environment in 2006, so some of the above may change, such as, WolfCall and Novell. Keep up with the changes at [http://microsys.unity.ncsu.edu/](http://microsys.unity.ncsu.edu/).
4 First Look: The User Interface

The "look and feel" of the workstation environment is defined by the operating system and its interface software. This software governs how the user interacts with the workstation to access Eos/Unity resources and run applications. Sun Solaris, Red Hat Enterprise Linux, Microsoft Windows XP, and Apple Mac OS X have all been adapted and configured for Eos/Unity workstations. Although they connect to many of the same resources, they have substantially different user interfaces. You can move among them fairly easily, but you have to learn to do many things in different ways.

Graphical User Interfaces and Windowing Environments

The first thing you see after you log in is the user interface. All Eos/Unity workstations, no matter the operating system, support a graphical user interface, or GUI (pronounced "gooey"). The GUI is a pictorial plane of windows, menus, and icons, which the user manipulates to perform operations. A GUI is an easy and engaging way to interact with a computer. It can be used without much initial instruction and does not require that users know commands to interact with the operating system and applications.

The appearance of windows on the user interface, or of screens within a screen, is created by a window manager. Windows are the modus operandi for displaying and running applications and for communicating with the operating system. They also help users work more effectively with the programs running inside them.

Each window is self-contained, and the applications running in them do not interfere with each other, even if they overlap, hide one another, or are scaled down to a size too small to read. All Eos/Unity platforms support multitasking, the ability to run more than one program at a time. Information can also be copied, moved, and shared among the windowed applications.

Although the dominant metaphor of the graphical environment is the window, the interface also employs the metaphor of the desktop. Windowed applications can be viewed as documents and folders that are stacked and arranged on the top of a desk. The desktop is the screen background, or root window, and windowed applications and icons are displayed on top of it.
Sun Solaris: X, fvwm2, and Command Shell

When a user successfully logs in to the Sun Solaris workstation, the login screen disappears and the screen below takes its place. This default interface is created by the F(?) Virtual Window Manager2 (fvwm2) for X Window System, Version 11.

The X Window System was developed at MIT and is now distributed by X.org. Also called X Windows, or X11, this software is similar to Microsoft Windows. However, when users manipulate the windows (e.g., resize and shuffle them), they are not working directly with X but with the fvwm2 window manager. fvwm2 is responsible for making the windows look and operate in the same way. Together, X and fvwm2 create the look and feel of Eos/Unity on the Sun Solaris workstation.

fvwm2 is designed to minimize memory consumption. It also provides a virtual desktop, both a large virtual desktop and multiple disjoint desktops that can be used separately or together. To learn more about how to use the fvwm2 window manager, consult the web site, http://www.fvwm.org.
The gray background is the *desktop*, or *root window*, on which all windows, icons, and screen contents are displayed. The small window that first appears on the desktop in the upper left corner is called the *console window*. It monitors the user's session and what goes on in the system. You do not work in the console window, and closing it will log you off! Rather, watch it for error messages and other system information.

Users of Solaris workstations also routinely use a *command-line interface*, whereby they interact with the computer and its operating system through commands issued at a *shell prompt* (appears as *unity%* or *eos%*) in an *Xterm terminal window*. These commands are interpreted, executed, and passed to the Solaris operating system by the shell program.

No applications are displayed on the Solaris desktop by default. Instead, applications are launched from the pop-up *Application Menu* (hold down the middle mouse button in the root window), or the command line in the Xterm window (type `add`; see also *Software Applications* and *Appendix B*). You can also bring up the *Root Menu* (hold down the right mouse button in the root window) to manipulate windows, refresh the screen, and log out.

**Microsoft Windows XP and Novell**

The Microsoft Windows interface is the quintessential "point-and-click" GUI. Rarely will the user need to work from the *Command Prompt* (*Start* -> *Programs* -> *Accessories* -> *Command Prompt*), the equivalent of the UNIX command-line interface. Users will find the Windows interface more familiar to them than the interfaces of other Eos/Unity platforms because of the widespread use of Windows at home and in the workplace.

Unlike the Solaris platform, which looks the same across labs, the Windows desktop may vary some depending on where you log in and what your NCSU affiliation is. If you use different labs, you will see some differences in the folders and applications because of what a college or department might have installed for its users.

The following figure is a typical Windows XP interface you would see after you log in (you may need to select the *Application Window* icon to launch it). Windows workstations run technologies from Novell, which include the *Novell Application Launcher* (NAL) that displays in the middle of your screen. You use the NAL to find and launch applications you wish to use.
Red Hat Enterprise Linux and GNOME

The Linux distribution on campus is Red Hat Enterprise Linux (RHEL), although most users refer to it as Realm Linux or the Linux Realm Kit since it is a fully integrated platform in the Eos/Unity realm (see http://www.linux.ncsu.edu/). Linux has been supported as a realm client since 1999. It provides the user access to the AFS file system, applications, printers, and other resources.

There are many facilities on campus that use Realm Linux, particularly in the Colleges of Engineering and PAMS. RHEL is the supported version in Eos/Unity labs on campus, but Red Hat Fedora is recommended for student-owned computers because it is free.

GNOME (GNU Network Object Model Environment) is the desktop environment that runs on this platform and creates the graphical user interface. It has been customized to give users easy access to applications and utilities that run under Linux.

As seen below, the Linux workstation interface resembles the one on Windows, with a NAL-like application launcher called Nautilus. It also has a menu of pro-
grams available from the Red Hat icon in the lower left corner of the screen (similar to the Windows **Start** menu).

No terminal window automatically opens as it does on Solaris, but you can launch one by clicking the monitor icon in the middle of the icon bar at the bottom.

**Common and Custom Configuration**

Users should view the Solaris, Windows, and Linux interfaces as different entry points to a common campus network of shared software, hardware, data, file space, and services. It is useful to get some experience with all of the platforms so you can take advantage of what is unique to each platform and how to use what is common to all.
System administration of all workstations is handled remotely via the network since it is not practical to configure each machine individually and on site. The configuration is either downloaded to the machine upon login (Solaris), or installed by administrators in protected partitions on the local drive (Windows). The common environment is optimized for access to shared hardware devices like printers, university licensed software, file space that is backed up nightly, and many additional services and resources.

**On all Eos/Unity platforms, the user CANNOT store content on the local drive of the workstation itself. The local drive is cleaned on logout.** Users store content either on external media or in network file space, specifically, in your home directory (the K: drive on Windows machines) or in other AFS directories to which you have access (via the J: drive on Windows machines).

User customization of the interface and software is still possible but kept in user file space. However, less customization is possible on Windows than Solaris because of its reliance on the local C: drive, which is cleaned upon logout. As a result, much of the customization you might usually do on your own computer, e.g., via the Control Panel and Accessories, is not available to you on lab workstations. You will get error messages when you try to reconfigure settings and devices.

The developers of Eos/Unity recognize the importance of maintaining standards across colleges and have worked to minimize the differences in platforms and interfaces as much as possible.
5

Home Directory, or K: Drive

The first question you are bound to ask after you log in is “where am I?” The var-
ious platform interfaces with their application launchers and menus show you what
you have to work with. But where are the files stored that you create? After you log
in and the system knows who you are, you are placed by default in your home
directory. All files you create are automatically saved there unless you change the
path. This storage space is accessible to you from any platform, but what it is
called and how you get to it varies.

User File Space

Everyone with a Unity account is given a home directory in the campus AFS file
system with a base quota of 50 MB. You can increase your quota to 300 MB via
the Quota Manager at http://sysnews.ncsu.edu. Your home directory is configured
to keep your files and data secure, and only you can log in and use it.

Your home directory is sometimes referred to by other names, e.g., Unity locker,
AFS locker, user volume, K: drive, etc. Some of these terms are fairly self-explan-
atory references to your home file space in Unity/AFS. Others are more cryptic.

For example, your home directory is mapped (shortcut) to the K: drive on Win-
dows workstations, coining “the K drive” as one of the more common terms for
personal file space. The My Documents folder on your Windows desktop also
points to the K: drive and your AFS file space. Remember that this is a platform-
specific term. You will not be able to find a “K” drive on Solaris, Linux, or Mac
workstations, but you can certainly access your home directory and files.

Another common term is locker, coined at MIT for a file collection belonging to a
user, project, software application, etc. Technically, a locker is an AFS volume,
which is a container that keeps a set of related files and directories together on a
disk partition in AFS. It usually has its own quota and permission settings. On Eos/
Unity, one AFS volume is used for each user’s home directory.

Location of User Home Directories

User directories are stored (distributed) on many file servers on the campus net-
work. AFS does this distribution and management, including backup, so users do
not need to know the exact machine on which their files have been stored.
Instead of a fixed physical location, Unity users are given a fixed path to their user volume or home directory. Only one location exists in AFS for each user’s home directory. This location does not change, although ways to access it vary.

When you log in, you are automatically placed in your home directory, which is several levels down from the top of the AFS file tree, see following figure. The path originates in the root /afs directory, which encompasses other sites in the world that run AFS. Unity (unity.ncsu.edu), Eos (eos.ncsu.edu), and Backbone Protocol (bp.ncsu.edu) are cells that make up the NCSU AFS site, and they in turn branch into more directories.

User volumes reside in a common users directory in the Unity AFS cell, /afs/unity.ncsu.edu/users/ (a shorter pathname to this space is /afs/unity/users/). Some early users of the system, principally in engineering, may have accounts in the Eos cell, /afs/eos.ncsu.edu/users/, or the shorter pathname, /afs/eos/users/.

User directories are further organized alphabetically starting with the first letter of the Unity ID. For example, the home directory for John Q. Public, or jqpublic, is located in /afs/unity/users/j/, not in the p directory for his last name. The full pathname of jqpublic’s home directory is /afs/unity.ncsu.edu/users/j/jqpublic/.

The diagram on the next page shows an abridged version of the Eos/Unity AFS file tree with the user directory path highlighted.

Most accounts are in Unity file space, not Eos, but you can check your Hesiod FILSYS record at https://sysnews.ncsu.edu/tools-bin/user-lookup to see for sure.

**Accessing Your Home Directory**

Methods vary as to how to access your home directory, depending on the platform you are using and whether you are on the campus network or accessing it remotely. More information is available in later chapters about working with directories, folders, files, UNIX, and AFS.

**Command Line Access on Solaris and Linux**

On Solaris and Linux, you access your home directory from the command line at the % prompt in a terminal window. The `cd` command typed by itself will always return you to your home directory. The `pwd` (path of working directory) command will display the path of the directory you are in. When you save files, they are saved by default to your home directory, unless you change the path to save elsewhere.
AFS File Tree: NCSU Cells (bp, eos, unity) and the Unity users Directory

/  
  /afs/  
  athena.mit.edu  bp.ncsu.edu  cmu.edu  eos.ncsu.edu  umich.edu  unity.ncsu.edu ...  
  contrib  dist  engrwww  courses  lockers  lockers  users  
  jdk  openoffice  pine  ansys  matlab  sas  acc ... e ... zo  
  bin ... src  acc100 ... acc630  e115  zo150 ... z0685  
  pine  archived  common  lec  prep  
  e115_00112002...e115_60482003  EosLabs  Review  www  001 ... 604  
  index.html  
  graded  submitted  
  assignment  assignment  
  userid  userid  
  graded-file.xxx  submitted-file.xxx  
  jqpublic  www  index.html  
  index.html  
  graded  submitted  
  assignment  assignment  
  userid  userid  
  graded-file.xxx  submitted-file.xxx  
  jqpublic  www  index.html  
  index.html
Your personal web pages are also delivered from your home directory. If you have a www subdirectory or folder in your home file space (/afs/unity/users/a-z/unityid/www) that contains an index.html or index.htm file, the campus web servers will find it on their next update and automatically deliver the page from http://www4.ncsu.edu/~unityid, see diagrams on previous page and above.

**Technical Note:** The commands typed in the Xterm window above illustrate how a more advanced user can change the prompt to show the path of the working directory without repeated typing of the `pwd` command. If you create/open the `.mycshrc` file in an editor and add the line `set prompt=“%/ %”` (“percent, forward slash, space, percent”) and save, the path of your current location in AFS will always display as the prompt. One exception is a system-wide substitution of `/ncsu/` for the paths to user volumes, `/afs/eos.ncsu.edu/users/` and `/afs/unity.ncsu.edu/users/`. For all other locations, you will see the full pathname. (`source .mycshrc` will activate the new prompt in the window without logging in/out again.)
To move through all the directories to get to your home directory, start in the root of the AFS file tree, or /afs. (Note: cd typed at the prompt by itself will place you in your home directory.) List (ls) or change directories (cd) in a terminal window to move through directories. For example, to navigate to /afs/unity/users/x/xman/:

% cd /afs

% ls

alw.nih.gov  andrew.cmu.edu  anl.gov  athena.mit.edu  bcc.ac.uk  bp  bp.ncsu.edu  bstars.com  bu.edu  cards.com  ce.cmu.edu  cern.ch  cheme.cmu.edu  ciesin.org  citi.uchicago.edu  club.cc.cmu.edu  cmf.nrl.navy.mil  cmu.edu  cs.arizona.edu  cs.brown.edu  cs.cmu.edu  cs.cornell.edu  cs.unc.edu  cs.washington.edu  cs.wisc.edu  css.cs.utah.edu  ctd.orl.gov  ctp.se.ibm.com  dmsv.med.umich.edu  dsg.stanford.edu  ece.cmu.edu  eos  

eos.ncsu.edu  ethz.ch  fnal.gov  gr.osf.org  grand.central.org  graphics.cornell.edu  hrzone.th-darmstadt.de  iastate.edu  ibm.uk  inel.gov  ipp-garching.mpg.de  ir.stanford.edu  isi.edu  jrc.flinders.edu.au  lrz.muenchen.de lsa.umich.edu  math.lsa.umich.edu  me.cmu.edu  media-lab.mit.edu  msc.cornell.edu  mtunix.com  nada.kth.se  ncat.edu  nce  nce_ctc  nce_psc  ncsa.uiuc.edu  nd.edu  nersc.gov  net.mit.edu  next.mit.edu  northstar.dartmouth.edu  nsf-centers.edu  others.chalmers.se  palo_alto.hpl.hp.com  pitt.edu  psc.edu  pub.nsa.hp.com  rel-eng.athena.mit.edu  ri.osf.org  rose-hulman.edu  rpi.edu  rrz.uni-koeln.de  rus.uni-stuttgarte.de  sfc.keio.ac.jp  sipb.mit.edu  spc.uchicago.edu  stars.com  stars.reston.unisys.com  tcell  tcell.ncsu.edu  test.alw.nih.gov  theory.cornell.edu  titech.ac.jp  transarc.com  ucoop.edu  umich.edu  uni-freiburg.de  unity  unity.ncsu.edu  urz.uni-heidelberg.de  vfl.paramax.com  wan.umd.edu  

% cd /afs/unity/

% ls

adm  admin  bso  ctdp  dmsv  ece  eos  

cds.afs.proxy  info  public  system  

contrib  lockers  sadm  users  
dist  project  source  

% ls /afs/unity/users/

a b c d e f g h i j k l m n o p q r s t u v w x y z
% ls /afs/unity/users/x/
xblin xhu2 xli xliu2 xman xwang xwang
xhu xiong xliang xma xmin xwang2 xyuan
% ls /afs/unity/users/x/xman/
Permission denied.

Your own home directory is one of many user directories in AFS, and only you can access it. The *Permission denied* error means that you cannot go any farther because you are not the user *xman* and do not have access to the space.

**Drive and Folder Access on Windows and Linux**

On campus Windows machines, the path to your home directory has been mapped (shortcut) to the **K: drive**, so it acts just like your local **C: drive**. When you save files to the **K: drive**, you are saving to your home directory in AFS.

![My Computer window](image)

The top level of the AFS file tree, or /afs, is mapped to the **J: drive**, or **all on (J:)**, on Windows; /afs/unity/users/x/xman/ is J:\unity\users\x\xman\ on Windows. The following figures show the path to this user directory on a Windows computer if you start from **all on (J:)** rather than going directly there from **K**.

In the terminal window of Solaris and Linux workstations, you **cd** through directories to get to this space. Working through the graphical interface on Windows and Linux workstations, you simply open folders.

Again, if you are trying to access a home directory that is not your own, you will get an *access denied* message and will not be able to move farther down the tree.
The Linux interface looks a little different, but the process is the same as on Windows of opening folders. The user’s home directory is mapped to the Home folder icon on the desktop (screen background), with the path shown in the Location field. Paths can be typed in this field, and the Up button moves you up the file tree.
6 Software Applications

One of the greatest strengths of the Eos/Unity environment is its suite of application software. Applications are available in many disciplines to support productivity computing, computing in the major, and research computing. All combined, there are hundreds of applications across the platforms--Solaris, Windows, Linux, and Mac. Because students will use these programs again in the professions they enter after graduating, their introduction to this software at NCSU is a valuable addition to their education.

Individual applications are usually available in more than one location, so getting access when you need it is fairly easy. Also, some software applications are available on more than one and sometimes all platforms, so you can move among platforms to work on your files (see Appendix B).

Solaris Applications

Solaris is the oldest realm platform and is principally used by faculty and students in engineering and the sciences. These applications usually require the exceptional graphics capability and processing speed you find on Sun workstations.

Application Menu

No applications are displayed on the Solaris desktop by default when you log in. Instead, the most common applications on this platform are launched from the pop-up Application Menu (hold down the middle mouse button in the root window).

The arrows on the Application Menu indicate that there is more than one application available in some categories. These tools are listed in submenus (also called cascading menus because one menu drops off another in cascade fashion). To move into a submenu for a category of tools, pull the pointer down the list to the menu option you want. Then pull to the right, as the arrow indicates, and a submenu appears. Drag up or down this submenu to the application you want and then release. This action selects the application and brings it up in its own window.

You can also bring up the Root Menu (hold down the right mouse button in the root window) to manipulate windows, refresh the screen, print selected text you have highlighted in windows or applications, restart the window manager (fvwm2), or log out.
The add Command

Not all applications are available from the Application Menu. Most are launched from the command line. Typing `add` on the command line brings up a full list of the main applications that run on Solaris workstations (see above).

It usually takes two commands to launch an application. The first command is `add` followed by the name of the software you want to use. This command attaches the software locker and sets up the application on your workstation. It also runs any startup programs that are in the locker. The second command executes the program and brings it into a window on the screen. The `add` command displays the commands you need to launch a program. For example, to launch ADAMS:
add adams
mdi &

Note: When launching an application on a Sun workstation, you often must wait awhile before it appears on-screen (more than a minute at times). Be patient. Do not keep launching it again and again. If you do, you will get multiple copies of the program running on your machine and slowing down its processing.

Background and Foreground Processes

Programs running on your computer are called processes, and they exist in one of three states: background, foreground, or stopped. Multitasking makes it possible to run a number of programs at the same time on the same machine.

When a program is started from the command line, it becomes a child process of the shell program running in the terminal window. The shell has to keep track of the program because it is running in the foreground. A foregrounded process has read and write access to the controlling terminal window, so the shell must wait until the processing is finished before returning the prompt. However, if you add an ampersand (&) after the executing command (see above, mdi &), it tells the shell to run the program in the background so it does not tie up the shell. The shell returns the prompt, and you can use the terminal window to run other commands.

If you decide you want to background a process that has already been launched in the foreground, type Control+z (hold down the Control key and type z). This command puts the process in a stopped or suspended state and gives you back the prompt (Control+c aborts a process). To background the process:

bg

To bring a stopped process to the foreground:

fg

Solaris assigns a unique reference number, called a process identification (PID) number, to each process running. Users refer to the process identification number (PID) when they want to affect a process in some way. To see what processes are running on your workstation:

ps -e (or -ef)

To end or “kill” a process running:

kill pid#
The realmlocate Command

You can also use the `realmlocate` command to find applications.

`realmlocate -a matlab`

Found matlab in the matlab7 locker.
You can access it by typing:
/afs/bp.ncsu.edu/dist/matlab7/bin/matlab

...  

The above finds all `-a` versions of Matlab on the system. Type (or copy and paste on the command line) the path to the command that executes the program.

`realmlocate` is particularly useful for finding the many public-domain applications on the system. If you know the name of an application you want to use, gcc, perl, xpaint, etc., just realmlocate it to find where it is stored on the system, e.g.,

`realmlocate -a gcc`

Found gcc in the gcc281 locker.
You can access it by typing:
/afs/bp.ncsu.edu/contrib/gcc281/bin/gcc

`realmlib <library>` is the same as realmlocate, except for libraries, e.g., `realmlib libjpeg`

`realmdoc <command>` provides the UNIX `man`ual page of documentation for a command without having to add the locker first, e.g, `realmdoc gcc`

Microsoft Windows Applications

While Solaris supplies engineering and science users with many of the applications they need, including useful general-purpose tools, it does not have the number or range of applications that are available for the Windows platform. Although Windows has proven to be the most difficult system to configure for the realm, it delivers applications by the dozens to users.

Novell Application Launcher

The NCSU Microsys group (microsys.unity.ncsu.edu) packages Windows applications for distribution to Eos/Unity labs using Novell Zenworks for Desktops. Windows applications are available in the Novell Application Launcher (NAL). Windows organizes applications into folders, which contain icons that represent
programs. To launch a program, double-click the application icon, or right-click the icon and select **Open** from the pop-up menu, or select the icon and press **Enter**.

Windows applications vary from lab to lab because colleges and departments provide different software for their students, e.g., **Engineering Applications** will only be in Eos labs, see below. However, the applications in the **Unity Applications** folder and subfolders are available to everyone and do not change from lab to lab.

If the workstation has never run the application before, it will have to install it, which can take anywhere from a few seconds to a few minutes depending on net-
work speed and the size of the application. If you cannot find an application, select the top-most folder [All], which will show all the applications on the workstation.

**The Start Menu**

The **Start** menu (see above) behaves as Windows users would expect, except that the **Programs** menu does not provide an alternate way to launch all Eos/Unity applications. You have to explore the launcher to see what is available to you. However, the **Start** menu is your access point to special utilities that have been added for accessibility, virus checking, and other needs. It is also the way you get to standard Windows programs and to the following:

- **Documents**: Lists the last 15 documents you opened. Selecting one will open the file in the application in which it was created.
- **Settings**: Displays the settings of the Control Panel, Taskbar, and Printers.
- **Search**: Locates files and folders on your computer.
- **Help**: Brings up index of Help Topics.
- **Run**: Opens a window in which you specify by name a program to run.
- **Shut Down**: Provides options for logging off or shutting down your computer.

**Fixing Applications with Verify**

If you have difficulty running an application, right-click its icon and select **Verify** from the pop-up menu. **Verify** rewrites settings from the network and essentially reinstall the application on the workstation. Once verified, the application should open and work. If it does not, contact the **Help Contacts** available from **Properties** on this same menu.

**Processes and the Task Manager**

Applications and processes are identified and monitored on Windows by the **Task Manager**, which is brought up by right-clicking in the gray area of the task bar at the bottom of the screen. Selecting the **Applications** tab shows you what applications are running. The **Processes** tab shows all background and foreground programs running and provides a full accounting of session activity. To quit an application or process, select it and then select the **End Task** button.

**Red Hat Enterprise Linux**

Campus Linux Services, or CLS, supports the **Linux Realm Kit**, or **Realm Linux**. Linux has an application launcher similar to the Windows **NAL** launcher called
**Nautilus.** Nautilus has application icons in folders that you double-click to launch (or right-click and **Open**). Programs can also be launched from the Red Hat icon in the lower left corner of the screen, similar to the Windows **Start** menu.

In addition, you can use the `realmlocate` command, or type `add` in a terminal window to display a list of applications on the workstation, just as you do for Solaris.
Like Solaris, the user can add and launch software with the two commands provided in the list, e.g.,

```
add matlab
matlab
```

There is not an abundance of application software on Linux, but it runs some of the most popular applications on campus, e.g., Mathematica, Matlab, JDK, etc. The handling of processes is identical to the way they are handled on Solaris. A Windows-style task bar appears at the bottom of the screen to show what is running.

**Documentation and User Manuals**

Documentation to support Eos/Unity software applications is often online inside the program under Help. Also, check the software information pages at the Eos Web site http://www.eos.ncsu.edu/software/ for information on documentation.

If there are manuals available in PDF or HTML versions, they will be linked in at: http://manuals.eos.ncsu.edu/

You must log in to this site because of license restrictions that confine the use of these manuals to NCSU users only. Print manuals can sometimes be ordered from the NCSU Bookstore. D.H. Hill library also has copies of some manuals. Of course, search the Web for additional resources that can help you with learning and using applications.

**Commercial and Non-Commercial Software**

Commercial software is purchased and licensed by NCSU upon recommendation by faculty for use in classes and research. For these packages, NCSU offers support and maintenance, see Appendix B for some of these applications.

Non-commercial software is not covered by an explicit contractual agreement with NCSU. It includes freeware, shareware, public-domain software, and software that is freely available for non-commercial or academic use. It may or may not be licensed, copyrighted, or in other ways protected by law. These packages are installed on the Eos/Unity system by NCSU staff, but in general are not distributed or supported by NCSU. Also, no upgrades or new versions are guaranteed. Many of these programs are excellent, but you must use them at your own risk.
Printing

Printing is a network service on Eos/Unity. There is no printer connected to individual workstations in the labs. Rather, every lab has at least one high-end laser printer that handles the printing requirements of all of the workstations (see Labs).

WolfCopy: How to Get Print Quota and Assistance with Printers

Once you have your computer account and are on campus, you need to go to a WolfCopy Center to purchase print quota so that you can print on the printers in the labs. Or, you can purchase quota online with a credit card at http://print.ncsu.edu. All Eos/Unity labs and workstations use the same print quota debit system.

Printing is $0.06/page, $0.60/page for color. The minimum quota purchase is $5.00 for about 83 pages. To purchase quota, go to either of the following locations:

* Talley Student Center, kiosk on ground floor next to main information desk, 8:00-4:30 MWF.
* Administrative Services, Sullivan Drive, 8:00-5:00 M-F

WolfCopy maintains the public lab printers, including adding paper and toner. Contact WolfCopy or lab operators if you have problems, wolfcopy@ncsu.edu (515-2131) or help@ncsu.edu (515-HELP). The printers are complex and expensive pieces of equipment that users should not try to fix themselves.

WolfPrint: http://print.ncsu.edu

WolfPrint is a campus-wide printing system that was put in place by ITD in 2003. It permits you to perform the following routine tasks at http://print.ncsu.edu:

* Buy quota online
* Check your print quota.
* Print to a file and send the file to a specific printer.
* Check print queues, re-route and remove print jobs.
* Report printing problems and find solutions to common problems.

If you do not remember the web address, http://print.ncsu.edu, you can get to it from menus and icons in a variety of places. On the Windows platform, it can be launched from Unity Applications -> Help -> Unity Print Quota.
On Linux, http://print.ncsu.edu is launched from Print Manager, which you get to from NCSU Realm in the Applications launcher.

On Solaris, Print Manager on the Application Menu (hold down middle mouse button in the root window) launches a browser pointed to http://print.ncsu.edu.

The following is the opening page of the WolfPrint web application. The first link, Buy Quota Online, takes you offsite to Yahoo Stores for credit card purchases. The subsequent sections of this chapter explain how to use the site’s web tools.
Print a File

Most of the time, to send a print job directly to the printer in the lab you are in, you simply select Print from the File pull-down menu of your application. The Print... option on your File menu provides additional print options to adjust default settings, change number of copies, range of pages, etc.

However, sometimes you need to route your file to another printer. To do this, use the Print a File tool from http://print.ncsu.edu, browse for and select the file, and choose the printer you want from the pull-down list. You can also print more than one copy by selecting Show Options to bring up Copies.

The file must be specifically formatted for printing, PostScript (.ps), Portable Document Format (PDF), or simply a plain text file (.txt). Whatever application you
are in, you must first print to a file before using the **Print a File** tool to route to an Eos/Unity printer (see *Printing to a File* in this chapter).

## Check Queues

Whether you print directly to your local lab printer from **File -> Print** or use the **Print a File** tool, you can check on the status of your print job with the **Check Queues** tool. Windows uses a different printing system from the three other platforms (Solaris, Linux, Mac), which is the reason you see two print queues listed for each printer.

With this tool, you can see what jobs are ahead of yours so you can estimate how long you have to wait. If there is a long wait, you can remove and/or re-route your job. You can only remove jobs that you own. Because you had to log in to [http://print.ncsu.edu](http://print.ncsu.edu), the system knows who you are and will not let you remove anyone else’s print jobs but your own.

The following shows a job sent to the Park Shops printer. The owner, mcdaniel, can select **Cancel the Job** in the lower left corner.

] When the job is successfully canceled, WolfPrint will return a web page with the following message:
Quota Details

Quota Details is a check you are likely to run frequently. You have to have print quota in order to print, and you purchase it from WolfCopy Centers on campus. The Quota Details web page shows you your quota balance and the jobs you have printed. You can see from the Logs when and where you printed each job, how much it cost, and the number of pages.

The IOU feature is important in case you run out of quota at a time when WolfCopy Centers are not open for you to purchase more. You can get an IOU of $10 worth of printing (about 166 pages) through the following web page. Only one $10 IOU is permitted per user at a time.
QUOTA IOU

QUOTA IOU TERMS

When you request an IOU, $10 will be immediately credited to your WolfPrint quota account balance, and your account will be flagged. At 8:00 am on Sunday, 05/08/2005, or approximately 48 hours after your request, the IOU’s $10 will be deducted from your WolfPrint quota account.

While your account is flagged, you will not be allowed to request further IOUs. The flag will disappear when you pay your outstanding balance online with a credit card or at one of the following WolfCopy locations:

- Talley Student Center, ground floor, next to main information desk
  - Open from 8:00 am-4:30 pm, M-F
- University Graphics, Sullivan Drive
  - Open from 8:00 am-5:00 pm, M-F

Important Notes:

- If you are over $10 in debt, you may not request a Quota IOU.
- If your balance is positive when the IOU’s $10 is deducted from your account, the IOU flag will be removed.

By clicking on I Agree To These Terms below, you indicate that you have read and understand these terms, and a $10 credit will be added to your WolfPrint account.

Cancel My Request or I Agree To These Terms

When you request an IOU, $10 is immediately credited to your WolfPrint balance, and your account is flagged. At 8:00 a.m., two days from the time you requested the IOU, $10 is deducted from your WolfPrint account. While your account is flagged, you are not allowed to request additional IOUs. If you are over $10 in debt, you may not request an IOU. The flag disappears when you pay your outstanding balance at a WolfCopy location.

Report a Problem

If you have any difficulty with the WolfPrint tools and checks, you can report a problem through the following web page. However, first look at the Frequently Asked Questions at http://print.ncsu.edu/faq.php before you report a problem to
make sure you have not missed something that will help you solve the problem on your own.

**REPORT A PROBLEM**

Welcome to the WolfPrint problem report wizard. Please answer the questions posed as accurately as possible. You will have an opportunity to elaborate later.

What is the nature of the problem?

**Quota Related Problems**
- dispute a charge
- haven't been charged
- money added hasn't shown up
- iou problems

**Printer Related Problems**
- paper out
- toner out
- paper jam
- poor print quality

**Print Job Related Problems**
- stuck in queue
- vanished from queue

**Other Problems**
If you are having problems that don't fit into the above categories, please give us a short description of the problem you are having.
- [ ]

[Continue >>]

**Printing to a File**

Most applications have ways for you to print to a file. It is usually as easy as selecting **File -> Print** and then selecting **Print to a File**.
Creating PDF Files on Windows Workstations

The full version of Adobe Acrobat is installed on Windows workstations in the Unity Applications folder, so you can use this program to create and work with files in Portable Document Format, or PDF. Acrobat Distiller is also installed as a printer on Windows applications. When you are working in an application, e.g., Word or Star Office, and want to output a file in PDF (*file.pdf*):

1. Select Print -> Acrobat Distiller
2. In the Print dialog box, select Acrobat Distiller as the Printer Name. Make any setting changes you want and select OK.
3. In the Save PDF File As box, name the file and choose where it should be saved.
4. Select Save. The .pdf extension will be added to the file name automatically.

Adobe Acrobat will launch so you can preview the file. Use the Print a File tool at [http://print.ncsu.edu](http://print.ncsu.edu) to route the file to a specific printer for printing.

Creating PDF Files on Solaris and Linux Workstations

On Solaris and Linux, when you print to a file in an application, the default file format produced is usually PostScript. Files have the extension of .ps, e.g., *file.ps*. You can send the file to a printer using the Print a File tool at [http://print.ncsu.edu](http://print.ncsu.edu). Or, you can print the file from the command line (see Print Tools on Solaris and Linux below):

```
/lpr file.ps
```

If you need to create PDF files on Solaris and Linux, use the command-line Acrobat Distiller to convert a PostScript file to PDF:

```
add acrobat
distill file.ps
```

or

```
distill file.ps > newfilename.pdf
```

To print the file:

```
lpr newfilename.pdf
```

Or, print the file from [http://print.ncsu.edu](http://print.ncsu.edu). You can also view the .pdf file in a browser that has the Acrobat Reader plug-in, see Print Preview below.
For using PDF attachments in email, and the reasons for preferring PDF to other formats for attachments, see *Mail Attachments: Advantages of PDF* in *Electronic Mail*.

**Color Printing, Plotting, and Scanning**

Color printing is offered in several computing labs. You can select these printers from the printer list at [http://print.ncsu.edu/listofprinters.php](http://print.ncsu.edu/listofprinters.php).

Scanners that can be used to scan graphics and text into machine-readable disk files. Contact the Help Desk at 515-4357 for hours and availability (see also *Labs* for the location of color printers and scanners).

For more in-depth scanning services, plotting, large-format printing, and other digital media resources, contact the NCSU Libraries new Digital Media Lab and Learning and Research Center for the Digital Age on the second floor of the east wing in D.H. Hill Library, see [http://www.lib.ncsu.edu/dml/](http://www.lib.ncsu.edu/dml/) and the description provided:

“The Digital Media Lab provides assistance for the NC State community in creating and converting all types of media to digital formats. In addition to a diverse mix of scanners allowing conversion of documents, slides, photographs, and microforms to digital format, the Digital Media Lab provides the means for converting analog video to digital video, as well as creating digital video clips. The Studio and Collaboratory may be reserved in advance. The Lab is located on the second floor, east wing, D.H. Library in the Learning and Research Center for the Digital Age. The adjacent Usability Research Lab is equipped to collect video audio, and computer data in real time for observation and analysis to facilitate the design of websites or computer interface.”

**Print Screen and Screen Captures**

On Windows workstations, you can copy the entire screen as it appears on your monitor by pressing the **Print Screen** key on the keyboard. To copy only the active window, press the **Alt** and **Print Screen** keys at the same time. This action copies the image to a Clipboard. To paste the image into an application, e.g., *Photoshop*, *Paint* or a document in *Word*, select **Edit -> Paste** in the application.

To capture screens on Solaris and Linux, use the **xv** application. Bring it up from **Application Menu -> Graphics -> xv**, or by typing **xv** on the command line. Right-click the **xv** window to bring up **xv Controls** and select the **Grab** button.
Follow the instructions provided to capture a window, area, or whole screen, and then save to a file.

Print Tools on Solaris and Linux

There are additional tools on Solaris and Linux, both UNIX-based platforms, which help you print and run checks from the command line. The http://print.ncsu.edu web application actually runs on top of some of these commands and tools. If you prefer, you can use them directly rather than through the web application.

Print a File (lpr)

Although most printing can be done from inside applications, there are times when you need to print a print-formatted file from the command line. Most applications let you print to a file, which means that you can send your output to a file rather than to a printer. Then you can print the file whenever you want without having to open the application.

On UNIX, to print a file that has been formatted for printing, generally a PostScript (.ps) or Portable Document Format (.pdf) file, type lpr (line print) followed by the file name or the path to the file:

```
lpr file.pdf
```

The workstation will automatically print your file to the local printer in your office or lab. However, if you want to route your print job to another printer, add -P after the lpr command, followed immediately (no space) by the name of the printer you want to use and the specific print-formatted file you want to print. For example, if you want to print file.pdf to the color printer in D.H. Hill library:

```
lpr -Pdhl-2413-colorl file.pdf
```

For printer names, see http://print.ncsu.edu/listofprinters.php.

Check Print Queue and Remove Jobs (lpq, lprm)

All jobs are numbered. To remove a job from the queue, type lprm followed by the number of the job:

```
lprm job#
```

You can only remove your own print jobs, not those belonging to other people. If you have been quick enough to catch it, the lprm command will remove the file
from the print queue and keep it from printing. To remove all of your print jobs from the queue:

`lprm -`

**Print Selected Text**

This tool is only available on Sun Solaris workstations. You can use the **Print Selected Text** option on the **Root Menu** to print selections of text you highlight on the screen or in an application. Drag over the text with the left mouse button to highlight it. Right-click in the root window of the screen (gray background) to bring up the **Root Menu** and select **Print Selected Text**. Whatever is highlighted is sent to your default printer.

**Print Preview**

Before sending a job to the printer, check your file carefully to make sure that it is ready to print so that you do not waste your print quota. Many programs have a **Print Preview** capability, generally available from the **File -> Print...** menu. If you have a PostScript (.ps) to preview before printing, you can view it with one of the PostScript viewers on the system, e.g., `gv file.ps` or `ghostview file.ps`.

PDF files can be viewed with `gv` or in a browser with the **Acrobat Reader** plug-in. If you saved the file to your home directory, you might be able to view it in some browsers as:

`file:///afs/unity/users/u/unityid/file.pdf`

Only you can view the file with the `file:` address, not others. If you want the file to be viewed by others via `http://`, you will need to create a **www** directory in your home directory, save the file there, and view the file with the URL, `http://www4.ncsu.edu/~unityid/file.pdf` (see also **Publishing Your Web Pages**). You can also print the PDF file from the browser.

**Setting Printer Variables**

On UNIX, the default printer is set in the **PRINTER** environment variable. To find out your default printer, type `printenv PRINTER`. You can change the default printer by typing `setenv PRINTER` followed by the name of the printer you want to use. For printer names, see `http://print.ncsu.edu/listofprinters.php`. Using the `-P` option will always override the default setting (see **Print A File** section above).
Advice for Conserving and Sharing Print Resources

The following advice will help you conserve your print quota and share printers with others who use the Eos/Unity networked printing system. Please plan ahead for your printing since facilities are shared. Also, be courteous of others who must use these facilities, too.

1. Accustom yourself to working on-screen rather than on paper. Read and edit online and print final copies only. Send and share files via e-mail, AFS file-sharing, and posting to the web rather than making paper copies.

2. Check files with available Print Preview utilities, editors, and viewers before you print them. Make PDF files and view them with Acrobat Reader in your browser.

3. Only print pages that you have changed, not the whole document. This will save paper and keep you and others from having to wait long for output.

4. Check your print settings carefully before you print. For example, if you have just changed a setting to print three copies of a document, make sure you change the print setting back to one before printing again.

5. Do not use the printer as a copier. Copying costs as little as 3 cents a page. Printing is 6 cents a page.

6. Remember how to cancel print jobs. Type lpq to show the print queue, find your print job, and then remove it with the command lprm job#. On Windows, select My Computer -> Printers -> Document -> Cancel. Or use the facility for checking and removing jobs at http://print.ncsu.edu.

7. Turn off header and banner pages.

8. Be considerate of other users. Break up big print jobs into several shorter jobs so you do not monopolize the printer.

9. If you are not in a hurry, choose times when the lab is not busy to print large documents.

10. Save your documents to external media and use your home computer and printer for cheaper printing and convenience.

For more information on printing, see http://www.ncsu.edu/it/essentials/managing_files/printing/
8

Electronic Mail

Most users of electronic mail want to be able to read and send mail no matter where they are, at home or school, when they travel, or in non-traditional work and study settings. NCSU supports the IMAP protocol, which stores mail in individual user accounts on campus mail servers, and a mail program called **NCSU Webmail**, which allows users to access their mail through a web browser from anywhere in the world. Users do not have to come to campus to use specific mail clients or download their mail to a local computer in order to read it.

**IMAP Mail Protocol**

The *Internet Message Access Protocol (IMAP)* is well established on campus as the primary mail protocol. If your account was created in 2000 or after, you have an IMAP mail account. Your mail account is separate from your AFS account, although both are storage locations on campus servers. Each has a base quota of 50MB, which you can increase via the **Quota Manager** at [http://sysnews.ncsu.edu](http://sysnews.ncsu.edu).

You need to monitor your email quota just as you do your AFS quota. You can log in to **User Info** at [http://sysnews.ncsu.edu/](http://sysnews.ncsu.edu/) and look under **IMAP Quota Information** to see how much of your quota you have used. Your **Hesiod POBOX** record on the **User Info** page also shows you which IMAP server your mail account is on.

**Hesiod Information:**

```plaintext
PASSWD: mcdaniel:*:3693:108:Ellen McDaniel:/ncsu/mcdaniel:/bin/tcsh
FILSYS: AFS /afs/eos.ncsu.edu/users/m/mcdaniel w /ncsu/mcdaniel
POBOX: POP uni05map.unity.ncsu.edu mcdaniel
```

**IMAP Quota Information:**

- On server uni05map:
- Using 11.5MB out of 50.0MB quota (23.0% used)

**Note:** Ignore the *POP* designation in the POBOX record, which is an artifact from when all mail servers used the *Post Office Protocol*. Some accounts still use POP. The way to tell is to look at the server name itself. All IMAP servers have *map* in their names, e.g., `uni02map.unity.ncsu.edu`. POP server names have *mh* in them, e.g., `uni02mh.unity.ncsu.edu`. For more on IMAP, see [http://www.ncsu.edu/it/essentials/email_messaging/imap/](http://www.ncsu.edu/it/essentials/email_messaging/imap/).
NCSU Webmail: SquirrelMail

Webmail is built on a standards-based webmail package called SquirrelMail, which lets you access your mail from anywhere using a web browser. SquirrelMail is written in PHP4 with built-in support for the IMAP and SMTP protocols. All pages render in HTML 4.0 (no JavaScript required) for compatibility across browsers. You can move among computers and get to your mail from different places. All you need is a current web browser with cookies enabled. You log in to Webmail with your Unity ID and password at:

http://webmail.ncsu.edu/

Webmail only works with IMAP. If you use the older POP protocol, you will need to switch to an IMAP account in order to use Webmail, see http://www.ncsu.edu/it/essentials/email_messaging/imap/howmove.html.

Overview of SquirrelMail

The SquirrelMail interface has two frames, folders in the left frame and messages in the right. A quota gauge in the left frame indicates how much quota you have in your IMAP mail account, see following figure. The Current Folder at the top of the page tells you which folder you are in. INBOX is the default folder, but you can change into other folders as needed. Under Current Folder is the main menu:

Compose - Write and send an email message, including attachments.
Addresses - Access your personal address book to select addresses for mail.
Folders - Create, delete, rename, subscribe, and unsubscribe folders.
Options - Change settings for how SquirrelMail looks and behaves.
Search - Search a mailbox using specific criteria.
Help - Get help and documentation on how to use SquirrelMail.

Message Index

The Message Index appears in the right frame and lists the email messages that are in a particular folder. When you click on a folder, you will be taken to the message index of that folder, which informs you which messages you are viewing out of the total you have, e.g., Viewing Messages 16-30 (229 total). Messages appear with a checkbox beside them for you to select when you want to perform an operation on them, e.g., move, delete, etc. The Toggle All link at the top and bottom of the window allows you to check all select boxes at once.
Above the message list is a drop-down list with your currently subscribed folders. Any selected message will be moved to the selected folder with the **Move** button. Multiple messages may be moved at once. The **Forward** button attaches a selected message to a **Compose** window for you to send.

On the far right side of the bar are three buttons. The first two allow you to mark selected messages as **Read** or **Unread**. The third is the **Delete** button used to delete messages whose checkboxes you have selected.

The message list itself is organized into three columns: **From**, **Date**, and **Subject**. These headings tell you who sent the message (or at least what email address it came from), the date it was sent, and the subject line of the message. Between **Date** and **Subject** is a small column that marks messages with specific symbols:

- + the message has attachments
- ! the message is urgent
- A the message has been answered

Unread messages are bold. Already viewed/read messages are in normal text. If your message list is long, the list will be split into multiple pages. To view other pages, use the **Previous** and **Next** links at the top and bottom of the message list. You can also jump to a specific page by clicking its page number. If you select **Show All**, you will disable the pagination, and all messages will be displayed in a single scrolling list on one page.

**Read a Mail Message**

Click on the **Subject** of a particular message to display and read it.
Another menu bar is presented below the main menu with functions that allow you to work with the mail message or navigate through your mail.

**Message List** - Return to the list of messages for the **Current Folder**.

**Delete** - Delete the message currently viewed. The deleted message is moved from **INBOX** to the **Trash** folder but can be restored by opening the **Trash** folder and moving it back. All attachments of the deleted mail are deleted as well. However, you must empty the **Trash** folder (**Toggle All -> Delete**) for messages to be completely removed from your IMAP space.

**Previous/Next** - **Previous** displays the previous message without going back to the message list. **Next** advances you to the next mail message.

**Important!** If you want to delete the current message AND advance to the next message, select **Delete & Next**, which is only at the bottom of the message window (same for **Delete & Previous**), see figure above.

**Forward/Forward as Attachment** - Open a new **Compose** window with the message copied under **Original Message** and the **Subject** line filled in. Fill in fields and add content to send to another user. **Forward as Attachment** opens an empty **Compose** window with the message turned into an attachment.
Reply/Reply All - Open a Compose window with the message in the text field set off by \( > \) characters on every line. Re: is added to the subject line, and the To: field displays the address of the person you are replying to. Reply All does the same thing but replies to everyone listed in the To:, CC:, and BCC: fields.

Four additional links appear after Options directly above the message.

View Full Headers - Display the entire header of the message. This includes the route that the message took and detailed information about the message itself.

View Printable Version - Preview the message optimized and formatted for printing. Select the Print button to print or Close to return to the message.

Add to Addressbook - Put email address of the sender in your Address Book.

View Message Details - Provide more information about the message body.

Attachments - Display attachments sent with the message. Select the file name to open and display the attachment in the application it calls. Or, select download to download the file rather than view it.

Take Address - Put the address of the sender into your Address Book.

Compose a Mail Message

The Compose link takes you to a page where you write your email message.
From: - Select the address you want to use as a From: address. From: only displays if you have enabled multiple identities in Options -> Personal Preferences.

To: - Enter mail address of the person(s) to whom you are sending the message. Enter as many addresses as you like, separated by commas. Select the Addresses button to get addresses for this field from your Address Book.

CC: - Carbon Copy. To send others a copy of the mail, enter their email addresses here.

BCC: - Blind Carbon Copy. To send others a copy of the mail without the recipients in the To: or Cc: fields knowing about it, enter their email addresses here.

Subject - Enter relevant heading that accurately describes the message contents.

Priority - Set the importance of the message to you and/or the recipient: High, Normal, or Low. Normal is the default setting. Use High sparingly.

Signature - Insert a signature if you have created one in Options -> Personal Information.

Addresses - Search Address Book.

Save Draft - Save a message in the Drafts folder until you are ready to send it. To retrieve it, select the Drafts folder and open the message.

Send/Cancel - Send a finished message or cancel the Compose window.

Check Spelling - Check spelling in the message body.

Message Body - Text field where you type the body of your message.

Attach - Include a file with your email. Use the Browse button to search for the file on your local or networked drives. Select the file and Add. When the attachment is added, it is listed at the bottom of the Compose window with its file type and size included. If you decide not to send the attachment, select the checkbox beside the file and Delete selected attachments.

Address Book

The Address Book allows you to set up nicknames to use in place of longer mail addresses to save you time with data entry. Each nickname must be unique. The Help in SquirrelMail shows you how to set these up. You can also set up nicknames or aliases for lists of people. Six is the recommended maximum. If you need more, you should set up a Majordomo list at http://lists.ncsu.edu. To create a list:
1. Go to [http://webmail.ncsu.edu](http://webmail.ncsu.edu)
2. Log in using your Unity ID and password.
3. Select **Addresses** at the top of the screen.
4. In the **Add to Personal address book** section, type the nickname of the email list you are creating.
5. In the **E-mail address** field, type in all of the addresses of the list members (recommended 6 maximum), separating them with commas.
6. In the **First name** field, retype the name of your list. Leave **Last name** blank.
7. Select the **Add address** button to save.

To send mail to a list you have created:

1. Open **INBOX** and **Compose**.
2. In the **To:** field, type the nickname of your list, compose, and send. The message will be sent to everyone on the list.

To edit a list:

1. Choose **Addresses**.
2. Find the name of your list in the **Nickname** column.
3. Mark the check box to the left of the name and select **Edit selected**.
4. Change the field(s) as needed and select **Update address**.

Webmail will allow you to search for email addresses of all NCSU faculty, staff and students. Select **Compose** and choose **Addresses** to search through your own address book or through *ldap.ncsu.edu* for any address in the university directory.

To import an address book from another mail program, it must be in CSV format. In the other mail program, export and save the address book as a CSV file. To import it into Webmail, select **Import CSV File** and browse to the location of the saved CSV file. You can also export your Webmail address book as a CSV file by selecting **Export CSV File**.
Folders

Folders for organizing your mail are easy to create in SquirrelMail, as the following figure shows. Select Folders and create a folder under INBOX, or another folder, by typing a name in the field and selecting Create. The new folder appears in the left frame of the SquirrelMail application when you Refresh Folder List; then you can select and Move messages from the Message List to the folder.

To rename a folder, select the folder and Rename. In the window that comes up, type in a new name and Submit. To delete a folder, select the folder and Delete.

Options

SquirrelMail lets you create a signature and multiple email address identities. You can customize the application extensively and set it up the way you like to work. You do all of this under Options. Signatures and identities are set up under Personal Information. The rest are set and managed through a variety of web pages in the application. Consult Help for information on Options. It is best to enter your personal information and set up the application when you first begin using SquirrelMail, so explore Options as soon as you start using the program.

Over Quota

You may see the following message when you log in to Webmail/SquirrelMail. If so, check the quota gauge in the left frame to see if it is nearly full. Also, keep up with your IMAP mail quota at https://sysnews.ncsu.edu/tools-bin/user-lookup.
When you delete a message in SquirrelMail, it goes into your Trash folder. Items in Trash are still on the system and count toward your quota, but it is easy to restore a deleted message if you need to. However, you need to purge your Trash periodically to clear up space. Just select the purge link next to the Trash folder.

If you go over quota, you cannot send items to the Trash folder, even if it is empty. You will need to permanently delete some messages from other folders. To do this, change your Trash folder preferences as follows:

1. Select Options -> Folder Preferences.
2. In the Special Folder Options section, select [Do not use Trash] from the drop-down menu next to Trash Folder.
3. Save your changes by selecting Submit at the bottom of the page.
4. Return to your INBOX by selecting its link in your Folders list.
5. Delete enough messages from one or more of your folders to recover part of your quota. These messages will be permanently deleted instead of transferred to the Trash folder.

Your recovered quota will be available immediately. Reload the page to see the updated usage. SquirrelMail will now permanently delete any messages as soon as you delete them from a folder.

To change back to the default setting of moving deleted messages to Trash:

1. Go to Options -> Folder Preferences -> Special Folder Options.
2. Select INBOX.Trash from the Trash Folder drop-down menu.
3. Select Submit.

Help with Webmail

For help and instruction in the use of Webmail and SquirrelMail:

http://www.ncsu.edu/it/essentials/email_messaging/webmail

http://www.ncsu.edu/it/essentials/email_messaging/

http://www.squirrelmail.org/
Preferred Email Addresses

Many users have mail accounts through AOL, HotMail, etc. Your mail can be sent to these other mail providers if you prefer. However, remember that you will be on campus for a long time, so consider the benefits of a free and long-term campus mail account. You get more quota and can send and receive larger mail attachments than you can with most service providers. Plus, you receive local support.

A good solution is to keep your email service-provider account for personal use. Use your Unity email for academic purposes only. You will get less spam in your Unity mail account and reduce the chance of missing important communications from your professors, classmates, and, eventually, from prospective employers, who prefer communicating with unityid@ncsu.edu than with skiptomyloo@hotmail.com or mydarling@gmail.com.

NCSU supports only one mail address per user, which is the Unity mail address unless the user specifies an alternate preferred mail address (not a forward). In other words, you must choose one mail address where everything is sent. You cannot set it so that mail sent to the Unity ID forwards to the alternate address.

Students set their preferred email addresses at:

https://www.acs.ncsu.edu/reg_records/tracs_lk/trc_frm.html

Faculty and staff set their preferred email addresses at:

http://www.ncsu.edu/directory/

Mail Attachments: Advantages of PDF

It is common for people to attach and send Microsoft Office files, particularly Word files. The problem with this practice is that in order to read the file, the person must have that application on his/her system. If people are away from their primary computer or do not have the application, they cannot read the attachment.

It is also the case that files that come in with .doc attachments may not be opened by people who do not know you because of the risk that they may carry a virus or worm. This can be a problem if you have sent a resume to someone, and they choose not to open it for this reason alone.

If the document is text only, you may wish to copy it as text directly into the email. Consider also converting your documents to Portable Document Format (PDF).

PDF has several advantages as a mail attachment:
• Reduced chance of carrying a virus or worm.
• Readable on any computer via a web browser and the Adobe Reader plug-in. The recipient does not need to own the application the file was created in to read the file.
• Smaller file size for sending/receiving. NCSU has a limit on the size of mail attachments you can send, so PDF can help keep your attachments smaller.
• Preservation of document’s look and layout across multiple media, e.g., handhelds, web, print.

Adobe Acrobat, the application used to make PDF, is in all Eos and Unity labs and widely available across campus. In most applications, you select File -> Print -> Acrobat Distiller to print a file to PDF. In other applications, you select File -> Save As and choose PDF as the format to save to. Other applications can also make PDF, e.g., PDF Factory (http://pdffactory.com). See also Printing.

Mail Forwarding

NCSU ITD offers email forwarding to faculty and students. Send your request to accounts@ncsu.edu with the address to which you want your e-mail sent. Write to this same address to turn off mail forwarding. Forwarding is available to everyone but is limited to four months for undergraduates. Faculty and staff can have mail forwarded for longer periods of time.

Important! Mail cannot be sent to two addresses. If your mail is forwarded, you cannot access it via the mail services and software on Unity until you stop the forward. The UNIX mail .forward file mechanism is not supported on Eos/Unity and will not work.

Outgoing Mail Relay

Outgoing SMTP servers vary depending on the computer you use to connect to them. The following list tells you what name to put into your email setup field for your outgoing mail server:
• smtp.ncsu.edu: computers in on-campus buildings
• smtp-resnet.ncsu.edu: ResNet computers in residence halls or on-campus chapter houses
• relay-mail.paetec.net: computers in University Tower.
• ISP’s outgoing mail server: computers located off-campus. Contact your ISP for this information.

Some ISPs require you to use authenticated SMTP if you want to use their SMTP server but your NCSU from/return address. For example, if you live off campus and want to send mail with your NCSU email as the From: address but use Road Runner's SMTP server, you will need to use authenticated SMTP.

**Viruses and Spam**

*Spam* is unwanted junk email. A *virus* is a program that makes copies of itself and spreads, often by email, by attaching itself to other programs to infect computers with *malware*. The campus email administrators filter mail to remove as much spam as they can and to prevent the spread of viruses. However, individuals can protect themselves from viruses and spam by following the advice below:

• Do not reply to spammers, and do not become a spammer yourself by broadcasting mail, see [http://www.ncsu.edu/rulesregs/](http://www.ncsu.edu/rulesregs/).

• Never unsubscribe to spam mail. Offering you the opportunity to unsubscribe is a ruse to see if your mail account is alive and therefore valuable to other spam lists the spammer may sell to.

• Do not post your email address on web pages. Do not give out the email addresses of others when web pages ask for them. Be careful with free email accounts, email groups, web hosting, open lists, shareware, etc. All want your email address. Keep a personal email for non-NCSU activities. Keep your NCSU mail address as private as possible.

• Before opening an email attachment, scan it to ensure that it is not infected. If you do not know the source of a file, do not open it. Even if you know the person who sent you a file, if you were not expecting it, you may want to contact them before opening it. Many viruses automatically send themselves out to addresses they find in files on the infected computer.

NCSU implements a number of strategies and technologies to prevent spam and viruses from getting to you.

• Manages block lists for the campus mail relays to stop viruses, mail loops, bad hosts, and spam directed at our entire user installation.

• Periodically scans the network for machines accepting mail and performs third party (open) relay checks.
The campus has also licensed Symantec's Norton AntiVirus and PureMessage for NCSU faculty, staff, and students to help them fight spam and viruses on their work and home computers.

**Symantec's Norton AntiVirus**

Most viruses find their way to your account via e-mail and e-mail attachments. NCSU purchases Symantec's Norton AntiVirus software and makes it available at [http://www.ncsu.edu/antivirus/](http://www.ncsu.edu/antivirus/). It is free for download by students, faculty, and staff to their on-campus and personal computers. Users can install either a managed version, which automatically updates virus definitions, or the unmanaged version, which requires the user to initiate updates. Run Live Update to keep your virus definitions current if you are managing your own updates. More information can be found at:

- [http://www.ncsu.edu/antivirus/](http://www.ncsu.edu/antivirus/)
- [http://symantec.com/](http://symantec.com/)

**PureMessage**

Adapted from [http://www.ncsu.edu/it/essentials/email_messaging/pure_message/](http://www.ncsu.edu/it/essentials/email_messaging/pure_message/). PureMessage is a mail filtering agent that attempts to identify spam and viruses. When an email passes through NCSU's mail relay system, it is processed by the PureMessage daemon, which attempts to determine if it is spam or contains a virus. If an email message satisfies one or more of the definitions used by PureMessage, it is assigned a hits percentage. The greater the percentage, the more likely it is that the message is spam or virus-contaminated.

PureMessage automatically quarantines an attachment that is infected with a known virus, replacing it with text that explains why the attachment was removed. Because a message may have been legitimate except for a virus-infected attachment, PureMessage removes only the infected attachment, not the message itself. Similarly, PureMessage is configured to identify spam but not to delete it automatically. Users must set up their own filters to sort and remove what they do not want.

Until this year, users could only set up filters in the email programs (clients) they used. The web site above provides instructions on how to do filter setup in specific email clients. However, recently, it became possible to set up filters on the server, and this option offers significant advantages. The main advantage is that you can move among mail clients without setting up or changing filters because messages are filtered at the server level and never get to your client.
The following solution will help you set up server-side filtering if you are on IMAP, which nearly all NCSU users are (to find out, see the IMAP Mail Protocol section of this chapter). If you are a POP user, you will need to set your filters in your email client.

From Remedy Solution http://help.ncsu.edu/services/get-soln.pl?id=3099

Server-side filtering has many advantages over client-side filtering. First, setting up a filter on your mail server instead of the email client on your local computer means that your mail is filtered all the time, even when you are not checking your mail. Also, even if you use another email client somewhere else (like WebMail, or a client at an Internet cafe), your mail will still be filtered as you like it.

To enable server-side filtering of spam using the campus PureMessage service:

2. Log in using your Unity login ID and password.
3. In the main message window, click on the Filters option at the top of the page.
4. Click on the Add a New Rule button.
5. Under Condition, select Header Match from the Rule Type menu.
6. Select X-Spam-Flag: as the header, leave contains as the comparison, and type in “YES” in the last field. The condition should now read, "The header X-Spam-Flag: contains YES."
7. Under Action, select the Move message into option. If you already have a folder for spam, choose that folder under the existing folder. If you need to create a folder, select a new folder, named and type a name for whatever you would like your junk mail folder to be called e.g., Spam.
8. Select the checkbox next to the stop sign to stop further filtering of spam messages.
9. Click the button, Add New Rule.

If you get unwanted mail and wish to report it, please send it to the correct place:

- If the spam was generated on-campus (as determined by its headers), forward it to abuse@ncsu.edu.
- If it was generated off-campus, forward it, with full headers, to spam@ncsu.edu.

See also “Minimizing Spam” at http://www.ncsu.edu/it/essentials/email_messaging/minimizing_spam.html
9 Safe Computing

Thanks to Don Schmidt and the Information Technology Division for permission to use the excellent content at the Safe Computing web site for this chapter.

http://www.ncs.edu/it/essentials/password/safe_computing/safe_computing.html

The loss or corruption of the data we store on our computers or network file space can cause anything from mild frustration to major disaster. Whether personally or in the work we do, our information is important and valuable to us. The rules have changed in today's world. Information is being transmitted in many ways at extremely high speeds. While networked computers are probably the most efficient and widely used medium for data transmission, they are also among the most vulnerable.

To protect our data from harm, we need to practice safe computing. That means taking the appropriate precautions and behaving in ways that protect our data and those we share it with. This chapter will serve as a guide to help you practice safe computing at NC State.

Do's and Don'ts of Safe Computing

The following do’s and don’ts should be followed to protect you and others in networked computing environments.

Do...

* Change your Unity password at least once each semester and keep it secret.
* Remember to log out of lab workstations, kiosks, nomadic network connections, online services, etc.
* Install an anti-virus program and keep it up-to-date on computers for which you are responsible: Anti-virus software is available free to NC State students faculty and staff for home and campus use.
* Scan all downloaded files and email attachments for viruses before opening them.
* Make back-up disks of your important files.
* Keep security patches up-to-date on your computer. If there is no automatic update feature for your computer's operating system (OS), go to the OS manufacturer's Web site for the latest updates. A weekly check is good.
* Be aware of what network services are running from your computer and disable all those not needed. (Your computer may be operating as a Web or file transfer server without your knowing it!) Most OS Help menus include instructions on how to identify and disable unneeded services under keywords servers or services. A weekly check is good.

* Keep informed about the latest network security risks, including programs that may enable your computer and the university's network to be used for illegal or commercial purposes. See for example http://securityresponse.symantec.com/

* Read and follow the End User License Agreement for all software that you own or use.

* Make wise decisions about who uses your personal computer. You may be held responsible for their actions!

* Follow all the NC State Computer and Network Use Regulations and Rules, http://www.ncsu.edu/it/rulesregs/

Do NOT...

* Write down your password or share your account with anyone.

* Use copyrighted images for publications or Web sites without the permission of the copyright holder.

* Attempt to gain access to computers or accounts for which you are unauthorized (hacking).

Know the Risks

Viruses are small files that attach to other files or programs. They are usually spread through email attachments and by downloading infected files. Many viruses are little more than annoyances. However, some can destroy your data. Some viruses will send copies of themselves to all of your email contacts, potentially infecting them as well.

Trojans are often transmitted in the same ways as viruses but can be far more damaging. Trojans are often sent deliberately so that someone can take over a computer. Through a trojan, a hacker can use your computer to break into other computers over the Internet. Because it is the hacked computer that appears to be the attacker, its owner is the person held responsible.
Take Precautions

NC State provides anti-virus software free of charge for all currently enrolled students, faculty and staff. You can download it from http://www.ncsu.edu/antivirus.

It is extremely important that you update your anti-virus software frequently, as new viruses and trojans are being created all the time. You should scan all attachments and downloaded files for viruses before you open them, and never open email attachments that you were not expecting or that are from someone you do not know. If you are unsure whether an attachment is legitimate, check with the sender before opening it.

Current versions of most operating systems provide a way to keep the operating system up-to-date. Make sure you install all security patches and bug fixes made available from the manufacturer. In many cases, you can configure your operating system to automatically alert you when new updates are available.

Keep Your Secrets

The first time you log in to your Unity account, you should change your password. It is easy to do. Just go to the interactive password change utility at http://www.ncsu.edu/password on the Web and follow the simple instructions.

Your password should contain at least six characters and should be something you can easily remember but not anything that people might associate with you, such as your name, friend's name, pet's name, your initials or your name backwards. Also do not use birthdays, anniversaries or your login ID.

Because passwords are case-sensitive, it's a good idea to use numbers, special characters and a mixture of upper and lowercase letters somewhere in the password to make it more difficult to guess. You may want to create a personal acronym, e.g. "I lived in Alaska for five years" = iliAf5y.

You should change your password at least once a semester and always keep it secret. It is against NC State policy to allow someone else to access your account.

If you don't change your password or keep it secret, someone else could gain access to your account and erase your work, use all your print quota, or send email to thousands of people with your name and email address attached to it.
Stay Legal

Copyright infringement is against university policy and state and federal law. You are responsible for understanding what constitutes legal use of music, movies, software, images, and other copyrighted works that you own or use.

The No Electronic Theft (NET) Act of 1997 allows for criminal prosecution of individuals who electronically copy and distribute copyrighted work, even if there is no commercial gain from doing so. This is punishable by up to three years in prison and a $250,000 fine, so knowing the law is part of safe computing.

Recorded music and DVDs are copyrighted. It is illegal to download, copy, distribute or sell such works except as allowed by the copyright holder. For example, some bands allow free distribution of concert recordings but not of studio-recorded CDs. Distributing the concert recordings is legal, provided it follows the procedures set out by the band. Distributing copies of the studio CDs either through duplication or MP3s is against the law and can be punishable by fine and imprisonment.

Violating the End User License Agreement (EULA) which comes with most software is also against the law. EULAs tell the owner, among other things, how many computers the software can be installed on and how many copies can be made. Some software, such as Netscape is freely available, but is still protected by copyright. As in the case of Netscape, it may be illegal to distribute certain freely available software packages.

Where to Get Help

Computing Services Help Desk, help@ncsu.edu
http://help.ncsu.edu

ResNet, resnet@ncsu.edu
http://www.ncsu.edu/resnet

Free Symantec AntiVirus software
http://www.ncsu.edu/antivirus/

C.L.E.A.R Security
http://www.ncsu.edu/it/essentials/password/computer_security/

Computer and Network Rules and Regulations
http://www.ncsu.edu/it/rulesregs
10 Wolfware

Wolfware is a web-based course management environment that simplifies the development and delivery of online course content. Built within the Eos/Unity computing environment, Wolfware leverages AFS to scale a common system of uniform course-locker creation and management across all courses taught at NCSU. The web browser is the graphical interface to both the instructor side of Wolfware, where courses are set up and administered, and the student side, where students access their courses' online content and tools. Wolfware courses can be found at http://courses.ncsu.edu, and help is available at http://wolfware.ncsu.edu.

courses.ncsu.edu

Wolfware lockers are accessed from http://courses.ncsu.edu. The web site lists all the departments with Wolfware lockers. The following is the list of departments with lockers for Summer I, 2006.

<table>
<thead>
<tr>
<th>All Courses</th>
<th>Summer I 2006</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACC</td>
<td>CE</td>
</tr>
<tr>
<td>ANT</td>
<td>CH</td>
</tr>
<tr>
<td>ARE</td>
<td>CHE</td>
</tr>
<tr>
<td>BIO</td>
<td>COM</td>
</tr>
<tr>
<td>BUS</td>
<td>CS</td>
</tr>
</tbody>
</table>
Wolfware uses course-catalog and Registration and Records information to automatically create a boilerplate home page for each course so that it has a presence on the web, see figure below. This course URL is the initial point of entry to the course locker with links to every active section.

Wolfware also automatically generates rolls and class mailing lists for each course and section. It provides tools for discussion, secure homework submission and retrieval, and restricted access to web pages. Each section on the course boilerplate page has links to information and tools that students use in their classes, **Home Page**, **Message Board**, **Submit Assignments**, etc.

http://courses.ncsu.edu/e115/  
Student Links: TRACSLINK | Policies | My Library  
Faculty Links: WolfWare Toolbox | Reg & Records

<table>
<thead>
<tr>
<th>E 115</th>
<th>Introduction to Computing Environments</th>
<th>F,S,Sum</th>
</tr>
</thead>
</table>

Fundamentals of the EOS System. Software and services available on the system. Network hardware configuration, on-line help and communication, file and directory manipulation. Software applications such as E-mail, publishing packages, spreadsheets, mathematical packages, CAD packages.

### Current Sections

<table>
<thead>
<tr>
<th>Course-Section</th>
<th>Instructor</th>
<th>Days</th>
<th>Time</th>
<th>Room</th>
<th>Links</th>
</tr>
</thead>
<tbody>
<tr>
<td>E115 - 002</td>
<td>NELSON</td>
<td>T</td>
<td>12:25P-3:15P</td>
<td>100K</td>
<td>Home Page</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Message Board</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Submit Assignments</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Grade Book</td>
</tr>
</tbody>
</table>

**Finding Your Wolfware Classes and Links**

Wolfware is platform and browser independent, and course lockers are listed at [http://courses.ncsu.edu/](http://courses.ncsu.edu/). Students access their class content and tools through the **Links** column of the course boilerplate page at [http://courses.ncsu.edu/crsnum](http://courses.ncsu.edu/crsnum), e.g., [http://courses.ncsu.edu/e115](http://courses.ncsu.edu/e115). At this time, there are five links possible: **Home Page**, **Message Board**, **Submit Assignments**, **Retrieve Assignments**, and **Grade Book**. (WebAssign and WebCT must be accessed from [https://www.webassign.net/ncsu/](https://www.webassign.net/ncsu/) and [http://webct.ncsu.edu](http://webct.ncsu.edu), respectively).

To access/use any of these, the student locates his/her class in the **Course-Section** column and selects the appropriate link from the **Links** column. The following
URLs follow the pattern set by Wolfware for all classes, if you substitute your course number and section for E115-002.

**Course location:** [http://courses.ncsu.edu/e115/](http://courses.ncsu.edu/e115/)

**Web site for all course sections:** [http://courses.ncsu.edu/e115/common/](http://courses.ncsu.edu/e115/common/)

**Section web site (lecture):** [http://courses.ncsu.edu/e115/lec/002/](http://courses.ncsu.edu/e115/lec/002/)

**Secure section content:** [http://courses.ncsu.edu/e115/lec/002/wrap/](http://courses.ncsu.edu/e115/lec/002/wrap/)

**Home Page**

The **Home Page** link takes you to course content for the course. Here you get the syllabus and class materials as the instructor makes them available to you. The course content is generally delivered from the [http://courses.ncsu.edu/crsnum/lec/sec/](http://courses.ncsu.edu/crsnum/lec/sec/) but not always. Some of the content may be at [http://courses.ncsu.edu/crsnum/common/](http://courses.ncsu.edu/crsnum/common/) or from another location altogether.

Sometimes you must log in with your Unity ID and password to access class materials. As a rule, all **Home Page** content is world readable unless the instructor has specifically placed material in a secure folder and set access for viewing by the section only, all course sections, or all of NCSU. This material may be unpublished research, copyrighted content, or sensitive in some way that it requires secure access by authorized individuals through the NCSU WRAP system (Web Realm Authentication Protocol). Any materials that have been placed by the instructor in [http://courses.ncsu.edu/crsnum/lec/sec/wrap/](http://courses.ncsu.edu/crsnum/lec/sec/wrap/) will require a login and password to view and use.

**Message Board**

Wolfware uses **Message Board** for class discussion. The instructor sets up discussion **Forums**, and students participate in the online discussion by posting **Topics** and replying to posts within these forums. Put simply, faculty create **Forums**, and students create **Topics**, although faculty may define other ways to use the tool.

For example, in the History 270 class below, the instructor has set up **Forums** to discuss both a subject area, **History of the Modern Middle East**, and a specific class, the **May 29 Lecture**. To participate in one of these forums, students select it, and on the web page that comes up can **Post a New Topic**. Or, they can use the **Search Topics** to search and locate information by key word, or select a topic link to enter the discussion.
Submit Assignments

Submit Assignments is a tool for the secure submission of student files into the course locker. Assignments are added when the instructor uses the Submit Admin tool to name the assignment, set inclusive time/dates for assignment submission, and identify the users who can submit. When the instructor sets up an assignment for submission, it will appear as a Submit Assignments link on the boilerplate course page in the section's Links area.

Students select this link and log in to go to the submission page (the system lets through only those students enrolled in the class and able to submit). Once there, students see a list of assignments they can submit to. If the assignment cannot be submitted to, it will say CLOSED. If open, the student will be able to select it and go to a page like the one below.
A **Browse** button appears that allows the student to locate the file on their local or network drives. Once the file is selected (it must appear in the field beside the **Browse** button to be selected), the student selects **Upload File** to transfer the file. Any type of file can be submitted to the locker, but only one file at a time. If a folder or multiple files need to be submitted, they would need to be zipped or tarred first before submission as a single file, see **Storage and Backup**.

The file is uploaded to a secure **submitted** directory in the course locker. This directory is automatically created by Wolfware when the locker is generated.

The AFS location of the student's submitted file is:

/afs/eos/courses/crs/crsnum/lec/sec/submitted/assignment/userid/file

The Submit tool creates the assignment directory (e.g., *Homework3*), and all students who submit files to this assignment will have directories created for them inside this directory, e.g.,

/afs/eos/courses/ww/ww101/lec/001/submitted/Homework3/mcdaniel/webprog.doc
Students cannot delete a submitted file, but they can overwrite it by submitting a file of the same name. If the upload is successful, students are returned to the page showing a listing of all the files they have uploaded, the date of the upload, and the size of the file as saved in the locker (see above).

If the instructor chooses to grade and return assignments through Wolfware, students can pick up their returned work via the **Retrieve Assignments** link on the course boilerplate page. The same is true with grades, if the instructor chooses to use the **Grade Book**. Grades and submitted assignments are restricted to access by the authorized student only (login required).

### Wolfware Class Mail

Wolfware lockers are set up automatically with downloaded rolls from Registration and Records (R&R). Professors also use automatically generated class mail lists to communicate with their classes, e.g.,

`crsnum-sec@wolfware.ncsu.edu`

`e115-001@wolfware.ncsu.edu`

You may not write to the class email address unless the instructor sets it up for you to do so. Default class mail is one way, from the instructor to the class.

If you have problems with your email, it is usually because you are using a non-NCSU mail address, or there is an error in your address. Your professors cannot fix your address because it is downloaded to them from R&R. You must fix your preferred email address at [http://www.ncsu.edu/registrar/students.html](http://www.ncsu.edu/registrar/students.html), **Update Directory Information**.

You should consider the benefits of using your Unity address, `unityid@ncsu.edu`, as your preferred mail address for classes and work at NCSU rather than one from a service provider. Unity mail is free, and you have it to use for four years, plus four months after graduation. Service is available anywhere, anytime via [http://webmail.ncsu.edu/](http://webmail.ncsu.edu/). Your mail is backed up nightly on university mail servers, and the size of the mail attachments you can send/receive is larger than most service providers provide.

If you keep your Unity mail for classes and work and use a separate mail address for personal use, buying online, and non-NCSU communication, you are more likely to keep spam out of your Unity mail and have fewer problems with getting/receiving class communications. Some of your professors may insist that you use your Unity address to reduce problems with class mail (see **Electronic Mail**).
Unlike files that store information or data, a directory is a file that points or links to other files, including other directories. Directories are represented as folders on Windows, Linux, and Mac graphical interfaces.

**Directories in AFS**

The AFS file-management software on Eos/Unity builds a tree hierarchy of all user and software directories, plus hundreds of other specialized directories for courses, projects, and university units. It is this shared file space that makes the Eos/Unity system unique. Everything is somewhere represented as a branch on the tree. AFS stores all these directories on network server machines and then retrieves them for the user, no matter when or where s/he is logged in, or on which realm platform.

For example, users who log in to the system are automatically placed in their home directories, where the files they create are collected and stored. Each home directory, identified by the user's Unity ID, defines a branch in the tree that belongs to that user alone, e.g., /afs/unity/users/jjqpublic/. However, the user is free to move around the tree and go wherever access is granted, to locate software, class information, user tools, and other resources (see *AFS File Sharing*).

**Directories and Subdirectories**

All directories in AFS branch from the root directory, `/`, the top-most directory in the tree. Technically, everything that branches from a directory is a subdirectory. However, users tend to use the word directory not only for the top root directory, but also for any main directory of files. In other words, a directory usually refers to a main branch on the directory tree (a base or starting place), and a subdirectory to a more specific collection of files that branches from that base.

A subdirectory is also called a child directory to the parent directory just above it in the hierarchy. Every directory, except the root directory, has one parent, and directories can be nested to any depth.

**Lockers: A Special Directory**

*Locker* is another name for a directory or folder and is a term that originated at MIT in the Athena Project. Although the terms directory and locker are used inter-
changeably and they look the same to the user on the system, a locker is a collection of a main directory and all the subdirectories under it. It is also a separate AFS volume with its own quota and access control list.

Users often call their home directories their lockers, which they are because they are unique and separate from directories above or beside them. Permissions and quota are individually set for each home directory, and the user alone is in control of what happens in his or her locker.

Likewise, software is stored in individual lockers, which can be restricted to certain users. Also, course lockers in Wolfware (courses.ncsu.edu) are assigned their own quota and can be accessed only by students in the class. In short, a locker is a storage container in the file system, associated with a particular user, purpose, or application, and assigned its own quota and permissions.

**Paths: Absolute and Relative**

You generally work in one directory or folder at a time. Whatever directory you are working in at the moment is called the *working* or *current* directory.

The path to a directory in the campus AFS file tree originates in the root directory, `/`. Other slashes join the names of subsequent subdirectories until the working directory is reached, e.g., `/afs/unity/users/j/jqpublic/` or `/afs/eos/courses/e/e115/`. This *full* or *absolute* pathname of a directory always starts at the root directory. No matter how long the path is, it always has the same starting place.

On Windows, `/afs` has been mapped to the *J: drive*, so the absolute path will be `J:\unity\users\j\jqpublic` or `J:\eos\courses\e\e115`. If the path is not displayed in the address bar of the folder (directory), select **My Computer -> Tools -> Folder Options -> View**, and check the box, **Display the full path in the address bar**.

On Solaris and Linux, the user can change the *eos%* or *unity%* prompt to show the path of the working directory. If the path is displayed, the user does not have to type the *pwd* command to see where s/he is. In an editor, open the file `.mycshrc` in your home directory (e.g., `nedit .mycshrc`) and add the line:

```
set prompt="\%/ %"
```

(percent, forward slash, space, percent)

Save the file, and the path of the working directory in AFS will always display as the prompt.
A *relative* pathname begins in the working or current directory, so the part of the path above the working directory is not referenced. A relative path is used to refer to file and directories below the working directory, which acts as the root. For example, if jqpublic is in his home directory, the relative path to his personal web page is *www/index.html*. The absolute path would be */afs/unity/users/j(jqpublic)/www/index.html*, see following diagram.

A *default* directory is the directory that the system puts you in automatically. For example, when you log in, you are placed by default in your home directory. On Solaris and Linux, if you are working outside your home directory, you can type **cd** by itself or **cd ~** to take you back to the default directory (the tilde ~ is the symbol for your home directory). On Windows, you are placed by default on the *desktop*, and your home directory is the **K: drive** and **My Documents**.

If you are granted access to other parts of the AFS tree, you will be able to move through and look at other directories, but only in the NCSU cells, *bp* and *bp.ncsu.edu*, *eos* and *eos.ncsu.edu*, and *unity* and *unity.ncsu.edu*. (Access is usually through the **J:drive**.) You may even be able to read and write in other directories if explicit permissions are set to grant you that access.

The whole campus is interconnected through AFS, making possible a lot of common access and file-sharing. The key to getting where you want to go in AFS is the pathname of the desired location (i.e., file or folder) and the permission to access it (see *AFS File Sharing*). AFS pre-dates the World Wide Web but works in much the same way, that is, know the pathname (address) of what you want and have the authorization to access it.

A pathname is simply a map that shows you how to get to a file through levels of nested subdirectories. It is like a route charted through a maze of streets that takes you to the address you want to reach.

For more information, see [http://www.ncsu.edu/it/essentials/managing_files/](http://www.ncsu.edu/it/essentials/managing_files/)
AFS File Tree: NCSU Cells (bp, eos, unity) and Selected Branches

/  
  
  afs/  
  
  athena.mit.edu  bp.ncsu.edu  cmu.edu  eos.ncsu.edu  umich.edu  unity.ncsu.edu  
  
  contrib  dist  engrwww  courses  lockers  lockers  users  
  
  jdk  openoffice  pine  ansys  matlab  sas  acc  e  zo  a  j  z  
  
  bin  src  acc100  acc630  e115  zo150  z0885  jqpublic  
  
  pine  archived  common  lec  prep  www  
  
  e115_00112002...e115_60482003  EosLabs  Review  www  001  604  index.html  
  
  index.html  
  
  graded  submitted  www  
  
  assignment  assignment  index.html  wrap  
  
  userid  userid  
  
  graded-file.xxx  submitted-file.xxx
12 Working with Directories and Folders

In your home directory, and any other directories you work in, you will create a hierarchy of subdirectories and files to organize your work. If you create a directory on a Solaris or Linux workstation, it will appear as a folder on Windows, and vice versa. Although they perform the same function, directories and folders are created and manipulated differently on each platform.

Directory Commands for Solaris and Linux

Directory commands that users need to work on Solaris and Linux are typed in a terminal (Xterm) window on the command line after the shell prompt. Check the path (pwd) to make sure you are creating, listing, or removing directories where you intend.

The following are the most commonly used directory commands. Consult man pages, books, or web resources for more on working in UNIX, see also Working on UNIX and Appendix A.

Make Directory (mkdir)

The mkdir command creates a directory. Type the command mkdir followed by a space and the name you want to give to the directory. For example, if you are in your home directory and want to make a subdirectory called homework, type:

```
mkdir homework
```

UNIX creates a new subdirectory named homework and places it one level below the working directory. The relative pathname is ~/homework (the tilde is the symbol for your home directory). It will appear as the homework folder on your K: drive on Windows.

Change Directory (cd)

The cd command changes or moves you into another directory. When you "cd" to a directory, you change your current working directory to the one you specify. For example, after creating the homework subdirectory in your home directory, you change into that directory by typing:
**cd homework**

The subdirectory *homework* is now your working directory, and the files you create will reside in this subdirectory, see also *Directories and Paths*.

To change back to your home directory (the parent directory), type `cd` followed by a space and two periods. The two periods tell the system to take you up one level in the directory tree:

```
  cd ..
```

or

```
  cd ~
```

or

```
  cd
```

The command `cd` by itself always returns you to your home directory (`~`) no matter where you are in the AFS tree.

**List Files in a Directory (ls)**

The *ls* command lists the names of all of the files in a directory. If you are in your home directory, *ls* will give you a directory listing of all of your files and subdirectories. If you want to see what files are in a subdirectory you created, either change into that subdirectory with the `cd` command and type *ls* to see a listing of its contents, or type *ls* followed by the absolute or relative pathname to the directory:

```
  cd /path/to/directory
  ls
```

or

```
  ls /path/to/directory
```

You can also use the UNIX special symbols for directory-listing shortcuts. The command *ls ..* lists the files in the directory one level up (the parent directory). The *ls ~* command lists the files in your home directory, no matter where you are on the system. To list a subdirectory in your home directory, *ls ~/subdirectory*.

You can also tailor commands with *options*. For example, to list all files in a directory, including hidden files or dotfiles, add the `-a` option for *all*.

```
  ls -a
```
To get more information about your files, including when they were made, their size, etc., use the `-l` option for long format listing.

```bash
cp -r directory1 directory2
```

**Remove Directory (rmdir)**

The `rmdir` command removes or deletes a directory. UNIX will not remove a directory that you are currently working in or a directory that contains subdirectories, files, or dotfiles. You must completely empty a directory before you can remove it (see `rm` command in *Working with Files*).

For example, if you want to remove the subdirectory `homework` from your home directory, first remove all files and subdirectories inside it. Then, type

```bash
rmdir homework
```

If you get a message "rmdir: directoryname: Object is remote," the system is telling you that the directory still has files in it. Use `ls -a` or `ls -al` rather than `ls` to view all the files. Sometimes, software will write dotfiles to your directories that a simple `ls` will not show. Remove them in the same way you remove an ordinary file.

```bash
rm file
```

To remove a directory and all of its files and subdirectories (be careful with this!):  

```bash\nrm -r directory\n```

**The add and attach Commands**

`add` and `attach` are special commands on the system (not standard UNIX commands), which simplify locker access on Solaris and Linux. These commands allow users to attach a remote file system to a directory hierarchy on their workstations and then map the path to it to a shorter name space. They create a link from the longer pathname to the shorter one and also obtain AFS tokens that allow access to the files in that locker. As a result, instead of typing the long pathname
(beginning with /afs) to change into the directory you want, you **add** and **attach** the locker you want and change directories into it using the short pathname, /ncsu.

**add** and **attach** are very similar. In fact, **add** calls the **attach** command but adds the *bin* directory to your path for that locker. Usually, you attach user and course lockers because you are not likely to want to execute any files in those directories. For example, to attach the locker for E115, where information about the E115 course is kept, type:

```
attach e115
```

Then change into that directory with the command **cd** /ncsu/e115 rather than **cd** /afs/eos.ncsu.edu/courses/e/e115/.

However, because you DO want to run all necessary programs in a software locker, you **add** software.

**add** matlab

However, the act of attaching/adding a locker does not necessarily mean that you can use the files in it. The e115 locker permits you to read and copy its files; however, you cannot change or delete them. Other lockers you cannot access at all. Permissions to use a locker must be set by its owner or administrator (see *AFS File Sharing*). As a result, you are only likely to attach/add lockers that you know have been set up for you to use.

**Getting Technical: What Happens When You add and attach**

So, what really happens when you add a locker, for example, **add** gnu?

1. **add** creates a symbolic link for the locker in /ncsu, that is, /ncsu/gnu -> /afs/eos.ncsu.edu/contrib/gnu by means of the **attach** program. To find out the path to the gnu locker before adding it, type **hes gnu**. After you **add** and **cd** into the gnu locker, type **pwd** to find out the path.

2. It updates your PATH and MANPATH environment variables to put all of the locker's executables in your directory path (at the beginning) and all of the locker's UNIX manual pages in the path where the **man** family of commands looks for them.

3. It executes commands found in a file called `.environment` located in the root directory of the locker. This file is generally used to display information about the locker's contents and to configure any additional environment parameters as necessary.
Windows Directory Manipulation

Windows replaces the MS-DOS environment entirely. As a result, the Windows operating system does not promote the use of the command prompt interface for directory and file manipulation. Most directory control is "point and shoot."

Windows Explorer

If you prefer to see files in a hierarchical structure or file tree, use Windows Explorer (Start -> Programs -> Accessories -> Windows Explorer). Instead of opening disks and folders in separate windows, you can browse through them in a single window. The left pane of the Windows Explorer window lists your disks and folders, and the right pane displays the contents of the selected folder. Using Explorer, you can copy, move, rename, and search for files and folders.

Make Folder

A folder in Windows is represented as a yellow folder icon. To create a new folder, select File -> New -> Folder. For example, if you want to place a portfolio of your work on the web at http://www4.ncsu.edu/~unityid/portfolio/, create a new folder in your www folder (/afs/unity/users/u/unityid/www/portfolio, or K:\www\portfolio). When the folder appears, change the name New Folder to portfolio (see also Publishing Your Web Pages).
Finding Folders

Opening folders generally moves you down the file tree. If you want to move up the file tree, select the folder icon that has an “up arrow” on it in the toolbar (see above). Selecting this icon takes you up the file system one directory at a time.

The Search tool on the Start menu allows you to search through the system to find the files or folders you need. This is a very versatile tool that allows you to locate files and folders by file name, type, date, specific text, etc.

Manipulating Folders and Shortcuts

Changing into another folder is as simple as double-clicking it. When the folder opens, its contents are displayed, so no separate action is needed to list files. However, there are different ways to list the contents of a folder via the View menu. You can view files as large or small icons, or see the Details of their creation (time and date) and a full description, see below.

You can also create shortcuts to folders for easier access. For example, if you want to put a shortcut to your portfolio folder on the Desktop, right-click in the background of your screen and choose New -> Shortcut. A Create Shortcut window opens that allows you to browse to your portfolio folder, select it, and name the shortcut icon. Now you can double-click the portfolio folder on the Desktop to open the portfolio directory.
For folder copying, pasting, renaming, moving, etc., you generally right-click the folder icon and select the function you want. You can also work inside Windows Explorer to manipulate folders, or use the file-handling methods described in Working with Files to copy, paste, cut, move, rename, remove, etc.

### Deleting Folders

To delete a folder, simply drag its icon to the Recycle Bin on the Desktop. Right-click the Recycle Bin icon on the Desktop to empty it. Once the Recycle Bin is emptied, the file or folder is gone for good.

However, if you do not empty the Recycle Bin, any file or folder you have dragged there is restorable. Double-click to open the Recycle Bin, select the file or folder
you want to restore, and select the **Restore** button. Restoring an item returns that item to its original location.

**Linux Directory Manipulation**

The campus Linux platform permits directory manipulation through a terminal window using the commands in the first section of this chapter. You select the terminal icon at the bottom of the screen to launch and enter commands at the prompt.

It is also possible to work through Linux’s GUI interface, which resembles Windows. You can access a **Search** tool from the Red Hat icon to find files and folders, and you can drag and drop folders to **Trash**. You also right-click folders to bring up a menu of functions for manipulating them, just as you do in Windows.

Once again, Linux offers you both types of interfaces, command line and graphical, to manage your directories/folders. Some of these tools are shown in the following image.
In your directories and folders, you will create a hierarchy of files and subdirectories to organize your work. If you create a file on a Solaris or Linux workstation, it will appear as a document/file icon on Windows, and vice versa. There are many ways to manipulate and work with files in Solaris, Linux, and Windows. Solaris relies on command control and Windows on mouse and menu options. Linux and GNOME make use of both.

**UNIX Commands on Solaris and Linux**

A command is simply a program that the computer runs. The following are the most frequently used commands for working with files (see also Appendix A, Working with Directories, and Working on UNIX).

**Display File Commands (more, less)**

The **more** command displays the contents of a file one screenful of text at a time in a terminal window (see help page, *man more*).

```
more file
```

more normally pauses after each screenful, printing **--More--** at the bottom of the screen. If the user presses the spacebar, another screenful is displayed. The user can also move forward one page at a time by pressing the **f** key and backward by pressing the **b** key. The **q** key quits or closes the file, the **h** key brings up a help screen, and the **Return** key scrolls the text line by line. When **more** reaches the file's end, it exits and returns the prompt.

The **less** program is similar to **more** (see help page, *man less*).

```
less file
```

However, instead of printing **--More--** at the bottom of each screen, **less** tells the percentage of the file that has been displayed up to that point, giving you some idea about how much of the file is left to page through. The **less** program also does not exit when you reach the end of the file. You must type **q** to exit.

To display the first and last ten lines of a file:

```
head file
```
tail file

**Concatenate Files (cat)**

The `cat` command (short for concatenate, to link together) will also display the contents of a file on your screen (see help page, `man cat`). This command dumps the contents of a file in one burst onto the screen, so if the file is very long, it will scroll past faster than you can read it.

To merge or link two files together and create a third file:

```bash
cat file1 file2 > file3
```

To append two files to the contents of a third file:

```bash
cat file1 file2 >> file3
```

To merge or link two files together and overwrite a third file:

```bash
cat file1 file2 >>! file3
```

In addition to these commands, the `cat` command can also be used to read input directly from the keyboard to create a new file.

```bash
cat > file
```

When finished with direct keyboard input, press **Control d** to quit. The `cat` command can also append what is typed to the contents of an already existing file.

```bash
cat >> file
```

**Copy Files (cp)**

The `cp` command copies the contents of one file to another (see help page, `man cp`). The file name and contents remain unchanged in the source file, and a copy of them is placed in the target file. The target file may have the same name or a new one, but the contents of the two files will be identical.

```bash
cp file1 file2
```

If `file2` does not exist, it will be created and will contain the contents of `file1`. If it does exist, its contents will be overwritten by the contents of `file1`. However, if `file2` is a directory, the system will know that and will place a copy of `file1` in that directory, `file2/file1`. The file is the same in both places.

If you want to copy files from one directory to another, you must specify a path.

```bash
cp olddir/file1 newdir
```
This command copies `file1` in the `olddir` directory to `file1` in the `newdir` directory. Both directories will have a copy of `file1`, i.e., `olddir/file1` and `newdir/file1`.

To copy a complete directory with all its files, add the `-r` option.

```
cp -r directory1 directory2
```

**Move Files (mv)**

The `mv` command is used both for moving and renaming files. The `mv` command moves the contents of the source file to a target file and then erases the source file. The effect is essentially that of renaming the original file (see help page, `man mv`).

```
mv file1 file1old
```

will give `file1` the new name `file1old`. The contents of the `file1old` file are the same as they were in `file1`; only the name of the file is different.

The `mv` command also moves files as well as renames them. To move `file1` from the `newdir` directory to the `olddir` directory

```
mv newdir/file1 olddir
```

The system knows that `olddir` is a directory and will move `file1` from `newdir` to `olddir` and preserve the name `file1`. `file1` is no longer in `newdir`.

**Remove Files (rm)**

To remove files from your account, use the `rm` command (see help page, `man rm`).

```
rm file
```

**Caution!** This command will permanently remove the files from your directory space and cannot be undone.

On the Eos/Unity system, the `rm` command is "aliased" to `rm -i` (-i for interactive) so that `rm` will prompt the user for confirmation before removing any files. This safeguard is good to maintain. However, if you want to remove files without prompting, you can unalias `rm` with `\`

```
\rm file
```

or

```
\rm *
```


to remove all the files in the directory you are working in. Use `rm` with care!
Windows File Manipulation

Files, like folders, are opened in Windows by double-clicking them, or right-clicking them and selecting **Open** from the menu that pops up. If a file has been created with a Solaris or Linux application, it will not open on Windows unless the application also runs under Windows, and vice versa. You will need to become familiar with what runs on all platforms, see *Appendix B*.

Windows Explorer and Search

**Windows Explorer** provides a quick way to see all the files and folders on your computer. It is also a good way to copy or move files from one folder to another. You launch it from **Start -> Programs -> Accessories -> Windows Explorer**.

The **Search** command on the **Start** menu offers the most direct way to locate a file. Use **Search** if you know the name of the file or folder you want to find. If you know only part of the name, you can use wildcards to locate all files or folders with that part of the name, e.g., *letter* will find *lettertomom.doc, lettertodad.doc*, etc.

Copy and Paste

Copying a file creates a duplicate of it for placement elsewhere, e.g., in a folder, on a floppy disk, or in another file system or folder. There are many ways to copy on Windows. Select the file icon and do one of the following:

* Choose **Copy** from the **Edit** menu. Select location and **Edit -> Paste**.
* Choose the copy icon from the toolbar (check **View -> Toolbar** if you want the toolbar displayed). Select where you want it go and select the paste icon.
* Hold down the **Ctrl** key and drag the file with the left mouse button to the location where it should be copied.
* Drag and drop the file with the right mouse button and select **Copy Here** from the pop-up menu.
* Use the keyboard shortcuts: **Ctrl c** to copy and **Ctrl v** to paste.
* Right-click the icon and select **Copy** from the pop-up menu. Select where you want it to go, right-click, and select **Paste**.

If you change your mind, select **Undo** copy or paste from the **Edit** menu.
Cut and Move

Moving files follows the same procedures as above, except that you Cut or Move as needed. Cutting removes the file from its original location, so follow immediately with a paste command so you do not lose it. Or, drag and drop with the left mouse button to move a file. You can also use keyboard shortcuts: Ctrl a to select all files, Ctrl x to cut, and Ctrl v to paste.

Rename Files

You can rename a file by selecting the file or object and then selecting the name area (a dashed line appears around the name). Type a new name and press Enter. Or, select an object or file and right-click to pop up a menu and choose Rename.

Remove/Delete Files

Removing or deleting files follows the same procedures as Cut, Copy and Move, except that you select Delete as needed instead. Select Undo from the Edit menu if you need to cancel a delete operation.

You can also drag a file to the Recycle Bin to delete it. You then must empty the Recycle Bin to get rid of all deleted files from your disk space. Select the Recycle Bin icon (it sits on your Desktop), right-click to bring up a pop-up menu, and choose Empty Recycle Bin.

If you do not empty the Recycle Bin, any file you have dragged there is restorable. Double-click to open the Recycle Bin, select the file you want to restore, and select the Restore button. Restoring an item returns it to its original location.

File Properties

You can find out many things about a file, what type it is, what settings are in place, etc. Select the file and choose Properties from the File menu. Or, right-flick the file and choose Properties from the pop-up menu.

Linux File Manipulation

The Linux Realm Kit has been designed to give users the command-line interface of UNIX and, with GNOME, the GUI file manipulation of Windows. As a result, users on Linux workstations will be able to adapt and apply both the UNIX and Windows file-manipulation functions described above.
To bring up the command-line interface to run the commands in the first section of this chapter, select the terminal icon in the taskbar at the bottom of the screen.

![Terminal interface]

As for file manipulation, most is done from the Edit menu of files and folders. The View menu also provides options for seeing details about files. The Nautilus File Manager performs many of the same functions as Windows Explorer. Open your Home folder and select Help to find out more about working with it.
14 Working on UNIX

Because the UNIX command-line interface lacks the intuitiveness of Windows and GNOME, the user has to have more background in the UNIX operating system to be effective on the system. You have already been introduced to basic UNIX in previous chapters, which also cover ways to do similar things on other platforms. However, this chapter focuses on UNIX alone.

Operating Systems

An operating system (OS) is the basic set of programmed instructions that tells a computer how to work. It is the intermediary between users and the hardware, performing operations according to user commands or input. The users' interaction with the operating system can take place via a command interpreter (or shell), which runs in a terminal window on the screen, e.g., the UNIX C shell in an Xterm window or Windows MS-DOS command prompt. Users also interact with the OS through graphical interfaces, MS Windows, X Window System, and GNOME.

The UNIX Operating System

UNIX was the original operating system for Eos/Unity and has been supported for nearly 15 years as its principal platform. A mainstay of high-end computational computing, UNIX is powerful, secure, and robust. The UNIX on Eos/Unity is Sun Solaris. Linux, a UNIX variant for the Intel PC, is a recent addition to Eos/Unity and shares the strengths of UNIX, but is cheaper, open source, and runs on personal computers. The Linux on Eos/Unity is Red Hat Linux.

Solaris runs on one-third of the workstations in the Eos labs (~ 175) and nearly 100 workstations in public Unity labs. More than 250 workstations run Realm Linux in labs, mainly in Engineering and PAMS. There are also remote access servers set up to deliver Solaris and Linux applications. The campus computing infrastructure is also built on Sun Solaris, with AFS, Linux, and Windows interoperating with it.

UNIX and its applications are not widely known in the world of personal computing, which mainly belongs to Microsoft. However, educating students in computing technology means exposing them to operating environments they do not already know. Also, much high-end engineering computing runs on UNIX.
Command Options and Arguments

Commands tell the system what actions to perform. However, if you want a command to behave in a particular way on a certain file, you must add that information to the command as options and arguments.

The portion of a command that names the file(s) or entity to be affected by the command is called an argument, e.g., `rm file`, where `rm` is the command and `file` is the argument. It is also common to add options after a command. Options (often single characters or a whole word preceded by a hyphen) specify a variation in the basic command, telling it to do something in a specific way.

A full command consists of a command, followed by zero or more options, followed by zero or more arguments.

**command option argument**

For example, if you type the command `ls` to list the files in a directory, the system will display a multi-column list of file and subdirectory names only. However, if you want more information about these files, e.g., when they were created or how big they are, you would add the `-l` option to specify a long listing. If you want hidden files (dotfiles) listed as well, you would add the option `-a` for all.

Additional options and arguments can be added on. If you want your files to be listed in the order they were created with the most recent first, add `-t` for time. All of these options together can be written as the following:

```
ls -alt
```

File Naming

Operating systems have conventions that users need to adhere to in naming their files and directories. File names can be up to 256 characters in length; however, as a rule, they should be relatively short, unique, easy to remember, and accurately descriptive of the file contents.

**UNIX file-naming, like command entry, is case sensitive.** For example, the files--`file.txt`, `FILE.txt`, and `File.txt`--are three different files, not one. Also spaces are not accepted in UNIX files names. By contrast, Windows file naming is tolerant of spaces and is not case sensitive. Users should be aware that even if they work primarily on the Windows platform, the Eos/Unity backend and file system
are UNIX based. The safest practice is to leave out spaces in file names and be
careful with capitalization.

Table 1: File Naming in UNIX

<table>
<thead>
<tr>
<th>Characters to avoid in file names</th>
<th>Naming conventions for extensions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ampersand &amp;</td>
<td>.bmp bitmap (graphics)</td>
</tr>
<tr>
<td>Asterisk *</td>
<td>.c C (program)</td>
</tr>
<tr>
<td>“At” sign @</td>
<td>.C C++ (program)</td>
</tr>
<tr>
<td>Brackets [ ] { }</td>
<td>.doc document</td>
</tr>
<tr>
<td>Caret ^</td>
<td>.f Fortran (program)</td>
</tr>
<tr>
<td>Dollar sign $</td>
<td>.gif Graphics Interchange Format</td>
</tr>
<tr>
<td>Parentheses ( )</td>
<td>.html HyperText Markup Language</td>
</tr>
<tr>
<td>Percent sign %</td>
<td>.jpg Joint Photographic (graphics)</td>
</tr>
<tr>
<td>Period . (except to create dotfiles or extensions)</td>
<td>.pdf Portable Document Format</td>
</tr>
<tr>
<td>Pipe</td>
<td></td>
</tr>
<tr>
<td>Quotation marks “ ‘ ”</td>
<td>.tar Tar (archive)</td>
</tr>
<tr>
<td>Tilde ~</td>
<td>.tex TeX (document)</td>
</tr>
<tr>
<td>Slashes / \</td>
<td>.txt ASCII (text)</td>
</tr>
<tr>
<td>Spaces</td>
<td>.Z compressed</td>
</tr>
</tbody>
</table>

Although most characters will be accepted in a file name, many should be avoided since they can cause problems or confusion. Some characters have already been assigned special meaning. For example, you should not use the "slash" character ( / ), which is the symbol for a directory.

The period should be used with caution since it has its own special meaning in a file name. The period is used to add an extension to a file name, additional characters that tell what kind of file it is or to identify it further. For example, the extension identifies file.c as C code, file.xls as an Excel file, and file.txt as ASCII text.

Also, if you use a period as the first character of a file name, you create a .dotfile. Dotfiles are hidden files--often configuration files--that will not appear in an ordinary directory listing.
Shortcuts and Operators

The following suggestions will make working on Eos/Unity easier.

**Copying and Pasting Between Windows**

One of the most useful functions is the ability to copy and paste information from one windowed application to another. On UNIX, all you have to do is point, hold down the left mouse button, and drag over the information you want to copy to select it. Then point into the application where you want the information to be copied and click the middle mouse button to place it there.

You cannot do this quite as easily on Windows. You must use the standard copy and paste methods (see *Working with Files*).

**Completing Command Entry with Typing**

You can use the Tab key to save you time in typing commands, pathnames, or data. For example, if you issue a command that affects the file `softwarelist`, you do not need to type all the characters in this long filename. You can simply type the first characters in the name, until it is distinguished from all other files in the directory, and then press the Tab key to let the system finish the typing for you.

For example, if `softwarelist` is the only file that begins with the letter `s` in the directory, then the `s` and Tab keys are all you would have to type to expand this filename on the command line, e.g.:

```bash
% more s[Tab]
```

This shortcut is also very useful when typing in long pathnames, which on Eos/Unity is something you have to get used to doing frequently.

**Repeating Commands with Typing**

To repeat a command that you have typed previously in a session, press the up-arrow cursor key until you find the command again. To execute the command after you have found it, press the Return key. If you want to modify the command before executing it, use the right and left cursor keys to position the cursor and type in or delete characters as appropriate.

The history command also displays the last commands you typed in a session up to whatever number is specified in the shell environment (type `set` to see the setting for `savehist`). If the `savehist` variable is set to 100, your last 100 commands have been recorded and can be displayed with the history command.
Commands are numbered in the order you typed them. If you want to execute the last command you typed, type two exclamation marks (!!) at the prompt, or use the up arrow key as described above.

% !!

If you want to execute an earlier command in the list, type an exclamation mark ! (sometimes called a "bang" or a "shriek") followed by the line number of the command, line 34 for example.

% !34

Aliases

Often, you find yourself typing the same commands, filenames, and paths over and over. Or, you find that you confuse UNIX commands with the commands of another operating system you know better. If you wish, you can create substitutions or aliases for these files, paths, and commands, using something shorter and easier to remember. For example, to type `portfolio` instead of `cd /afs/unity/users/u/unityid/www/portfolio/` to change to that directory:

% alias portfolio cd /afs/unity/users/u/unityid/www/portfolio/

The command alias is followed by the substitution you want to use and then the original path, filename, or command (or a combination of these) that you want the alias to replace. If you have aliases that you want to use all the time, put them in your `~/.mycshrc` file, which is processed when you log in.

To take out an alias, use the `unalias` command. For example, to undo the `portfolio` alias you created (remove the alias from your `~/.mycshrc` file if you put it there):

% unalias portfolio

Useful Key Combinations

Individual keys and key combinations will perform particular operations and functions that can help you or save you time. When you see instructions that tell you to press some kind of Ctrl+character combination, it means to hold down the Control key (or the Ctrl key on some keyboards), and press the character key indicated. The action is similar to holding down the Shift key and pressing a key to make an uppercase letter.

Ctrl z Suspend a process
Ctrl c Cancel or abort a process
Wildcards and Metacharacters

Wildcards are special characters designed to work in place of other characters and strings of characters in command arguments. They save you time when you are trying to work with a number of files at once.

The asterisk * (called a star) can be used in place of any string of characters. For example, to list (command `ls`) only the files in a directory with the extension `.doc`:

`ls *.doc`

Use the wildcard with any command that operates on files: copy, remove, print, etc. This way, you do not have to work with files individually but can manage them as groups. The * by itself stands for all files. As a result, if you type `rm *`, you will remove all the files in a directory. Be careful with wildcards, and use the `-i` (interactive) option with commands like `rm`. This option asks the user for confirmation before removing each file.

The question mark ? represents a single character.

`% ls essay?`

lists all the files you named `essay` followed by a single character, such as, `essay1 essay2 essay3 essay4`

Or, you can use a series of question marks to stand for two characters or more. The command `ls essay??` picks up `essay10, essay11`, etc.

Redirection of Input and Output

The keyboard and terminal screen are UNIX's standard input and output devices, respectively. UNIX expects input from the keyboard and always sends output to the screen, unless told to do otherwise. Redirection is the process of changing the source and destination of input and output.

To UNIX, your screen is just another file. When a command generates output, the shell writes it to a standard output (abbreviated `stdout`) file, which puts the data on your screen.

However, you can redirect this output if you wish, sending it to another file instead. For example, if you want a directory listing sent to a file rather than to your screen, you might type

`% ls -al > myfile`
where \textit{myfile} is the name of the file that receives the directory-listing output. The right-angle bracket (>) tells the shell to perform the redirection. If \textit{myfile} does not exist, it will be created. If it does exist, its contents will be overwritten by the new data. To append the data to the contents of a file rather than overwriting them, use two right-angle brackets instead of one. The following command places the directory listing at the end of any data already in the \textit{myfile} file.

\% \texttt{ls -al >> myfile}

To merge the contents of files together, that is, concatenate them, use the \texttt{cat} command and redirection. For example, \texttt{cat file1 file2 > file3} will merge \textit{file1} and \textit{file2} into a new file called \textit{file3}. The right angle bracket tells the system to send the result of the concatenation to \textit{file3} (see \textit{Working with Files} for more on \texttt{cat}).

\textbf{Pipes and Pipelines}

The process of piping sends output to a command or a series of commands. A series of commands is called a pipeline. You pipe data from one command to another by entering the commands on a single line with a vertical bar between them. In this way, the output of one command becomes the input to another command.

For example, when you enter a command and its output is too large to fit on one screen, you may want to cancel the output (type \texttt{Control c}) and type the command again, this time "piping" the output through \texttt{more} so it will be displayed in a format that you can move through more easily.

Say you have a directory with many files in it, so many that they scroll off the screen before you can read them when you do a directory listing. You can pipe the \texttt{ls} command through \texttt{more} instead, e.g.,

\% \texttt{ls -l | more}

\textbf{UNIX Man Pages}

Information is available online to explain how to use most of the commands you encounter on the system. In fact, all UNIX commands are described in the online documentation called the UNIX Man(ual) Pages. A separate \textit{man page} exists for every command. The \texttt{man} command followed by the name of a UNIX command will bring up that command's man page in a \texttt{more} display format.

Most man pages provide the following information:
* **Name:** A simple definition of the command.
* **Syntax:** The correct way to type the command and its options and arguments.
* **Description:** A longer explanation of how to use the command and in what situations.
* **Options:** The options (characters or terms preceded by a hyphen) that may be combined with the command and what effect they have.
* **Restrictions:** Known limitations on the use of the command.
* **See Also:** A list of cross-references to other commands that are related to or can shed light on the use of the command.

You may notice that the commands have a numerical argument, such as `zwrite(1)` or `chmod(2)`. This number refers to the type of command the argument is.

1 User Commands
2 System Commands
3 Library Calls
4 Devices
5 File systems
6 Games
7 Miscellaneous
8 System Administration
l - Local Commands
n - New Commands

Most of the commands the general user will be referencing will be of the (1) *User Command* variety, so this is the default. Some commands, such as `chmod`, have multiple usages; `chmod` has man pages set up for `chmod(1)`, `chmod(2)` and `chmod(3f)`.

To look up a set of commands of a particular type, use `man` with the option `-k` for keyword, which lets you to specify a keyword to search for.

For more information on the `man` command, a logical place to look is `man man`, which displays the UNIX manual page on `man` itself.
The C Shell

UNIX is composed of two main layers, a kernel and a shell. The shell surrounds the kernel, which is the core programming that is responsible for machine-level operation and connection to hardware devices. Few users ever communicate directly with the kernel. Instead, users send instructions to the shell, an outer layer of software that interprets and executes commands, passing on to the kernel any further processing that may be required. For example, a user may give the lpr command to print a file, which the shell interprets and executes. However, the actual connection and transmission to the printer itself is handled by the kernel.

When you log in, the operating system starts a shell for you. The characters you type are entered into a command-line buffer. When you press the Return key at the end of a line, the operating system accepts the contents of the buffer as the command and then interprets it. If it cannot tell what the command means, it delivers an error message back to the user. For example, if you type copy instead of cp when you try to copy a file, you will get the message:

copy: Command not found

A command to the shell, or shell command, actually tells the shell to run a program. The cp command tells the shell to run the copy program.

The user enters instructions and commands to the shell at the shell prompt. The percent character (%) in the prompt is not an arbitrary character. It stands for the particular kind of shell the system is running, in this case, a C shell, or tsch, the enhanced version of the Berkeley UNIX C shell. If the symbol were a dollar sign ($), then it would mean that a Bourne shell is running.

More than one shell can run at a time. Each time the user opens an Xterm terminal window, a new shell is created to accept user input.

Setting Variables

Your environment is determined by the behavior of the shell and other programs that interact with it. The shell has a facility for storing data in variables. There are two categories of variables: environment variables and shell variables.

Environment Variables (printenv, setenv)

Environment variables contain information about your working environment. They are “global" variables, that is, the values or settings for these variables are the same
throughout all the shells you create. Environment variables determine the default operation of all shells and are also passed on to application programs. The list of environment variables is fairly lengthy and includes settings for a default printer, a default editor, a default path, etc. These variable are set by system administrators but can be changed by the individual user. To list them, type the command

**printenv**

To check the setting for a particular variable (variables are typed in uppercase letters):

**printenv PRINTER**

The format for setting the values of variables is:

**setenv VARIABLE value**

The **setenv** command is followed by the variable name in caps, followed by the value the variable should receive, e.g.,

**setev PRINTER dan118**

To undo a value setting for an environment variable:

**unsetenv VARIABLE**

**Shell Variables (set)**

Shell variables are specific to each shell; in other words, each window has its own shell variables that can be set. Shell variables work like environment variables, except for the following differences.

A set of shell variables is used by a single C shell only.

* Shell variable names are written in lowercase.
* Shell variables are displayed, set, and changed with the **set** command.
* Shell variables do not propagate to new shells or other programs.

Generally, shell and environment variables are independent, although they may look and behave similarly, both in name and purpose. Shell variables may also obtain their initial values from environment variables. However, once values are set for a shell, they will not be affected by changes in environment variables. Setting shell variables is a way of overriding environment settings in a shell.

To display shell variables (the equivalent of **printenv**):

**set**
To set or change a value for a variable, type the `set` command followed by the variable name (in lowercase), an equals sign (=), and the value assigned to the variable.

For example, to replace the `eos%` or `unity%` with `ncsu`:

```bash
set prompt=ncsu
```

If the value has internal spaces, you must put it inside quotations marks, e.g., to set the prompt to “You rang?”:

```bash
set prompt=“You rang?”
```

Or, to show the path of the working directory (`pwd`) as a prompt:

```bash
set prompt=“%/ ”
```

You can place this command in your `.mycshrc` file to have it come up with every terminal window all the time, not just for one shell or session.

To undo a value setting for a shell variable:

```bash
unset variable
```

**Instant Messaging: Zephyr Replaced by Gaim**

The Zephyr service, which for years provided instant messaging on Solaris and Linux workstations, has been discontinued. On July 5, 2005, ITD permanently shut down the servers that managed the Zephyr messaging system on campus because it was no longer being supported by its developers.

The current recommended messaging system on Solaris and Realm Linux is gaim. Gaim is also available in the Windows labs. The web site for gaim is [http://gaim.sourceforge.net/](http://gaim.sourceforge.net/), and a good online manual for learning to use gaim is at [http://alphamonkey.org/gdp/files/gaim-manual-1.0/gaim-manual-html-1.0/](http://alphamonkey.org/gdp/files/gaim-manual-1.0/gaim-manual-html-1.0/)

To launch gaim on Solaris and Linux, type the following in a terminal window.

```bash
gaim &
```

On Linux, you can also launch gaim by selecting the Red Hat icon to bring up the main menu and **Internet -> IM**.

Gaim supports a number of IM and chat protocols, and you must register with one (or more) before you can start using gaim. Gaim is compatible with AIM and ICQ (Oscar protocol), MSN Messenger, Yahoo!, IRC, Jabber, Gadu-Gadu, SILC, GroupWise Messenger, and Zephyr. Usually, you register at the service’s web site.
Go to http://alphamonkey.org/gdp/files/gaim-manual-1.0/gaim-manual-html-1.0/x94.html for basic information on each protocol/service and how to register for it.

The opening gaim window appears at the left in the figure below. You must first add an account (select Add in the bottom window) and fill in the details of the IM protocol you want to use (window at right), your screen name, password, etc. You must register with a service before you can use gaim to access that account.

Once an account is entered, you will select it from the Account drop-down menu in the opening gaim window and then Sign on to access it (you may be prompted for your password). Once connected, you can begin sending and receiving messages and exploring what you can do under Preferences. Again, consult http://alphamonkey.org/gdp/files/gaim-manual-1.0/gaim-manual-html-1.0/ for help.
AFS makes it easy for people to work together on the same files, no matter where the files are located. AFS users do not have to know on which computer their files are stored, and administrators can move files from computer to computer without interrupting user access. Users always identify a file by the same pathname, and AFS finds the correct file automatically. While AFS makes file-sharing easy, it does not compromise the security of the shared files.

Client/Server Computing

AFS uses a *client-server* computing model with two types of computers. *Server* computers store data and perform services for *client* computers. Client computers perform computations for users and access data and services provided by server computers. Some computers act as both clients and servers. In most cases, you work on a client computer and access files and software stored on a file server.

Distributed File Systems

AFS is a distributed file system that joins together the file systems of multiple file servers. A distributed file system has two main advantages over a conventional centralized file system:

* Increased availability: Copies of files can be stored on many file servers. An outage on a single server or even multiple servers does not necessarily make a file or application unavailable. Instead, user requests for the file or application are routed to accessible servers. With a centralized file system, the loss of the central file storage computer effectively shuts down the entire system.

* Increased efficiency: In a distributed file system, the workload is distributed over many smaller computers, which can be more fully utilized than the larger, and usually more expensive, file storage computer of a centralized file system.

AFS hides its distributed nature, so working with AFS files looks and feels like working with files stored on your local computer, except that you can access many more files. Also, because AFS relies on the power of the user’s client workstation for computation, increasing the number of users and workstations does not slow AFS performance appreciably, making it a very efficient computing environment.
Cells and Sites

Just like the UNIX file system, AFS uses a hierarchical file structure (a tree). Under the /afs root directory are cells. The cell is the administrative domain in AFS and can be owned by a company, a university, or any defined group of users. Each cell is autonomously administered. Cell administrators determine how workstations are configured, how directories are organized, and how much storage space is available to each user. While organizing and maintaining its own file space, each cell can also connect with the file space of other cells running AFS.

The result is a huge file space that enables file sharing within and across cells. The cell to which your client computer belongs is your local cell. All other cells in the AFS filespace are termed foreign cells, such as cmu.edu and umich.edu, see following figure. An AFS site is a grouping of one or more related cells. For example, the bp.ncsu.edu, eos.ncsu.edu, and unity.ncsu.edu cells at NCSU form a single site.

Volumes and Mount Points

The storage disks in a computer are divided into sections called partitions. AFS further divides partitions into units called volumes.

A volume is a container for storing a subtree of related files and directories. It also has a completely independent size limit, or quota. Each user home directory is housed in one volume, which keeps its contents together on a file server partition. Your system administrators can move volumes from one file server to another without your noticing because AFS automatically tracks a volume's location.

AFS tracks and accesses the contents of a volume by its mount point. A mount point is a special file system element that looks and acts like a regular directory but tells AFS the volume's name and location. Your own volume resides on one of many file servers, and the mount point is the pointer that AFS uses to find and retrieve it for you.

For example, the volume for the user jqpublic in the unity.ncsu.edu cell is called user.jqpublic. A mount point exists in the /afs/unity.ncsu.edu/users/ directory named jqpublic. It points to the volume user.jqpublic. The convention NCSU follows in naming user volumes is user.unityid.
AFS File Tree: NCSU Cells (bp, eos, unity) and Selected Branches

/ 

afs/ 

thena.mit.edu bp.ncsu.edu cmu.edu eos.ncsu.edu umich.edu unity.ncsu.edu ... 

contrib dist engwww courses lockers lockers users 

jdk openoffice pine ansys matlab sas acc e zo a j z 

bin src acc100 acc630 e115 zo150 z0885 jqpublic 

pine archived common lec prep www 

e115_00112002...e115_60482003 EosLabs Review www 001 604 index.html 

index.html 

graded submitted www 

assignment assignment index.html wrap 

userid userid 

graded-file.xxx submitted-file.xxx
Volume Quotas

Each volume has its own size restrictions, or *quota*, assigned by the system administrator. A volume's quota determines the maximum amount of disk space the volume can consume.

A volume's quota, measured in 1 kilobyte (1024 bytes) blocks, determines the storage space allowed in the volume. When users exceed their quota, they will receive error messages. As a result, users should check their quotas often by logging in at [http://sysnews.ncsu.edu](http://sysnews.ncsu.edu) and checking User Info and Quota Manager.

Each user's home directory (volume) is located on a disk partition with many other users. The quota command shows both percent of volume and percent of partition used, e.g.,

<table>
<thead>
<tr>
<th>Volume Name</th>
<th>Quota</th>
<th>Used</th>
<th>% Used</th>
<th>Partition</th>
</tr>
</thead>
<tbody>
<tr>
<td>users.m.mcdaniel</td>
<td>50000</td>
<td>25000</td>
<td>50%</td>
<td>98%</td>
</tr>
</tbody>
</table>

The *Used* and % *Used* of volume are the critical numbers to watch. The *Partition* does not affect your account, even if it is as high as 98%, which on a large partition still leaves ample disk space to use. However, if *Partition* reaches 100%, please contact your system administrator at *help@ncsu.edu*.

Cache Manager

The *cache manager* is your agent in accessing information stored in AFS. When you access a file, the cache manager on your client machine requests the file from the appropriate file server machine and stores, or *caches*, a copy of it on your client machine's local disk. Application programs on your client machine use the local, cached copy of the file. This improves performance because it is much faster to use a local file than to send requests for file data across the network to the file server.

Saving your file sends the changed file back to the appropriate file server where the file is stored. In campus labs, you cannot save files to the workstation’s local drive. When you log out, the C: drive or local disk is cleared. However, because files are saved by default to your home directory in AFS, unless you change the path, your files are safely stored on network file servers, which are also backed up nightly.

Just remember to save often, which writes your data to permanent storage on the file server, and do not use the local drive for more than temporary storage.
AFS Security and Tokens Access Control Lists

To identify yourself to AFS, you enter your Unity password to prove that you are who you say you are. When you provide this password, you become authenticated, and your cache manager receives a token.

A token is a package of information that is scrambled by an AFS authentication program using your AFS password as a key. Your cache manager can unscramble the token because it knows your password and AFS's method of scrambling. The token acts as proof to AFS server programs that you are an authenticated user. The token is also used for mutual authentication. When your cache manager contacts a file server, it also sends your token. Under mutual authentication, both parties communicating across the network prove their identities to one another. AFS requires mutual authentication whenever a server and client communicate with each other.

UNIX and AFS

AFS is designed to be similar to the UNIX file system. For instance, many of the basic UNIX file commands (cp for copy, rm for remove, and so on) are the same in AFS as they are in UNIX.

However, AFS augments and refines the standard UNIX scheme for controlling access to files and directories. Instead of using mode bits to define access permissions for individual files, as UNIX does, AFS stores an access control list (ACL) with each directory. The ACL defines which users and groups can access the directory and the files it contains, and in what manner. The following list summarizes the differences between the two methods:

* UNIX mode bits specify three types of access permissions: r (read), w (write), and x (execute). An AFS ACL specifies seven types of access permissions: r (read), l (lookup), i (insert), d (delete), w (write), k (lock), and a (administer).

* The three sets of mode bits on each UNIX file or directory enable the user to grant permissions to three users or groups of users: the file or directory's owner, the group that owns the file or directory, and all other users. An AFS ACL, on the other hand, can accommodate 20 entries on a directory, each of which extends permissions to a user or group. Unlike standard UNIX, a user can belong to an unlimited number of groups, and groups can be defined by both users and system administrators.

* UNIX mode bits are set individually on each file and directory. An AFS ACL applies to all of the files in a directory. While at first glance the AFS method
possibly seems less precise, in actuality (given a proper directory structure) there are no major disadvantages to directory-level protections, and they are easier to establish and maintain.

* To access a file in a remote computer's UNIX file system, you must log into the remote machine or create a mount point on the local machine that points to a directory in the remote machine's UNIX file system. To access a file on a remote machine in AFS, you simply specify the file's pathname.

**Access Control Lists**

AFS uses an access control list (ACL, pronounced “acle”) to determine who can access an AFS directory and what actions they can perform on its files, e.g., read, write, administer, etc. Each directory has its own ACL, either individually defined or inherited, and up to 20 users or groups can be assigned unique rights to the space. AFS users can see and share all the files under the /afs root directory, given the appropriate privileges.

**Remember!**

* AFS assigns permissions at the directory level, not the file level. As a result, you organize your files into directories in order to grant others access to them.

* Subdirectories inherit the ACL of the parent directory, but subdirectory ACLs can be changed by the owner to differ from the parent directory. When you grant access to a directory, you also grant access to all new subdirectories created under it. In addition, if a file is moved to a directory where the access permissions are different, the file will inherit those new settings.

* The lowest level “lookup” setting is l (see below), and it must be combined with the other settings for them to work. Also, a user must have l permission on the parent directory to reach its subdirectories. The l setting permits the user to move through directories to get to ones below it. Otherwise, the user will be stopped in his/her navigation with a “permission denied” error.

There are two general types of AFS commands: file server (fs) commands and directory protection commands (pts). You run them from the command line in a terminal window on both Linux and Solaris workstations.

**Levels of Access**

You set permissions for directory access in the access control list (ACL). A directory's ACL is a list of users and groups and the rights they have to access and use
the files in that directory, specifically, r-Read, l-Look, i-Insert, d-Delete, w-Write, k-Lock, and a-Administer. The owner of a directory (and anyone who has administer rights) can set and manipulate the ACLs for a directory.

Table 2: Levels of Access on AFS Directories

<table>
<thead>
<tr>
<th>Access</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>r</td>
<td>read (and copy) the contents of files in the directory.</td>
</tr>
<tr>
<td>l</td>
<td>look (not read access). Can list (ls) directory and look at its ACL. You must have l access to use other access rights, e.g., to read you must have rl.</td>
</tr>
<tr>
<td>i</td>
<td>insert files or subdirectories (create new files, move existing ones).</td>
</tr>
<tr>
<td>d</td>
<td>delete files or subdirectories from the directory.</td>
</tr>
<tr>
<td>w</td>
<td>write or edit the contents of files in the directory.</td>
</tr>
<tr>
<td>k</td>
<td>lock. Sets an advisory lock on a file (not used often).</td>
</tr>
<tr>
<td>a</td>
<td>administer or change permissions in the ACL. Owner has administer rights.</td>
</tr>
</tbody>
</table>

Aliases have also been set up for common levels of access, i.e., read, write, and administer. These can be used in place of the letter abbreviations, and you can use them on both Linux and Solaris workstations.

Table 3: Aliases for Access Settings

<table>
<thead>
<tr>
<th>Alias</th>
<th>Access</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>read</td>
<td>rl</td>
<td>read and look</td>
</tr>
<tr>
<td>write</td>
<td>rlidwk</td>
<td>all rights but administer</td>
</tr>
<tr>
<td>all</td>
<td>rlidwka</td>
<td>full owner’s permissions including right to administer. Be careful giving all rights. Use write instead.</td>
</tr>
<tr>
<td>none</td>
<td></td>
<td>remove all rights, e.g., fa sa directory username</td>
</tr>
</tbody>
</table>


Viewing ACL Permissions

To look at the access rights on your home directory, type `cd` to return to your home directory and type the file server command, `fs la` (file server listacl). By default, this command shows you the access control list for the current (.) directory, e.g.,

% fs la

Access list for . is
Normal rights:
www:servers l
system:administrators rlidwka
mcdaniel rlidwka

You can also specify a path to a directory, e.g., `fs la /path/to/directory/`.

The output above tells you that system administrators have full rights to administer your directory, just as you do as owner of the directory (your userid would replace mcdaniel): r-Read, l-Look, i-Insert, d-Delete, w-Write, k-Lock, and a-Administer. The campus web servers (www:servers) also have permission to pass through your home directory to get to any subdirectories you have set up for the web, e.g., your www subdirectory. Remember that AFS requires that the parent directory have l in order to read any subdirectories below it (see Publishing Your Web Pages).

There are very few people with system administrator privileges, and they are carefully screened, full-time employees of the university computing staff. It is necessary for them to have access rights in order to assist you if you have problems with your account. It is not a good idea to change or remove the administrators' permissions on your directories.

Setting ACL Permissions

To grant someone access to a directory, you must set access to it with the `fs sa` command (file server setacl). Use the following command syntax to set new access rights on a directory:

`fs sa directory userid access`

where directory is the name of or path to the directory to which access is being granted, userid is the login name of the person to whom you are granting access, and access is the permission being granted to userid.

For example, if jnpublic wants to give jouser full access rights to his ~/bin directory (except for administer rights), he would type the following at the prompt:
fs sa . jouser rlidwk
or
fs sa ~/bin jouser rlidwk)

Or, he could use the alias write for rlidwk:

fs sa . jouser write

To take away or remove these rights, jqpublic would use the none access setting.

fs sa . jouser none

Fewer rights can be given than these. If jqpublic wants jouser to be able to read
and copy his files but nothing else, he would set rl permission on the directory.

fs sa . jouser rl

Or, he could use the alias read for rl:

fs sa . jouser read

Sharing Information with Groups

Another refinement to the standard UNIX protection scheme is that users can
define their own protection groups, or pts groups. A pts group is a defined list of
individual users that you can place on the ACLs of your directories. Instead of
adding and removing individuals separately, you can add/remove them as a group.

A group can include both users and machines. Each user who belongs to a group
inherits all of the permissions granted to the group on the ACL. AFS permits only
20 users or groups for each directory. As a result, if you want to grant access to 25
people, you could not do so unless you put them in a group.

When you create a group, you automatically become its owner. You create a group
with the pts creategroup command (or pts cg):

pts cg owner:group

where owner is your Unity ID and group is a name you make up for the group.
Most groups have these two parts: the part before the colon tells who owns the
group, and the part after is the group's name.

Groups that you encounter that do not have an owner prefix are special groups cre-
ated by system administrators. All of the groups you create must have an owner
prefix and a colon before the group name.

You add a member to a group with the pts adduser command (or pts ad).
\textbf{pts ad} \textit{userid owner:group}

where \textit{userid} is the Unity ID of the person you want to add, and \textit{owner:group} is the name of the group you have created. This command places that user in the group. There is no restriction on the number of members in a group.

You check who is in the group with the \textbf{pts membership} command (or \textbf{pts m}).

\textbf{pts m} \textit{owner:group}

You remove a member from the group with the \textbf{pts removeuser} command (or \textbf{pts rem}).

\textbf{pts rem} \textit{userid owner:group}

You delete a group with the \textbf{pts delete} command (or \textbf{pts del}):

\textbf{pts del} \textit{owner:group}

To get a full listing of \textbf{pts} commands:

\textbf{pts help}

In the following example, \textit{jqpublic} makes a \textit{classproj} directory that he and three classmates (Unity IDs: \textit{moe}, \textit{larry}, and \textit{curly}) can all work in together. \textit{jqpublic} creates the group \textit{jqpublic:projgroup} and adds \textit{moe}, \textit{larry}, and \textit{curly}, to it. He adds this group to the ACL of the \textit{classproj} directory with the \textbf{fs sa} command and gives the group write access (rlidwk).

\textbf{mkdir} \textit{classproj}

\textbf{cd} \textit{classproj}

\textbf{pts creategroup} \textit{jqpublic:projgroup}

\textbf{pts adduser} \textit{moe jqpublic:projgroup}

\textbf{pts adduser} \textit{larry jqpublic:projgroup}

\textbf{pts adduser} \textit{curly jqpublic:projgroup}

Or, to add all three users in one command:

\textbf{pts adduser} -\textit{user moe larry curly} -\textit{group jqpublic:projgroup}

You grant access for a group the same way you would for an individual:

\textbf{fs sa} \textit{. jqpublic:projgroup write}

To check the membership of the group:

\textbf{pts membership} \textit{jqpublic:projgroup}
Members of jqpublic:classproj (id: -1234) are:

moe
larry
curly

**AFS on Windows**

The Windows workstations are full AFS clients, but the way they interface to the campus file system is different from Solaris and Linux. Once again, nothing is command driven in Windows. AFS control is available from the main **File -> AFS** menu on system directories. Remember that access control is set at the directory (folder) level, not on individual files.

If you have used Windows computers before, you will not have seen **AFS** on the **File** menu. It is a special customization that was done to make the Windows platform fit into the Eos/Unity AFS infrastructure so that files could be accessed and shared easily.

The following figure illustrates how to view and set access to your **K: drive**, which is mapped to your home directory in AFS. Right-clicking the **K: drive** brings up the **File** menu, and selecting **AFS** brings up a submenu of AFS functions.

1. Select drive or folder.
2. **File -> AFS**

When the **Access Control List** is selected from the menu, the **AFS ACL** dialog box pops up showing the same permission settings on your home directory that you see from the command line with the **fs la** command.

If you were to give someone read permission on your home directory or, preferably, a subdirectory, you would do the following:

1. Select **File -> AFS -> Access Control List**.
2. Type a user’s Unity ID in the **Name** field.
3. Select the checkboxes for permissions (e.g., r and l for read access). Select **OK**.

Other tools and checks can also be selected from the **AFS** menu. For example, the user can check the quota on his/her home directory, or user volume, by selecting **File -> AFS -> Volume/Partition**. It is the same as typing the **quota** command on Solaris and Linux workstations, or **fs lq**.
AFS on Windows Version 2006-07 Guide to Eos and Unity Computing
A **Help** system is available for the Windows AFS client with information on how to work with AFS functions and tools. It can be brought up by selecting the **Help** button on any of the AFS tool bars and dialog boxes (see figure above).

It is also possible to use the **fs** and **pts** commands from the MS-DOS command, **Start -> Programs -> Accessories -> Command Prompt**. At the command prompt, you can change to one of the AFS drives and run your AFS commands from there. Type **K:** or **J:** and press **Enter** to change to that drive.

Use the commands **dir** (not **ls**), **fs**, **pts**, **mkdir**, **cp**, **rm**, etc, as you are used to. Consult **Help** for more on using AFS commands at the prompt.
OpenAFS

The following information is reproduced in the chapter on Remote Access Services.

NCSU has a large AFS network, which is used to serve user home directories, course lockers, research and project file space, and software. It is possible for users to gain access to AFS by running an OpenAFS client (http://www.openafs.org) on their personal computers.

The OpenAFS client, working with Kerberos, joins the file system of your local computer with the campus AFS file system. It allows you to access AFS on your personal computer in ways you are familiar with (K: and J: drives on Windows, /afs on Unix/Linux), and you can work with the files on those drives just as you would in an Eos or Unity lab. You can open, edit, and save files as if they were on your local computer, while the client takes care of transferring them to and from the campus network. In short, the AFS file system comes to you through the OpenAFS client, and you do not have to go to a lab to have direct access to AFS.

OpenAFS is the open-source organization that maintains and distributes clients for AFS. OpenAFS provides clients for many operating systems, but the three most commonly used by students at NCSU are the ones for Windows, Linux, and Mac OS X. A high-speed connection is essential for running OpenAFS effectively. Kerberos is built in to Linux and Mac OS X, but Windows users will have to use the Kerberos for Windows software.

The following web site provides downloads, instructions for use, and configuration details for the specific client you need. At the time of this guide’s publication, the AFS client for Mac Tiger (10.4) is still in development, but OpenAFS for Panther (10.3) is available. The replacement for NCSU’s custom WolfCall application, whose functionality is now part of OpenAFS and Kerberos for Windows, is still in development also. As a result, the web site below will be your best and most current resource for AFS client information and downloads.

http://www.eos.ncsu.edu/remoteaccess/afs.html

Important! Establishing AFS access on your own computer is not for everyone. For the user who needs routine access to command-line tools and file transfer, the methods described in previous sections are recommended over running an AFS client, particularly if you do not have a high-speed connection. OpenAFS is useful but not essential for most users working remotely.
AFS Glossary

access control list (ACL): A list associated with an AFS directory that specifies what actions a user or group is permitted to perform on the directory and its files.

acl entry: An entry on an ACL that pairs one user or group of users with specific AFS access permissions. An entry can be normal, granting the user or group specific permissions, or negative, denying the user or group specific permissions.

afs uid: An identification number assigned to each AFS user and group. It is guaranteed to be unique.

Andrew File System (AFS): A file service that joins the local file systems of several file server machines. Files are stored (distributed) on different machines in the computer network but are accessible from all machines.

authenticated: The state of a principal whose identity has been verified by AFS.

authentication: Verification that a user or process is presenting a valid identity. Authentication involves certifying that a password provided by the user is correct.

cache manager: The portion of an AFS client machine that communicates with AFS server processes by translating file requests made locally into remote procedure calls. It stores the requested files in a cache on the local disk, from which it makes the files available to local users.

cell: An administratively independent site running AFS and consisting of a set of file server machines and client machines. A machine can belong to only one cell at a time.

file server: A type of machine in AFS used to store files and transfer requested files to client machines.

foreign cell: An AFS cell other than the one to which the local (client) machine belongs. The local machine's cell is referred to as the local cell.

local cell: The cell to which the local client machine belongs. Even though a user can authenticate in a foreign cell or fetch files from it, the identity of the local cell remains the same throughout a logon session.

mount point: A special type of directory that connects a location in the AFS filesystem with a volume. A mount point looks like a standard directory. Listing the directory shows the contents of the volume. Each mount point corresponds to a single volume.
**network drive**: A connection to the hard drive of a remote computer, allowing you to access shared files and directories. You can establish a network drive connection to a directory in the AFS filespace.

**partition**: A logical section of a disk in a computer.

**password**: A unique, user-defined string of characters that validates the user's system identity. The user must enter the password to become authenticated.

**quota**: The size limit of a volume assigned by the system administrator and measured in kilobyte blocks.

**token**: A set of data that is granted after a user authenticates to AFS. A token is used by the cache manager when requesting services from AFS servers. A token has an associated lifetime and expires after a set period of time. If your token expires, you no longer have authenticated access to AFS.

**username**: The name a user types in when authenticating that uniquely identifies the user in the local cell. It is mapped to the user's AFS UID.

**volume**: A "container" that keeps a set of related files and directories together on a disk partition that is specific to AFS.

**volume location server**: An AFS server process that maintains the Volume Location Database, which records location and other status information about all volumes in the cell.
16 Publishing Your Web Pages

Thanks to ITD Help Desk Remedy Solution 17

You can publish your own web pages on the www4 server provided by NCSU Computing Services from your home directory in AFS. You create your HTML-coded “home page” and other web pages in a www directory you create. Then, you set the access rights on the directory so that other people can read what’s in it.

Computing Services has an electronic guide that covers HTML and access rights. This guide is on the WWW at the following URL:

http://www.ncsu.edu/it/essentials/web_pages/www4_setup.html

Using the WWW Setup Utility

You can use a web tool to automatically assign proper access rights to the appropriate directories and set up your personal web site:

https://sysnews.ncsu.edu/tools-bin/www-setup

This utility will set up your www directory so it works properly with campus web servers. To use it, you just need to enter your Unity password in the field provided at the web page above, and click the button, Set Up My Web Space. Afterwards, your web space will be accessible via http://www4.ncsu.edu/~unityid. Whatever you put in your www directory will be visible by the rest of the world. This utility will not harm anything that you might already have in your www directory.

Creating a ~/www Directory and Setting Access Permissions

You can also do manually what the above tool does automatically. Sometimes that’s the best way to learn exactly how things work. These instructions are for people working from the command line in an Eos/Unity terminal window.

Because your Unity account allows only you, the owner, to look at and read the files inside it, you must specifically grant the rest of the world access to your files in order to publish your HTML documents. To do this, you will need to:

1. Grant lookup permissions to your home directory.
2. Create a subdirectory in your home directory called www.
3. Change directories to your www directory.
Grant lookup and read permissions to your www directory.

Create your HTML files in the www directory, or move them there.

Below are step-by-step instructions on how to do these things.

**Grant lookup permissions to your home directory**

First, you are going to alter the AFS file permissions for your home directory so that www:servers has lookup (l) access (see also *AFS File Sharing*). www:servers allows NCSU's web servers to access your file space to distribute your web content. Think of your directories as boxes inside each other. Before others can look up and read what is in your www box, they have to be able to look up or open what is in your home directory box first.

The following is the syntax for the fs command:

```
fs sa directory rights
```

The specific command that you type while in your home directory or K:drive:

```
fs sa . www:servers l
```

The cd command will return you to your home directory from wherever you may be on the system. The fs in the command above stands for file server; and the sa stands for set access. The period means the current directory (the one you are in), and the l means that the web servers can look up file and directory names.

**Create a subdirectory in your home directory called www**

Create a directory called www.

```
mkdir www
```

All of your HTML documents that you want to let others view will reside in this directory. An automatic procedure runs nightly to find www subdirectories in users' home directories and to automatically post their contents to the web from http://www4.ncsu.edu/~unityid/. This allows people to put their materials on whenever they wish without involving system personnel.

**Change directories to your www directory**

Move into the www directory by typing the command:

```
cd www
```
Grant lookup and read permissions to your www directory

Once inside the www directory, you are ready to change its permissions to grant read access to www:servers.

```
fs sa . www:servers rl
```

Create your HTML files in the www directory, or move them there

Use the `mv` command to move your HTML files into the www directory. The syntax for the move command is:

```
mv what where
```

For example, to move the file `test.html` from your home directory to the www subdirectory, type the following while in your home directory.

```
mv test.html www
```

**Warning!** If the destination directory does not exist, in this case, the www directory, the `mv` command will rename the file www (see also *Working with Files*).

The full AFS path to your web directory and the pages it contains is:

```
/afs/unity.ncsu.edu/users/j/jqpublic/www/
```

Shorthand Access to Your URL

All NCSU people (faculty, staff and students) with personal web pages are on the www4 server, so the `http://www4.ncsu.edu/` part of the URL is the same for everyone.

```
http://www4.ncsu.edu/~jqpublic
```

The ~ stands in place of the full directory path, assuming that your web pages are in the www subdirectory in your home directory.

Web servers are set up to display `index.html` or `index.htm` automatically if this file exists in the directory, so you should create one as your home page. If you choose to use a file name other than `index.html` or `index.htm`, you must specify the file explicitly in the URL, for example, `http://www4.ncsu.edu/~jqpublic/home.html`

Responsibility for Web Pages

In creating documents for the web, remember that your information is being served from university computers. Both your userid and your URLs bear the university's
name. For this reason, please make sure that what you present in your pages is appropriate since the content and use of your pages are subject to university policy. The intent of the university in providing these facilities and encouraging student use of the web is educational. Please keep your activities within that arena so that these facilities remain available to others in the future with minimal need for supervision and restriction.

Creating HTML Documents

Although this guide does not offer a full explanation of how to write HTML documents, a list of HTML tags follows that will help you as a reference after you learn the basics.

The Windows labs also have web tools in them (see Appendix B and http://www.eos.ncsu.edu/software/), including the Adobe suite of Dreamweaver, Flash and Fireworks, with the LIFT add-on for web-page accessibility. There is also the Adobe Creative Suite 2 with full versions of Photoshop, Illustrator, InDesign, GoLive, and Acrobat Professional.

An HTML document is generally set up on a page with these minimal elements:

```html
<html>
<head>
<title></title>
</head>
<body>
</body>
</html>
```

The whole document is placed inside the `<html></html>` tags. Make sure that there is a clear, descriptive title between the `<title></title>` tags, which is placed inside `<head></head>`. Between the `<body></body>` tags, you create your document. Also, make sure to sign and date your pages, that is, put your name on your pages and the date when they were created and/or updated.

For help in creating pages on Solaris/Linux, you may want to explore the following lockers:

```
add webbrowsers
add imagetools
add java
```
Some HTML tags:

- `<address></address>`: Address or signature for a document, italicized
- `<a href=" ">`: Hyperlinked reference, e.g., `<a href="reffile.html">link</a>`
- `<b></b>`: Bold text
- `<blockquote></blockquote>`: Quoted passage
- `<body></body>`: Document body
- `<br>`: Line break, single spacing
- `<cite></cite>`: Name or title of cited work
- `<code></code>`: Short words or phrases of source code
- `<dd>`: Definition of a term in a definition list
- `<dl></dl>`: Definition list or glossary
- `<dt>`: Term in a definition list
- `<em></em>`: Emphasized phrase
- `<h1></h1>`: Heading, level 1
- `<h2></h2>`: Heading, level 2
- `<h3></h3>`: Heading, level 3
- `<h4></h4>`: Heading, level 4
- `<h5></h5>`: Heading, level 5
- `<h6></h6>`: Heading, level 6
- `<head></head>`: Document head
- `<hr>`: Horizontal ruled line
- `<html></html>`: HyperText Markup Language Document
- `<i></i>`: Italic text
- `<img>`: Link to image, e.g., `<img src="file.gif">`
- `<li>`: List item, used with ordered `<ol>`, unordered `<ul>`, or menu `<menu>`
- `<menu></menu>`: Menu list
- `<ol></ol>`: Ordered or numbered list
<p> Paragraph, double spacing</p>
<pre></pre>
<code>
<pre></pre>
</code>

<code><strong></strong></code>  Strong emphasis

<title></title>  Title of document (Important! Every document needs one.)

<ul></ul>  Unordered or unnumbered list, with bullets

See also <a>http://www.ncsu.edu/it/essentials/web_pages/</a>
17 Storage and Backup

Thanks to Gary Gatling of ITECS for his help with this chapter.

All user volumes (home directories) and user IMAP mail are backed up nightly on campus servers. However, because every user's space is a limited resource, users should get rid of files they do not need and routinely back up files of importance on a removable storage medium.

 Preserving files that are important (an end-of-the-semester project, dissertation, important research, etc.) is ultimately the responsibility of the users who create them. However, if you happen to lose a file, there are procedures in place to help you restore from backup.

All lab workstations come with floppy drives. Some also have 250MB zip drives, CD and DVD drives, and/or USB ports for hot-pluggable RAM drives. The three platforms also have different utilities and software for making backups and conserving space, which are described below.

Windows Platform

You can store files only temporarily on the local C: drive of Windows lab computers, which is cleaned after each logout. Permanent storage is in your AFS space, which is mapped to the K: drive. To check your quota:

Right-click the K: drive and select AFS -> Volume/Partition -> Properties.

To free up quota:

* Copy files to disk. Press the Shift key and drag and drop files from the K: or J: drive to the:

  - floppy disk
  - CD
  - zip disk
  - USB device

This action moves files, that is, it deletes them from the first drive (source) and places them on the second (target). Drag and drop without Shift copies files (preserves them in both places) and does not free up any disk space. If you
need to format a disk first, place the disk in the drive. Select the drive in **My Computer** and **File -> Format**.

* Delete files. Use the **Search** tool (**Start -> Search -> Files or Folders**) or Windows Explorer (**Start -> Accessories -> Windows Explorer**) and locate files that may be candidates for deletion, e.g., temporary files (***.tmp**), files larger than a certain size, files created before/after certain dates, etc. Make sure that the **K: drive** appears in the **Look in:** field. Select file(s) and **File -> Delete** (to select more than one file, hold down the **Shift** or **Ctrl** key).

* Empty the **Recycle Bin**. Files you delete go in the **Recycle Bin** on the **Desktop**, which means that they are still on the system taking up space (but are also restorable if you need them). Right-click the **Recycle Bin** and select **Empty Recycle Bin**. You can also delete individual files in the **Recycle Bin** by opening it, selecting the file(s), and **File ->Delete**.

* Compress files. Use the **PowerArchiver** program in **Unity Applications** of the **Novell Application Launcher** to zip (archive) and compress files. For help, select **Help -> Brief Tutorial**.

**Solaris and Linux Platforms**

To check your quota on Solaris/Linux, type **quota** at the command line. To remove files from your space, **rm** files and **rmdir** directories, see the chapters, **Working with Directories** and **Working with Files**.

The following methods tell you how to use the devices on the Red Hat Linux and Solaris platforms for external storage.

**Floppy Drives and mtools**

**mtools** is a public-domain collection of programs that enables UNIX computers to read, write, and manipulate files on MS-DOS file systems. You must use **mtools** if you want to access and use the floppy drives on Solaris workstations. You cannot mount floppy drives on Solaris like you can on Linux systems. If you like the **mtools** suite, you can still use all the tools on Linux, you just don’t have to.

You can use any pre-formatted 3.5-inch high-density (HD) 1.44MB diskette in the floppy drive (**A: drive**) of Linux and Sun workstations. However, if it is not formatted, you will need to format it using the following two commands:

```
fdformat /dev/fd0
mformat a:
```
**fdformat** puts the low-level format on the disk. **mformat** adds an MS-DOS file system to a low-level formatted floppy disk. `/dev/fd0` is the device name for *floppy disk 0* and is the correct device path for the first floppy drive on both Sun Solaris and Red Hat Linux.

To list the contents of the diskette in the **A: drive:**

**mdir**

To copy a file from your UNIX computer to the diskette in the **A: drive:**

**mcopy** *oddsends a:*

This action copies the file using the same name. To give the file a different name:

**mcopy** *oddsends a:newname*

To copy a file with the same name from the floppy diskette in **A:** to the current directory you are in on UNIX:

**mcopy** *a:oddsends*

This command copies to your current working directory on UNIX by default. Or, specify a path, if necessary. To specify a new name for the destination file:

**mcopy** *a:oddsends newname*

Make sure that there is no space between the **A:** and the source file. However, be sure to put a space between the source and destination files.

You can also use the wildcard * to copy files from one place to another. To copy all of the files in your current working directory to the diskette in **A:**

**mcopy** *a:*

To copy to disk only those files in the directory with the `.html` extension:

**mcopy** *html a:*

To copy in reverse with a wildcard, that is, from the diskette in **A:** to your current working directory, you will need to put the drive in single quotes.

**mcopy** `a:*`

or

**mcopy** `a:*html`

Consult the man page on **mtools** (**man mtools**) to learn other **mtools** commands. Also, consult the man page on individual commands, e.g., **man mdir**, **man mcopy**.
**Mounting Floppy Disks on Linux**

To mount media is to make the file system of the media available for access. When you mount media, the file system of the media is attached as a subdirectory to your file system. (For Realm Linux workstations based on RHEL WS4, this is now at the path, `/media/floppy/`.)

To mount media, insert the media in the appropriate device. An object that represents the media is added to the desktop.

Double-click on the **Computer** icon from the desktop. A dialog is displayed. Double-click on the object that represents the media. For example, to mount a floppy diskette, double-click on the Floppy object. An object that represents the media is then added to the desktop.

If you do not use the Gnome desktop, or if you prefer doing this step via the command line, you can also mount the floppy disk by typing in your terminal window:

```
mount /media/floppy/
```

Files can be accessed either in the terminal window from the path, `/media/floppy/`, or through the Nautilus file manager on the Gnome desktop.

When you are finished working with the floppy disk, you need to unmount the volume with the **umount** command (no “n”):

```
umount /media/floppy/
```
Or, right-click on the floppy disk icon on the Gnome desktop.
A popup menu will appear. Select the menu option **Unmount Volume**
from the menu.

Zip Drives

**mtools** can be used for accessing both the floppy and zip drives on Linux lab workstations. However, **mtools** is only used to access the floppy drive on Sun lab workstations, not the zip drive, which automounts the drive instead.

You do **not** use **mtools** to access zip drives on Solaris (Sun Blade) lab machines. Rather, follow the instructions below:

1. Insert a zip disk into the zip drive. The zip disk will automount from
   `/rmdisk/zip0/`, which is a mount point that automatically appears when you
   insert a zip disk.

2. Use UNIX commands (**ls**, **cd**, **cp**, **rm**, **mkdir**, etc.) but specify the mountpoint
directory, `/rmdisk/zip0/`, rather than a drive letter, e.g., **ls** `/rmdisk/zip0/`.

3. When you are finished working with the disk, remove the disk from the drive
   with the following command in an xterm window:
   **eject** *zip*
   You must eject the disk with the **eject** command. The button on the front of the
   drive will not work.
If you receive an error message similar to:

```
/vol/dev/dsk/c0t2d0/noname:c: Device Busy
```

you are still in the `/rmdisk/zip0/` directory. Type `cd`, press `Return`, and issue the `eject zip` command again.

**Important!** You cannot format a zip disk on a Sun workstation. It requires root-level permission, which the routine user does not have. However, you can format zip disks on Windows and Linux workstations and use them in a Sun zip drive. Formatting puts a `vfat` file system on the zip disk partition that holds data, which works on all three platforms and on both zip 100 or zip 250 disks.

**CD Drives**

A *CD-ROM* is a read-only disk. Commercial software comes on these disks. All CD-ROM drives can read these disks.

A *CD-R* is a recordable CD that can only be recorded once. A CD-R can be read in most CD readers, including old PCs.

A *CD-RW* (recordable/writable) disk can be recorded once like a CD-R or written to multiple times (about 1000 times). You blank it first (takes just a few minutes) and then you can write to it like a CD-R. The rewritable CDs can only be read on more modern PCs. You should be able to read these disks on any lab machine.

Data CDs usually use the *iso9660* file system. `mtools` commands are designed to read FAT16 or FAT32 file systems of the MS-DOS operating system only. As a result, you cannot access your CD-ROM with `mtools` on either Linux or Solaris workstations. However, an automounting mechanism has been created for both platforms to access data CD-ROMs.

**Sun Solaris Lab Workstations**

To use CDs on Sun workstations running Solaris 8:

1. Insert the CD-ROM in the DVD-ROM drive. The CD will automount off of `/cdrom/cdrom0`, which is a mount point that will automatically appear when you insert the CD-ROM.

2. Use UNIX commands (`ls`, `cd`, `cp`, `rm`, `mkdir`, etc.) but specify the mountpoint directory, `/cdrom/cdrom0`, rather than a drive letter, e.g., `ls /cdrom/cdrom0`.

3. When you are finished working with the CD, remove the CD-ROM:
   
   `eject cd`
   
   Or, press the button on the front of the drive.
Data DVD-ROM disks mount under `/cdrom/cdrom0/` just like CDs do, but you cannot watch DVD movies. The software required to view DVD movies (`ogle, dvdread, libcss`) is not installed on Eos/Unity.

**Red Hat Linux Lab Workstations**

Using the GNOME environment:

1. Insert the CD in the drive. It will automount for you (at `/media/cdrom/`).
2. Remove (unmount) the CD-ROM before you log out. To unmount, right-click the CD-ROM icon on the desktop and select **Eject** on the popup menu.

Also you can eject CDROMs by typing this command in your terminal window:

```
eject /dev/cdrom
```

Or, press the button on the front of the drive.

You can also burn CDs on GNOME

1. Insert a blank CD-R or a CD-RW disk into the CD-ROM drive. The Nautilus file manager will open its **CD Creator** application.
2. Drag files you want to archive into the `burn:///` window. Select the **Write to CD** icon in the window to burn the CD.

If the window does not appear, you can type `burn:///` in any Nautilus window for the same function. You can also select **Places -> CD Creator** in a Nautilus window.

You can also use the `cdrecord` command to burn CDs. There are many different arguments that you can give `cdrecord`, so consult the man page:

```
man cdrecord
```

To blank CD-RW disks, you will also use the `cdrecord` command. You will need to blank a CD-RW before you can record to it if the CD has ever been used before.

**USB Drives and Smart Card Reader**

You cannot use USB drives on a SunBlade 100 or 150, nor can you use the Smart Card Reader. Drivers and OS support are not available at the current time.

You can use USB drives on Linux, but not all USB drives will work with Red Hat Linux. Many/most of the usb-pen/thumbdrive type devices out on the market will work, but the only way to know is to try them out. There is no Smart Card Reader on the Dells running Windows and Linux.
To use your USB drive, always remember to insert it into the USB port on the front of the computer. Most lab machines have popup doors in the front of the case which expose the USB ports.

Once you have inserted your USB drive into the USB port in the front of the PC, an icon should appear on the desktop labeled **Removable Media**. To access the drive, select the **Removable Media** drive icon on the desktop, or access the drive via a terminal window from the path, `/media/usbdisk`.

If you choose the command line method of access, the disk will always be mounted off of `/media/usbdisk`.

To unmount the disk, right-click the **Removable Media** icon and select **Unmount Volume**, or type the following command (**umount**, no “n”):

```
umount /media/usbdisk
```

Once you have unmounted the drive, you can safely pull it out of its USB port.

To format a USB drive on Linux, make sure that the drive is unmounted but still plugged in and type:

```
/sbin/mkfs -t vfat /dev/sda1
```

This command makes a **vfat** file system on the USB drive partition that holds the data. It is possible to format a USB drive with some other file system such as **ext3**. Check **man mkfs** for more information.

**Note**: Computers running the Windows operating system will not be able to read USB drives which have been formatted **ext2** or **ext3**. Most people will want to use **vfat** so that the device can be read on the widest possible range of computing devices.

Avoid NTFS if you format your USB drive on Windows since Linux has problems with that file system at this time.

You can use **mtools** with a USB drive to copy files if you prefer using mtools. If you are to have success with the **mtools** suite, however, use **G** to access the usbdisk. **mtools** only works with **vfat** formatted media.

Or, use regular UNIX commands if `/media/usbdisk` is the root of your USB drive. Accessing via `/media/usbdisk` works with any filesystem including **ext2/ext3**.
**Tar and Compress Files**

The GNU `tar` command (tape archive) takes multiple files and archives them as a single file, whose size can be further compressed with GNU `zip`. `tar` also works in reverse to extract files from a `tarfile` and restore them to their original state.

The following instructions show how to archive/extract files to/from a single tarfile.

1. Put files to be archived in a subdirectory, e.g., `homework`.
2. `add gnu` (Solaris only; GNU tar is default for Linux)
3. Make a single compressed file from the files in homework:
   ```shell
tar zcvf file.tgz homework
   ```
   (the `z` flag does the `gzip` step to compress the file)
4. Move tarfile (`mv file.tgz`) to other media (see previous section on `mtools`) and remove the `homework` directory and its contents, `\rm -rf homework`.

To restore the work directory and its files:

1. Copy `file.tgz` back to your AFS space
2. `add gnu`
3. Extract the `homework` subdirectory and its files:
   ```shell
tar zxvf file.tgz
   ```
4. Check to see that the `homework` directory and files are restored and then remove the tarfile, `rm file.tgz`.

You can also compress files to make them smaller with the `compress` command. A compressed file has a `.Z` extension.

- `compress file`
- `uncompress file.Z`

**Reallocating your AFS, IMAP, and Novell Storage Space**

From [http://www.ncsu.edu/it/essentials/your_unity_account/disk_quota.html](http://www.ncsu.edu/it/essentials/your_unity_account/disk_quota.html)

As a Unity account holder, you have 300 MB of personal file storage space (disk quota) on the campus network, divided into three categories:

* AFS space
  
  Your space for personal files and web pages. On an Eos or Unity lab machine, this appears as your home directory (on a Solaris or Linux machine) or K:
drive (Windows machine). The path to this space is in this format:
/afs/unity.ncsu.edu/users/initial/unityid
where unityid and initial represent your Unity ID and its first letter, e.g.,
/afs/unity.ncsu.edu/users/j/jqpublic

* Email space
  Your campus email account space, which contains your IMAP email and email folders.

* Novell space
  Your profile data and any files you save on the desktop and M: drive of a Wind-
  dows Eos or Unity lab computer.

To check or reallocate the 300MB of storage you are given on the campus network:

1. Go to https://sysnews.ncsu.edu/tools-bin/usmdb-quota. You will need to log in
   with your Unity ID and password. On this page is a table showing your current
   space usage for each of the above categories (AFS, Email, Novell).

2. For each of these categories you will see a text box in the right hand column
   (New Quota) containing a number that indicates your current usage in that
   category.

3. To change your usage limit for a category, double-click on the number and
   type in a new one.

4. The total of the numbers in the three boxes will be calculated automatically
   and will appear in the New Total Quota box. Make sure that your new total
   does not exceed 300.

5. When you have made all the changes you want, click on the Submit Change
   Request button at the bottom of the table. If you have difficulty allocating
   your space, contact the NC State Help Desk, help@ncsu.edu.

### Restore from Backup

Thanks to NC State Help Database (http://help.ncsu.edu, calls 1332, 2167) for the
information in this section.

Sometimes you delete files you do not intend to and need to restore from a backup
made on university servers. Tape backups exist for the previous 28 days. You can
do your own restore if you need a backup from yesterday. If you need a backup
from days prior to yesterday, you will need to request a restore. Nothing older than
28 days can be restored.
Note: The commands described in this section here are issued at a command prompt on Solaris and Linux computers. If you are working on the Windows platform, you will need to work from the MS-DOS Command Prompt or PuTTY. If working on a non-realm computer, see the chapter, Remote Access Services.

How and When Backups are Made

All user volumes (home directories) are backed up every 24 hours. Part of the backup process is the generation of backup volumes, or online backup copies. Backup volumes are generally created shortly after midnight, and they exist unaltered until the next time a backup volume is created. Backups are made from a snapshot of your files as they exist on or around midnight of that day. For example, files you restore on a Thursday are as they existed when you quit working on Wednesday.

In order to restore a deleted file, the file must have been copied to backup at some time. It is not possible to restore a file that was never backed up. In other words, if you delete a new file that you just created, you will not be able to restore it because it has never been copied to backup.

Restoring Your Own Lost Files

You can restore your own files, but only from the previous day's backup. If you need something from earlier than yesterday, see Request a Restore below.

Before getting started, regardless of what operating system you are on, you will need to get to a unity% or eos% prompt:

UNIX/Linux: Open a new terminal window or use default terminal window.

Windows: Open the Unity Terminal application from the application launcher. This will automatically connect you to one of the remote access machines. Upon successful login, you will be presented a command prompt.

Macintosh: To get to the unity% prompt on the ITD Lab Kit, open the Admin-Launcher (should be open at login) and click on the Default tab. Select the button that says ssh. Once you click on the ssh button, the terminal program will open and automatically connect you to ssh.ncsu.edu. Type in your password when prompted, and after successful login, the unity% prompt will appear in the terminal window.

Every instruction listed below that is labeled a "command" needs to be entered at this unity% prompt.
In order to restore a deleted file yourself, the most recent backup volume must have the file in it, and you must restore it before the next backup volume is made (just after midnight). Otherwise, the user volume without the file will be on the next day's backup. To restore your files:

1. Determine the location of the files to be restored, including the following:
   - name of the file(s) and the directory they are in
   - name of your user volume
     To identify your user volume name:
     ```
     fs examine ~
     ```
     which will output something like
     ```
     Volume status for vid = 537008297 named
     users.m.mcdaniel
     ```
     The name of the user volume is `users.m.mcdaniel`
   - name of your AFS cell
     To find out the AFS cell in which your volume resides:
     ```
     fs whichcell ~
     ```
     which will output something like
     ```
     File /ncsu/mcdaniel lives in cell unity.ncsu.edu
     ```
     The cell name is `unity.ncsu.edu`.

2. Mount your backup volume. Type `cd` with no arguments to move to your home directory. Next, mount your backup volume with the following command:
   ```
   fs mkmount -dir directory -vol volume.backup -cell cell
   ```
   e.g.:
   ```
   fs mkmount -dir backup -vol users.m.mcdaniel.backup -cell unity.ncsu.edu
   ```
   **Note:** The `backup` directory has to be a path to a directory in the user's home directory. Otherwise, you will get an error message that you have insufficient permission to write.

3. Retrieve your files. After you have mounted your `backup` volume, you can `cd` into it, `~/backup`. You are now in the `root` of your home directory as it was at the time the `backup` volume was made. Find the file(s)/you are looking for, and copy it out of the `backup` directory into your home directory, e.g.:
   ```
   cp backup/lostfile.doc ~
   ```
Repeat this step for each file you wish to restore, then `cd` back to your home directory.

4. Unmount your `backup` volume. To unmount:
   
   ```
   fs rmmount -dir directory
   ```
   
   e.g.,
   
   ```
   fs rmmount -dir backup
   ```

**Request a Restore**

If you lose a file, you can restore it from the previous day's backup yourself (see above). If you need a backup from earlier than the previous day, you will need to request it from system staff by writing `help@ncsu.edu`.

Restoring files from tape backups is a labor-intensive and time-consuming process. As a result, system administrators are limited to performing only two restores per person. When you write to `help@ncsu.edu`, please provide:

* your Unity ID
* name of the file
* name of the directory in which it resides
* the date when the file was last known to be on the system.

Include any additional information to help system staff find and restore the file(s). **Please note that backups are only kept for 28 days.** The computing staff cannot fulfill restore requests for files more than 28 days old.

A staff member will locate a suitable copy of the file(s) and place it in a temporary directory away from your home file space. The path to the restored file will be e-mailed to you. You should examine the restored file, and if it is what you need, copy it from the temporary directory back to your home directory and/or to external media. After approximately 10 days, the temporary restored copy will be removed from the system.

**Conserving Quota**

Follow the advice below to conserve quota and make the best use of your space.

* Do not store files that you can get from other locations. Read and use these files where they are located rather than downloading them to your file space.
* Archive and compress files you are not using and move to other media for storage.

* Delete duplicates, mail attachments, and any files you don't need. Use the `du` command (disk usage) to see what space your files are using.

* Do not share your quota by giving someone your password. You can share your account space in other ways (see *AFS File Sharing*). However, be aware that you are giving up quota for someone else's use.
18 Remote Access Services

*Thanks to Billy Beaudoin and Aaron Peeler for the content in this chapter.*

NCSU provides students, faculty, and staff with remote-access services for connecting to and using the campus computing system from home and non-realm computers. A description of this service and its use policies are at:

`http://www.ncsu.edu/it/rulesregs/remote-access/`

Some exceptions to these policies exist for the College of Engineering, which provides separate remote-access facilities that permit users to run high-end software on its servers. The remote-access services developed and documented by the College of Engineering can be found at:

`http://www.eos.ncsu.edu/remoteaccess/`

Non-engineering users can also take advantage of the resources at this site. However, some resources are restricted to the College of Engineering only.

**ResNet**

NCSU provides network services to students in the residence halls called **ResNet**.

`http://www.ncsu.edu/resnet/`

Although there are Unity labs in several of the residence halls (see **Labs** chapter), ResNet is primarily targeted at connecting student-owned computers to the university’s computer network and to the Internet. Since ResNet lies outside Eos and Unity computing, access to realm resources from the residence halls is via remote access. Excellent ResNet-specific information and resources are provided at the web site above. In addition, the remote-access services discussed in this chapter are available to ResNet users also.

**Wireless Networking on Campus**

From `http://www.ncsu.edu/it/essentials/connections_labs/wireless.html` and `http://wireless.ncsu.edu`

NCSU provides wireless access to the campus network for students, faculty, and staff. The number of wireless “hot spots” on campus is increasing almost daily, but it is not yet ubiquitous, nor will it be for some time. However, there is a multi-year
schedule for campus-wide deployment of easily maintainable wireless networking that will offer widespread coverage and good security from malicious hackers.

You can do many things via wireless that you can do with a wired network connection. However, the range is less than 300 feet and is diminished further if the signal has to travel through walls or is hampered by other obstacles. Additionally, wireless access points are a shared resource using shared bandwidth, which decreases the bandwidth an individual user may have to use. Wireless is not as good a connection as wired, but it is satisfactory for many tasks.

To find wireless “hot spots” around campus where you can connect, see:

http://www.ncstate.net/wireless/docs/map.html

If you are in engineering buildings, you can check the locations at:

http://www.eos.ncsu.edu/soc/wireless/wireless_areas.php

To access the wireless network, you need a portable computer or handheld device that either has built-in wireless capability or a wireless add-on card. Make certain that any equipment, card or adapter you buy uses either 802.11g (preferred) or 802.11b standard. The older 802.11b is supported on many different computing platforms, including Macs, PCs and handheld devices, but the newer 802.11g offers improved security and speed. Many of the newer access points on campus are 802.11g, but all are backwards compatible to accommodate 802.11b also. Some wireless areas also use 802.11a, including many classrooms.

To connect to the campus Nomad wireless network:

1. Follow the manufacturer's directions for installing the wireless card and its software, using the newest drivers for the card from the manufacturer's web site. Use the default network settings specified by the manufacturer.

2. If you are close enough to a wireless access point, the card should automatically detect it. If this does not happen, go into your card's configuration setup and look for the SSID. For that value, type (in lower case): ncsu.

3. If you want to register your computer, go to the Nomad Registration System web page at http://nomad.ncsu.edu, if it does not automatically appear.

4. Select Device Registration, log in, and select Add Device. Detection of your MAC address should be automatic, so add a Description of your laptop, agree to the Policy Agreement, and select Add Device.

5. At the left of the page, you will find additional information on managing all devices you register at this site, including renewing them every 3-4 months.
Remote Access Connections

To use remote-access services to connect to NCSU from off campus, you will need a Unity account (see *Accounts and User Resources*). You also need Internet access provided by an *Internet Service Provider (ISP)*. Students in residence halls have high-speed access through ResNet, so no additional Internet access provider is needed. ITD provides advice for choosing an ISP at:

http://www.ncsu.edu/it/essentials/connections_labs/off_campus.html

For some remote-access services, such as running applications remotely, you will need a high-speed connection through DSL or a cable modem. Dialup will be too slow and unreliable. Thus, if you are a distance student, who cannot come to labs and routinely work from your home or office, you will likely need a high-speed connection to make effective use of the tools described here.

To protect the privacy of those who use remote-access services, NCSU and the College of Engineering recommend and implement secure, encrypted communication for the services they provide. Also, whenever possible, they use free open-source technology to implement remote access.

The following is a list of methods that remote users can use to get to campus resources. More information is available in the following sections for access from Windows, Linux, and Macintosh platforms.

* Web-based Services
* Secure File Transfer
* Secure Access to UNIX/Linux Applications
* Virtual Computing Lab
* Batch Processing
* OpenAFS

Web-based Resources

Web-based services comprise the simplest form of remote access. There is a growing number of web applications and services at NCSU available to anyone with a Unity account, a computer connected to the Internet, and a web browser. You can use the web to access the following:

* Webmail for Unity email (http://webmail.ncsu.edu)
* Oracle Calendar (http://webcal.ncsu.edu)
* Registration (http://www.ncsu.edu/registrar/registration/)
* WebAssign assignment and course tools (http://www.webassign.net/ncsu/)
* WebCT course tools (http://webct.ncsu.edu)
* Realm printers and WolfPrint (http://print.ncsu.edu)
* Sysnews computing tools and news (http://sysnews.ncsu.edu)
* Library services and subscriptions (http://www.lib.ncsu.edu)
* Information Technology Online Help Desk (http://help.ncsu.edu)

Other services are quickly moving to the web for easy access by users wherever they are working. Most of these services are secured by the NCSU Web Realm Authentication Protocol (WRAP), which requires you to log in with your Unity ID and password in order to use them.

http://www.ncsu.edu/wrap/

**Remote Access Servers**

For some of the services described in this chapter, you will need to make a connection to a server on campus. The following is a list of the Secure SHell (ssh) remote-access servers for all NCSU users and for the College of Engineering.

* `login.ncsu.edu` - (Solaris) NCSU students, faculty, staff
* `remote.eos.ncsu.edu` - (Solaris) College of Engineering students, faculty, staff
* `remote-linux.eos.ncsu.edu` - (Linux) College of Engineering students, faculty, staff

Virtual Computing Lab (VCL)

(Solaris, Linux) NCSU students, faculty, and staff
(Windows) VCL courses and College of Engineering students using specific applications at http://vcl.ncsu.edu/site/pages/project/engineering-application-list

**Secure File Transfer**

The purpose of file transfer is to move files/data from one computer to another over the Internet. With file transfer, you navigate through directories to locate and move files. Most Eos/Unity users use file transfer to put/move files from their home computers into AFS, or to get/move files from AFS to their home computers.
You can only move files with file transfer. You cannot open or read them on the remote computer, nor can you run applications on the computer you connect to.

File transfer between computers has commonly been done through ftp, a thirty-year-old protocol that is not secure. ftp clients transfer files and passwords in the clear, meaning that the transfer can easily be tapped by third parties. The campus will eventually phase out traditional ftp clients and servers and replace them with the ssh-based protocol, which encrypts data sent over the network.

As a secure alternative to ftp, we recommend sftp (SSH File Transfer Protocol) clients for Windows, Linux, and Macintosh, available for download from http://www.eos.ncsu.edu/remoteaccess. These programs provide user-friendly interfaces to work through to transfer your files to and from AFS space.

**Important!** Do not connect through an ftp server with this software but to the ssh-configured remote-access servers listed in the Remote Access Servers section.

**From Linux and Macintosh**

scp (Secure Copy) and sftp (SSH File Transfer Protocol) are recommended over conventional ftp on Linux and the UNIX-based Macintosh OS X because they encrypt and transfer data securely, whereas ftp passes everything in the clear, including passwords. With scp and sftp, you connect through the ssh-configured remote-access servers listed in the Remote Access Servers section. Scp and sftp are part of OpenSSH, which comes pre-installed on most Linux distributions and all installs of Mac OS X.

SecPanel is an application available for Linux that provides a graphical user interface for managing and running ssh and scp connections. Fugu, a program created by the University of Michigan, provides similar functionality for Mac OS X sftp and scp. Cyberduck is another good sftp program for the Mac. For additional application information and instructions, see:

- http://www.eos.ncsu.edu/remoteaccess/linux.html
- http://www.eos.ncsu.edu/remoteaccess/macintosh.html
- http://www.ncsu.edu/mac/

**From Windows**

Two secure file-transfer programs are available for download from the Eos remote access site (see URL below): WinSCP (Windows Secure Copy) and F-Secure. If you want file transfer only, WinSCP is easier to install and use. However, if you want a single client that does both file transfer and shell access through a secure-
shell connection, you may prefer F-Secure. For both, you connect through the ssh-configured remote-access servers listed in the Remote Access Servers section.

For these and other application downloads, plus instructions for configuring and using them, see:

http://www.eos.ncsu.edu/remoteaccess/windows.html

Table 4: WinSCP vs. F-Secure: Which to Choose for File Transfer?

<table>
<thead>
<tr>
<th>Feature</th>
<th>WinSCP</th>
<th>F-Secure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ease of Installation</td>
<td>No installation required. Application is one file.</td>
<td>Easy installation</td>
</tr>
<tr>
<td>User Interface</td>
<td>Fairly Simple</td>
<td>Complex</td>
</tr>
<tr>
<td>Supports SSH Terminal</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Location of Settings</td>
<td>Registry</td>
<td>File in F-Secure directory</td>
</tr>
<tr>
<td>History</td>
<td>Open Source. Written and maintained primarily by Martin Prikryl.</td>
<td>Not Open Source. A commercial application made available for free to all NCSU faculty, staff, and students.</td>
</tr>
<tr>
<td>Size</td>
<td>~560 KB</td>
<td>~5 MB</td>
</tr>
</tbody>
</table>

Secure Access to Command-Line and Graphical UNIX/Linux Applications

Almost any program available on Eos/Unity Solaris and Linux lab workstations can be run remotely using a terminal program to connect to one of the remote-access servers listed in the Remote Access Servers section. A terminal program allows you to open/view files and run programs on the computer you connect to, but you cannot transfer files to or from it.

To make a terminal connection to run commands and applications requires the use of Secure SHell (ssh) software. Users may be familiar with the older, insecure alternative to the ssh protocol called telnet. Telnet terminal access is no longer supported on campus, and you will not be able to use telnet to connect to any Eos or Unity remote server.

To run a graphical application requires additional software that can display the windowed applications on your computer. (Run only one application at a time if you want good performance.) The specific windowing system used by Solaris and
Linux applications is X Window System, or X. Ssh and X go well together because of a feature called X11 forwarding, which allows for X applications to be forwarded through the ssh connection back to the computer where the user is sitting. This allows X, which is an a fairly insecure protocol, to gain the security features used with ssh.

**Note:** The application you connect to actually runs on the remote computer, not on your own machine, so such things as printing locally from the application will not work. Also, the speed at which applications run is determined by the capacity of the remote server and the load it is carrying. Remote-access servers are shared resources, capable of handling many users connecting at the same time, which can slow them down. By contrast, the servers utilized by the Virtual Computing Lab (VCL), mentioned later in this chapter, are all dedicated, single-user machines.

For a list of applications available on Realm/Linux and Realm/Solaris, see *Software Applications* and *Appendix B*, and also [http://www.eos.ncsu.edu.software/](http://www.eos.ncsu.edu.software/).

**From Linux**

Linux uses the X Window System, or X, as its native system for displaying graphics. Additionally, almost every distribution comes with ssh (specifically OpenSSH) included. Using ssh, you can log in and run UNIX and AFS commands and command-line applications, such as, pine, pico, vi, etc. Once again, ssh is recommended over the older protocols of telnet and rlogin because of its enhanced security, supportability and performance. Use ssh to log in to one of the remote-access servers listed in the *Remote Access Servers* section. Information on the precise command-line parameters is available at:

[http://www.eos.ncsu.edu/remoteaccess/sshsettings.html](http://www.eos.ncsu.edu/remoteaccess/sshsettings.html)

For additional information and instructions for configuring ssh and X11 tools for use on Linux computers, as well as general information on accessing various campus resources remotely, see

[http://www.eos.ncsu.edu/remoteaccess/linux.html](http://www.eos.ncsu.edu/remoteaccess/linux.html)

**From Macintosh OS X**

Macintosh OS X is a UNIX-based OS, unlike earlier versions of Macintosh OSes. However, OS X does not use the X Window System as its native system for displaying graphics. In order to display graphics and windows that use X, you must download and install Apple's distribution of X from:
OS X does come with ssh (specifically OpenSSH) included. Using ssh, you can log in and run UNIX and AFS commands and command-line applications, such as, pine, pico, vi, etc. To run graphical applications, you must first start X11.app and then log in with ssh in the xterm window that will be displayed automatically.

Once again, ssh is recommended over the older protocols of telnet and rlogin because of its enhanced security, supportability, and performance. Use ssh to log in to one of the remote-access servers listed in the Remote Access Servers section. Information on the precise command-line parameters is available at:

http://www.eos.ncsu.edu/remoteaccess/sshsettings.html

For additional information and instructions for configuring ssh and X11 tools for use on Mac OS X computers, as well as general information on accessing various campus resources remotely, see:

http://www.eos.ncsu.edu/remoteaccess/macintosh.html
http://www.ncsu.edu/mac/

### From Windows

To run command-line applications like pine and pico, and to execute UNIX and AFS commands at the shell prompt, requires the installation of either F-Secure or PuTTY (see following table for help in choosing). For both, you connect through the ssh-configured servers listed in the Remote Access Servers section.

<table>
<thead>
<tr>
<th>Feature</th>
<th>PuTTY</th>
<th>F-Secure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ease of Installation</td>
<td>No installation required. Application is one file.</td>
<td>Easy installation</td>
</tr>
<tr>
<td>User Interface</td>
<td>Fairly Simple</td>
<td>Complex</td>
</tr>
<tr>
<td>Supports SCP</td>
<td>Supports SCP with an add-on program</td>
<td>Yes</td>
</tr>
<tr>
<td>Location of Settings</td>
<td>Registry</td>
<td>File in F-Secure directory</td>
</tr>
<tr>
<td>History</td>
<td>Open Source. Written and maintained primarily by Simon Tatham.</td>
<td>Not Open Source. A commercial application made available for free to all NCSU faculty, staff, and students.</td>
</tr>
<tr>
<td>Size</td>
<td>~370 KB</td>
<td>~5 MB</td>
</tr>
</tbody>
</table>
The ssh client that you use to connect to the remote-access servers is not capable of displaying X-based graphics, but it is capable of forwarding the corresponding data to the local X-Server, which in this case is **X-Win32**, a commercial application made available for free to all NCSU faculty, staff, and students through licensing arranged by the College of Engineering and Starnet Communications. X-Win32 is a PC X-Server and displays graphics on your PC that use the X Window System.

**Note:** To run X Windows applications requires X-Win32 to be run each time you make a connection. The program allows Windows users who have connected to Linux/Solaris systems on Eos/Unity to display the windowed (graphical) applications running on those systems back on their Windows machines. Although these applications are running remotely, you interact with them on your Windows desktop just like you were sitting in front of a Solaris or Linux workstation in a computer lab.

To connect:

1. Run **Start Menu -> Programs -> X-Win32 -> X-Win32**
   Do this every time you want to use an application with a GUI remotely.

2. Check for the X icon in the system tray, which shows that X-Win32 is running.

3. Start your ssh client, either PuTTY or F-Secure.

4. Connect to the server of your choice, see Remote Access Servers, depending on where the application runs (see also Appendix B or [http://www.eos.ncsu.edu/software](http://www.eos.ncsu.edu/software)).

5. Run programs just as you would on Eos/Unity workstations. Type **add** on the command line for a list of applications and instructions for running them. For example, to launch the NEdit editor, type **nedit &** at the prompt. Please run only one application at a time since the remote-access servers are a shared resource.

6. When you are finished using realm applications, type **logout** at the prompt.
   Exit your ssh client. Exit X-Win32 by right-clicking on the X in the system tray and selecting Close.

**Note:** There will be a new version of XWin32 on the system by fall 2006, which might change some of the above instructions, particularly the ssh connection. Please check the following web site for up-to-date information and instructions:

[http://www.eos.ncsu.edu/remoteaccess/xwin32.html](http://www.eos.ncsu.edu/remoteaccess/xwin32.html)
Virtual Computing Lab

The Virtual Computing Lab (VCL) is an on-demand, 24/7 facility that connects NCSU users to high-end computers for the purpose of running software applications remotely. The VCL is a joint project of the College of Engineering's Office of Information Technology and Engineering Computer Services (ITECS) and the NCSU Information Technology Division's (ITD) High-Performance Computing (HPC) initiative. It was designed to address the computing needs of both local and distance students and faculty, who require round-the-clock access to university-licensed software applications.

VCL Resources

The user accesses VCL at http://vcl.ncsu.edu/ and uses a web interface to choose an application and schedule a computer for immediate or future use.

The computers that VCL uses are all dedicated, single-user machines. The design of VCL makes it possible to schedule and interface with many different types of environments. Current VCL environments that can be remotely accessed are custom Linux and Windows XP application environments with elevated permissions, and the Solaris/Linux public lab environments.

* VCL Windows XP application environments are available to all College of Engineering students. A complete list of available applications is located at http://vcl.ncsu.edu/site/pages/project/engineering-application-list. VCL environments are also available to instructors and students on a per-course basis. The Windows XP environment is provided on demand at the time of the VCL request. These are accessed using the Remote Desktop Protocol (RDP), which is a protocol that allows a user to connect to a computer running Microsoft Terminal Services.

* The Solaris/Linux lab environments are available to anyone with a Unity account. The machines consist of a pool of 24x7 servers and access to over 200 off-hours Solaris/Linux lab machines (see the Labs chapter). Refer to Secure Access to Command-Line and Graphical UNIX/Linux Applications section earlier in this chapter for instructions in how to access these machines.

Users can access VCL and run applications from their own desktop or mobile computers. The computing experience is very similar to what is possible in a physical computing lab. VCL also provides vendor-standard remote access protocols and client software, eliminating the need for specialized customization of one's own computer and making updates and maintenance easier. Having a single version and
configuration of an application for a course also eliminates the problems that result when students run the application on different OSes, versions, and configurations. Complete instructions for reserving and using VCL are at http://vcl.ncsu.edu.

**How to Reserve an Application in VCL**

Before you can connect to any VCL application, you need to be working over a high-speed Internet connection (T1, T3, DSL, cable modem).

To connect to a Windows application in VCL, you need to configure your computer to make a remote desktop connection. You will need to follow the specific Remote Desktop Protocol (RDP) instructions at http://vcl.ncsu.edu/site/pages/help/vcl-help for the OS you are connecting from (Windows, Mac, or Linux).

To connect to Solaris and Linux applications, you will need to be running SSH and an X-Server. Those instructions are available at http://www.eos.ncsu.edu/remoteaccess and linked in to the VCL site, http://vcl.ncsu.edu.

To make a reservation to use an application:

2. Select the **Make a VCL Reservation** link.
3. Log in to the web-based reservation system with your Unity ID and password.
4. Choose the application and operating system environment that you want to connect to from the pull-down list of available applications.
5. Select the radio button beside **Now** if you wish to use the application immediately. Select the radio button beside **Later** to run the application in the future. If selecting **Later**, enter the day and time.
6. Select the session length for how long you need the application and computer ((For: 30 minutes, 1 hour, 2 hours, 3 hours, or 4 hours).
7. Select **Submit**.

If you choose to use an application now, you will be taken to a **Current Reservations** page with a note in red that says **Pending**... When the application is set up on the remote computer (requiring as much as 1 to 20 minutes to load), the **Pending**... note will be replaced by a **Connect!** button. Select it to connect.

If you scheduled to use the application later, you will get a reservation confirmation. Return to http://vcl.ncsu.edu at the specified reservation time and select the **Current Reservations** link to connect to the application.
Once connected, you have full access to your AFS drives for storage and retrieval of files, and you can also print if needed. See VCL Help at the web site for more.

**Note:** VCL is still under development with the goal of making more connections automatic for easier access and use. Consult the VCL site for the most up-to-date information about making connections and running applications remotely.

**Batch Processing**

The **LSF Suite (Load Sharing Facility)** from Platform Computing Corporation is an industry-standard set of integrated products that turns a distributed network into a single shared computing resource for robust load sharing and batch scheduling. LSF provides background batch processing for Eos/Unity users who need to run long calculation-intensive programs that take longer than a session to complete. LSF renews your AFS tokens and Kerberos tickets automatically, so you do not have to **kreset** or lock a workstation to run your program.

When the program completes, LSF emails you with any output it has created. If your program saves all of its output to a file, the file can be created in your AFS home directory. The email will show any output that normally goes to the screen and will indicate to you whether your program run was successful.

LSF operates under a **fairshare** policy. If **jouser1** submits 30 jobs and **jouser2** submits one, **jouser2**’s job becomes second in line. This prevents a single user from monopolizing all of the batch resources. LSF runs on two servers to improve load-sharing, so you get your results as soon as possible.

To submit a job to LSF batch servers (see Secure Access to Command-Line and Graphical UNIX/Linux Applications in this chapter for information on how to make an **ssh** connection; see also [http://www.eos.ncsu.edu/software/lsf](http://www.eos.ncsu.edu/software/lsf)):

1. **ssh** to **lsf.ncsu.edu** and log in with your userid and password.
2. **add** **lsf**
3. **cd** to the directory your program is in.
4. **bsub** **program**
   where **program** is the command typed to get the application to run from the command line. Enter your password when prompted.

**Note:** If your job needs redirected input or output, put the job description in quotes, e.g.,

**bsub** “**program < input_file**”
5 Enter your password when prompted.

You will receive email when the job is complete. Other commands include:

**bjobs** (to check on the status of your job(s))

**bkill jobnumber** (to kill a job you have running)

Or, you can use **xlsbatch** for a graphical user interface (GUI) to submit and remove jobs from the queue. It will pop up a window to request your password.

Documentation for LSF is available at [http://manuals.eos.ncsu.edu](http://manuals.eos.ncsu.edu) at the URL listed below. You will need to log in with your NCSU Unity ID to use the manuals. [http://manuals.eos.ncsu.edu/lsf/docs50/html/using_5.0/lsf_admin_usingTOC.html](http://manuals.eos.ncsu.edu/lsf/docs50/html/using_5.0/lsf_admin_usingTOC.html) [http://www.eos.ncsu.edu/software/lsf/](http://www.eos.ncsu.edu/software/lsf/)

**OpenAFS**

NCSU has a large AFS network, which is used to serve user home directories, course lockers, research and project file space, and software. It is possible for users to gain access to AFS by running an **OpenAFS** client ([http://www.openafs.org](http://www.openafs.org)) on their personal computers.

The OpenAFS client, working with Kerberos, joins the file system of your local computer with the campus AFS file system. It allows you to access AFS on your personal computer in ways you are familiar with (K: and J: drives on Windows, /afs on Unix/Linux), and you can work with the files on those drives just as you would in an Eos or Unity lab. You can open, edit, and save files as if they were on your local computer, while the client takes care of transferring them to and from the campus network. In short, the AFS file system comes to you through the OpenAFS client, and you do not have to go to a lab to have direct access to AFS.

OpenAFS is the open-source organization that maintains and distributes clients for AFS. OpenAFS provides clients for many operating systems, but the three most commonly used by students at NCSU are the ones for Windows, Linux, and Mac OS X. A high-speed connection is essential for running OpenAFS effectively. Kerberos is built in to Linux and Mac OS X, but Windows users will have to use the Kerberos for Windows software.

The following web site provides downloads, instructions for use, and configuration details for the specific client you need. At the time of this guide’s publication, the AFS client for Mac Tiger (10.4) is still in development, but OpenAFS for Panther (10.3) is available. The replacement for NCSU's custom WolfCall application,
whose functionality is now part of OpenAFS and Kerberos for Windows, is still in development also. As a result, the web site below will be your best and most current resource for AFS client information and downloads.

http://www.eos.ncsu.edu/remoteaccess/afs.html

**Important!** Establishing AFS access on your own computer is not for everyone. For the user who needs routine access to command-line tools and file transfer, the methods described in previous sections are recommended over running an AFS client, particularly if you do not have a high-speed connection. OpenAFS is useful but not essential for most users working remotely.

**Student-owned Computing**

Students with their own computers will need to make use of the tools described in this chapter, along with others they may find for themselves. NCSU ITD and College of Engineering ITECS supplies as much information as they can about remote access to the campus network and its resources so that students can connect to them easily and securely.

http://www.ncsu.edu/it/essentials/connections_labs/
http://www.eos.ncsu.edu/remoteaccess/

Nearly all students at NCSU own either a desktop or laptop computer, or both. A personal computer has become a standard commodity, and students want to know how to make the best use of them.

To aid students in knowing what baseline specifications their computers should meet in order to run recommended tools and services, the university provides minimum computer specifications and support information at:

http://www.ncsu.edu/it/essentials/your_computer/hardware_specs/

The College of Engineering’s recommendations are at:

http://www.eos.ncsu.edu/soc/

The College of Engineering has also negotiated with vendors to provide excellent educational pricing on selected laptop models, which are available for purchase by any NCSU student, faculty or staff, see http://www.eos.ncsu.edu/soc/purchasing/.

Other colleges also have recommendations about student-owned computers that students in those colleges need to be aware of. Consult the web sites or IT staff of the college you are in.
## Command Summary

The following tables provide many commands and tools used on Eos/Unity.

### Table 6: Common UNIX Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>alias alias oldname</td>
<td>make an alias or shorter form of a command, path, etc. (e.g., alias dir ls lets you type dir not ls)</td>
</tr>
<tr>
<td>unalias alias</td>
<td>make an alias or shorter form of a command, path, etc. (e.g., alias dir ls lets you type dir not ls)</td>
</tr>
<tr>
<td>cat</td>
<td>display, concatenate, or merge files together</td>
</tr>
<tr>
<td>compress file</td>
<td>make a file smaller (a .Z extension is added)</td>
</tr>
<tr>
<td>uncompress file</td>
<td>restore file to original size</td>
</tr>
<tr>
<td>cp sourcefile targetfile</td>
<td>copy a file to a new file or location</td>
</tr>
<tr>
<td>date</td>
<td>print current date and time</td>
</tr>
<tr>
<td>diff file1 file2</td>
<td>compare the contents of files or groups of files</td>
</tr>
<tr>
<td>du</td>
<td>summarize disk usage</td>
</tr>
<tr>
<td>exit</td>
<td>close a terminal (Xterm) window</td>
</tr>
<tr>
<td>find</td>
<td>find files in a directory hierarchy</td>
</tr>
<tr>
<td>grep string</td>
<td>search a file for a pattern</td>
</tr>
<tr>
<td>head file</td>
<td>display first ten lines of a file</td>
</tr>
<tr>
<td>tail file</td>
<td>display last ten lines of a file</td>
</tr>
<tr>
<td>history</td>
<td>list all commands used in a session</td>
</tr>
<tr>
<td>more file</td>
<td>display contents of a file</td>
</tr>
<tr>
<td>less file</td>
<td>display contents of a file</td>
</tr>
<tr>
<td>ls</td>
<td>list the contents of a directory</td>
</tr>
<tr>
<td>logout</td>
<td>log user out of workstation</td>
</tr>
<tr>
<td>man command</td>
<td>show UNIX manual page for the named command</td>
</tr>
<tr>
<td>mv oldname newname</td>
<td>rename a file</td>
</tr>
<tr>
<td>mv sourcefile target</td>
<td>move a file from one location to another</td>
</tr>
</tbody>
</table>
### Table 6: Common UNIX Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>ps -e</td>
<td>list all processes running by process ID number (PID)</td>
</tr>
<tr>
<td>kill pid</td>
<td>end a process</td>
</tr>
<tr>
<td>pwd</td>
<td>display path of working or current directory</td>
</tr>
<tr>
<td>rm file</td>
<td>remove a file; file cannot be restored if removed</td>
</tr>
<tr>
<td>sort file</td>
<td>sort file data</td>
</tr>
<tr>
<td>spell file</td>
<td>list all misspelled words in a file</td>
</tr>
</tbody>
</table>

### Table 7: Directory Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>add software</td>
<td>load an application, e.g., add matlab</td>
</tr>
<tr>
<td>attach directory</td>
<td>map a directory to the shorter /ncsu path, e.g., attach e115 (cd /ncsu/e115/ replaces cd /afs/eos/courses/e/e115/)</td>
</tr>
<tr>
<td>mkdir directory</td>
<td>create a directory with the name you provide</td>
</tr>
<tr>
<td>cd directory</td>
<td>change into a directory. cd .. goes up one level and cd ~ takes user to his/her home directory.</td>
</tr>
<tr>
<td>rmdir directory</td>
<td>remove a directory (directory must be empty of all files)</td>
</tr>
<tr>
<td>realmlocate directory</td>
<td>find a directory, e.g., realmlocate matlab</td>
</tr>
</tbody>
</table>

### Table 8: Print Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>add acrobat</td>
<td>add the Adobe Acrobat distiller program</td>
</tr>
<tr>
<td>distill file.ps file.pdf</td>
<td>convert a PostScript file into PDF</td>
</tr>
<tr>
<td>lpq</td>
<td>list jobs in the print queue</td>
</tr>
<tr>
<td>lpquota</td>
<td>opens browser to <a href="http://print.ncsu.edu">http://print.ncsu.edu</a></td>
</tr>
<tr>
<td>lpr file</td>
<td>print a file</td>
</tr>
<tr>
<td>lprm job#</td>
<td>remove a print job from the printer queue</td>
</tr>
</tbody>
</table>
### Table 9: AFS Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Alias</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>fs listacl</code></td>
<td><code>fs la</code></td>
<td>lists access control list for a directory</td>
</tr>
<tr>
<td><code>fs setacl</code></td>
<td></td>
<td>sets access control list for a directory, who has rights and what they are (rlidwka)</td>
</tr>
<tr>
<td><code>fs help</code></td>
<td><code>fs h</code></td>
<td>help on other <code>fs</code> commands</td>
</tr>
<tr>
<td><code>fs examine</code></td>
<td><code>fs exa</code></td>
<td>lists volume information</td>
</tr>
<tr>
<td><code>fs whereis</code></td>
<td><code>fs whe</code></td>
<td>lists file server on which volume is stored</td>
</tr>
<tr>
<td><code>fs quota</code></td>
<td><code>fs lq</code></td>
<td>lists volume quota and usage</td>
</tr>
<tr>
<td><code>pts adduser</code></td>
<td><code>pts ad</code></td>
<td>adds a member to a group</td>
</tr>
<tr>
<td><code>pts creategroup</code></td>
<td><code>pts cg</code></td>
<td>creates a group (owner:group)</td>
</tr>
<tr>
<td><code>pts delete</code></td>
<td><code>pts del</code></td>
<td>deletes a group</td>
</tr>
<tr>
<td><code>pts examine</code></td>
<td><code>pts e</code></td>
<td>lists who owns and created group</td>
</tr>
<tr>
<td><code>pts membership</code></td>
<td><code>pts m</code></td>
<td>lists all groups in which user is a member</td>
</tr>
<tr>
<td><code>pts removeuser</code></td>
<td><code>pts r</code></td>
<td>removes a member from a group</td>
</tr>
</tbody>
</table>

### Table 10: Common Local Commands and Tools

<table>
<thead>
<tr>
<th>Command</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>add</code></td>
<td>display a list of applications on the workstation</td>
</tr>
<tr>
<td><code>add application</code></td>
<td>load an application, e.g., <code>add matlab</code></td>
</tr>
<tr>
<td><code>help</code></td>
<td>open web browser to Help Desk, <a href="http://help.ncsu.edu">http://help.ncsu.edu</a></td>
</tr>
<tr>
<td><code>hes user</code></td>
<td>query Hesiod for user information</td>
</tr>
<tr>
<td><code>hes application</code></td>
<td>query Hesiod for location of application</td>
</tr>
<tr>
<td><code>kreset</code></td>
<td>reauthenticate and renew Kerberos session tickets</td>
</tr>
<tr>
<td><code>library</code></td>
<td>open web browser to NCSU Libraries, <a href="http://www.lib.ncsu.edu">http://www.lib.ncsu.edu</a></td>
</tr>
<tr>
<td><code>nedit</code></td>
<td>open an easy-to-use text editor</td>
</tr>
<tr>
<td><code>password</code></td>
<td>open browser to <a href="http://www.ncsu.edu/password">http://www.ncsu.edu/password</a> to change password</td>
</tr>
<tr>
<td>Command</td>
<td>Meaning</td>
</tr>
<tr>
<td>----------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>policy</td>
<td>open browser to <a href="http://www.ncsu.edu/it/rulesregs">http://www.ncsu.edu/it/rulesregs</a> for computing policies</td>
</tr>
<tr>
<td>quota</td>
<td>list home directory (volume) quota and usage</td>
</tr>
<tr>
<td>whois</td>
<td>whois lastname, firstname locates user information</td>
</tr>
<tr>
<td>string</td>
<td></td>
</tr>
<tr>
<td>xterm</td>
<td>open an Xterm terminal window</td>
</tr>
<tr>
<td>xv</td>
<td>open image manipulation program</td>
</tr>
</tbody>
</table>
**B Application Software: What Runs Where?**

The application software listed in this appendix is installed in campus Unity labs and engineering Eos labs. Additional software is available in realm-configured labs in other departments and colleges. Check with those units for software not listed here, see [http://www.ncsu.edu/it/essentials/connections_labs](http://www.ncsu.edu/it/essentials/connections_labs).

**Vendor, Version, License, and Platform**

The information presented here for Fall 2006 is the best information that was available at the time of publication. For current information about applications, see:

- [http://www.ncsu.edu/it/essentials/software_ncstate/](http://www.ncsu.edu/it/essentials/software_ncstate/)
- [http://www.eos.ncsu.edu/software/](http://www.eos.ncsu.edu/software/)

New this year are applications available in the Virtual Computing Lab (VCL) at [http://vcl.ncsu.edu](http://vcl.ncsu.edu).

**Table 11: Eos/Unity Application Software: Vendor, Version, License, and Platform**

<table>
<thead>
<tr>
<th>Application Software</th>
<th>Vendor</th>
<th>Version</th>
<th>License</th>
<th>Win</th>
<th>Solaris</th>
<th>Linux</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Database (in VCL)</td>
<td>Microsoft</td>
<td>2003</td>
<td>NCSU</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Acrobat PDF Publisher</td>
<td>Adobe</td>
<td>7.0 Pro</td>
<td>NCSU</td>
<td>*</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ADAMS Mechanical Simulation</td>
<td>MSC</td>
<td>2003</td>
<td>Engr</td>
<td>*</td>
<td>12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adobe Creative Suite 2</td>
<td>Adobe</td>
<td>CS2</td>
<td>NCSU</td>
<td>*</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AMPL Modeling Language</td>
<td>ILOG</td>
<td>9.0</td>
<td>Engr</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>ANSYS Finite Element Analysis</td>
<td>Mallett</td>
<td>9.0</td>
<td>Engr</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>ArcInfo GIS (in VCL)</td>
<td>ESRI</td>
<td>9.1</td>
<td>NCSU</td>
<td>*</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ArcView GIS</td>
<td>ESRI</td>
<td>3.3, 3.2</td>
<td>NCSU</td>
<td>*</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Arena Simulation</td>
<td>Rockwell</td>
<td>10</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AspenONE (VCL only)</td>
<td>AspenTech</td>
<td>2004.1</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AutoCAD (in VCL)</td>
<td>Autodesk</td>
<td>2006</td>
<td>NCSU</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Automod Simulation Software</td>
<td>Brooks</td>
<td>12</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AVR Studio Microcontroller Dev. C</td>
<td>Atmel</td>
<td>3.53</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C Cadence Circuit Design</td>
<td>Cadence</td>
<td>2004</td>
<td>Engr</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td></td>
</tr>
</tbody>
</table>
### Table 11: Eos/Unity Application Software: Vendor, Version, License, and Platform

<table>
<thead>
<tr>
<th>Application Software</th>
<th>Vendor</th>
<th>Version</th>
<th>License</th>
<th>Win</th>
<th>Solaris</th>
<th>Linux</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>CADRA Computer-Aided Design</td>
<td>Softech</td>
<td>11</td>
<td>Engr</td>
<td>*</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COMSOL Multiphysics (VCL only)</td>
<td>COMSOL</td>
<td>3.2b</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>COSMOS Design Analysis (in VCL)</td>
<td>SolidWorks</td>
<td>2006-07</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CPLEX Linear Optimizer</td>
<td>ILOG</td>
<td>9.0</td>
<td>Engr</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>Data Explorer Visualization</td>
<td>IBM</td>
<td>3.1</td>
<td>NCSU</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dreamweaver Web Editor</td>
<td>Adobe</td>
<td>8</td>
<td>NCSU</td>
<td>*</td>
<td></td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>Excel Spreadsheet</td>
<td>Microsoft</td>
<td>2003</td>
<td>NCSU</td>
<td></td>
<td></td>
<td></td>
<td>*</td>
</tr>
<tr>
<td>Fireworks Web Graphics</td>
<td>Adobe</td>
<td>8</td>
<td>NCSU</td>
<td></td>
<td></td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>Flash Web Animation</td>
<td>Adobe</td>
<td>8</td>
<td>NCSU</td>
<td></td>
<td></td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>Fortran 90/95 Compilers</td>
<td>NAG</td>
<td>5.0</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>Framemaker Publisher</td>
<td>Adobe</td>
<td>7.0</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>HSPICE Circuit Simulator</td>
<td>Synopsys</td>
<td>2005.09</td>
<td>Engr</td>
<td>*</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ICPP Interactive Chemical Process</td>
<td>Felder</td>
<td>3.0</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Java Development Kit (JDK)</td>
<td>Sun</td>
<td>5.0</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>JMP Statistical Discovery (in VCL)</td>
<td>SAS</td>
<td>6.0</td>
<td>NCSU</td>
<td></td>
<td></td>
<td></td>
<td>*</td>
</tr>
<tr>
<td>LIFT for Dreamweaver</td>
<td>UsableNet</td>
<td>2.1</td>
<td>NCSU</td>
<td></td>
<td></td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>Lindo Optimization</td>
<td>LINDO</td>
<td>6.1</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lingo Modeling</td>
<td>LINDO</td>
<td>6.0</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LSF Load-Sharing Batch Facility</td>
<td>Platform</td>
<td>5.0</td>
<td>NCSU</td>
<td></td>
<td></td>
<td></td>
<td>*</td>
</tr>
<tr>
<td>Maple Symbolic Math (in VCL)</td>
<td>Maplesoft</td>
<td>10.0.2</td>
<td>NCSU</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>Mathcad Calculation (in VCL)</td>
<td>Mathsoft</td>
<td>12.1</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mathematica</td>
<td>Wolfram</td>
<td>5.2</td>
<td>NCSU</td>
<td>*</td>
<td></td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>MathType Equation Editor for Office</td>
<td>Design Sci.</td>
<td>5.2</td>
<td>Stat</td>
<td>*</td>
<td></td>
<td>5.1</td>
<td></td>
</tr>
<tr>
<td>MATLAB and Toolboxes (in VCL)</td>
<td>Mathworks</td>
<td>7.2R2006a</td>
<td>NCSU</td>
<td>*</td>
<td></td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>Microstation CAD</td>
<td>Bentley</td>
<td>V8 2004</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Moldflow Plastics Advisers</td>
<td>Moldflow</td>
<td>7.3</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NExS Engineering Spreadsheet</td>
<td>GreyTrout</td>
<td>1.6</td>
<td>Engr</td>
<td>*</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Office XP Applications</td>
<td>Microsoft</td>
<td>2003</td>
<td>NCSU</td>
<td></td>
<td></td>
<td></td>
<td>*</td>
</tr>
</tbody>
</table>
Table 11: Eos/Unity Application Software: Vendor, Version, License, and Platform

<table>
<thead>
<tr>
<th>Application Software</th>
<th>Vendor</th>
<th>Version</th>
<th>License</th>
<th>Win</th>
<th>Solaris</th>
<th>Linux</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPNET Network Modeler (in VCL)</td>
<td>OPNET</td>
<td>11.5</td>
<td>Engr</td>
<td>*</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Photoshop Image Design</td>
<td>Adobe</td>
<td>CS2</td>
<td>NCSU</td>
<td>*</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PowerPoint Presentation</td>
<td>Microsoft</td>
<td>2003</td>
<td>NCSU</td>
<td>*</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Primavera Project Mgmt. (VCL only)</td>
<td>Primavera</td>
<td>4.1</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pro/Engineer Wildfire CAD Project</td>
<td>PTC</td>
<td>3.0</td>
<td>Engr</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>RSLogix Logic Prog. (in VCL)</td>
<td>Rockwell</td>
<td>500</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAS Data Analysis (in VCL)</td>
<td>SAS</td>
<td>9.1.3</td>
<td>NCSU</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>SlickEdit Editor</td>
<td>SlickEdit</td>
<td>11</td>
<td>Engr</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>SolidWorks CAD (in VCL)</td>
<td>SolidWorks</td>
<td>2006-07</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>StarOffice Applications</td>
<td>Sun</td>
<td>7.0</td>
<td>NCSU</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>SuperPro Designer (in VCL)</td>
<td>Intelligen</td>
<td>6.0</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SURFCAM Velocity II</td>
<td>Surfware</td>
<td>II</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Symantec AntiVirus</td>
<td>Symantec</td>
<td>9.0.3</td>
<td>NCSU</td>
<td>*</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Synopsys Digital Circuit Synthesis</td>
<td>Synopsys</td>
<td>2006.06</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tecplot Interactive Plotting</td>
<td>Tecplot</td>
<td>10</td>
<td>Engr</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>Timberline Estimating (VCL only)</td>
<td>Sage</td>
<td>7.1.3</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TK Solver Equation Solver</td>
<td>UTS</td>
<td>4.0</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Visio Professional (in VCL)</td>
<td>Microsoft</td>
<td>2003</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VisualAge Smalltalk Language</td>
<td>IBM</td>
<td>5.5.2</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Visual MODFLOW Groundwater</td>
<td>Waterloo</td>
<td>Pro 3.0</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Visual Studio .NET</td>
<td>Microsoft</td>
<td>2003</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WaterCAD Computer-Aided Design</td>
<td>Haestad</td>
<td>6.5</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Word Document Publisher</td>
<td>Microsoft</td>
<td>2003</td>
<td>NCSU</td>
<td>*</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>X-Win32 X Windows App Server All Solaris &amp; Linux apps can be run in Windows labs via X-Win32</td>
<td>Starnet</td>
<td>7.1</td>
<td>Engr</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Version 2006-07 Guide to Eos and Unity Computing
Description, Availability, and Instructions for Use

The following are descriptions of software applications on Eos/Unity, with instructions for launching each application on the specific lab platforms that run it.

Windows applications are generally located in the Novell Application Launcher (NAL), either in Unity Applications or Engineering (Eos) Applications, or on the Start menu.

Solaris applications are listed by typing add on the command line. Commands are provided for launching the program. Some of the most used applications are also on the Application Menu, which you bring up by holding down the middle mouse button in the gray background.

Linux applications can be found in the Red Hat Application Launcher, on the Start menu (Red Hat icon), and by typing add.

Mac applications are easy to find and launch in the Unity Mac lab environment (there are no Macs in Eos labs), so no special instructions were needed in the catalog that follows. Use the table above to identify the Mac applications in Unity labs.

New this year are applications available in the Virtual Computing Lab (VCL) at http://vcl.ncsu.edu, supporting remote access to software from your personal computer.

Important: Consult the software catalogs at http://www.eos.ncsu.edu/software/apps.html and http://www.ncsu.edu/it/essentials/software_ncstate/category_full_list.php for additional information about the individual applications below, including documentation, tutorials, and links to educational resources.

Access Database Management
Microsoft Corporation

For experienced database programmers and first-time database users alike, Microsoft Access provides powerful tools for managing and analyzing data. Access 2003 provides the following capabilities: link tables from other Microsoft Access databases, Microsoft Excel spreadsheets, ODBC data sources, and other data sources; view dependency information--quickly find tables, queries, forms, or reports that depend on a particular database object; and publish forms and reports on the Web and bind your information to a record source to display, update, and work with data from your database. Access 2003 uses a file format that permits modification by Access 2000 and Access 2002.
To run on Windows:

Novell Application Launcher (NAL)
   -> Unity Applications
   -> Office Applications
   -> Access

Also in VCL. Go to http://vcl.ncsu.edu

**Acrobat PDF Publisher**
**Adobe Systems Incorporated**

Adobe Acrobat lets you convert any document to Adobe Portable Document Format (PDF). PDF is a universal file format that preserves the look/layout of any source document, regardless of the application or platform used to create it. PDF files are compact and can be shared and printed by anyone with Adobe Reader. New features of Acrobat 7 Professional include: extended commenting capabilities for users of free Adobe Reader 7; the ability to create PDF forms that look like the paper forms they replace and incorporate business logic, such as calculations and data validations; organization of recently opened Adobe pdf documents; and the ability to attach source documents such as spreadsheets and multimedia files.

To run on Windows:

Novell Application Launcher (NAL)
   -> Unity Applications
   -> Acrobat

To run on Solaris:

```
add acrobat
distill file.ps > file.pdf
```

**ADAMS Mechanical System Simulation**
**MSC Software, Inc.**

ADAMS is mechanical system simulation software with modeling, analysis, and visualization capabilities. It enables users to produce virtual prototypes, realistically simulating the full-motion behavior of complex mechanical systems on their computers and quickly analyzing multiple design variations until an optimal design is achieved. This reduces the number of costly physical prototypes, improves design quality, and dramatically reduces product development time.

To run on Windows: In College of Engineering Eos labs only.
Novell Application Launcher (NAL)
   -> Engineering Applications
   -> Adams

To run on Solaris:
   add adams
   mdi

Adobe Creative Suite 2
Adobe Systems Incorporated

Adobe Creative Suite 2 is a unified design environment that delivers the next level of integration in creative software. New features and tighter integration among suite components simplify creative and production tasks. The CS2 products on campus are GoLive, InDesign, Illustrator, and Photoshop. Other Adobe products in the labs are Acrobat, Framemaker, Dreamweaver, Fireworks, and Flash.

To run on Windows:

Novell Application Launcher (NAL)
   -> Unity Applications
   -> Graphics and WebTools
   -> GoLive, InDesign, Illustrator, Photoshop

AMPL Modeling Language
ILOG, Inc.

AMPL is a comprehensive and powerful algebraic modeling language for linear and nonlinear optimization problems in discrete or continuous variables. It is a computer language for describing production, distribution, blending, scheduling and many other kinds of problems known generally as large-scale optimization or mathematical programming. AMPL's familiar algebraic notation and interactive command environment are designed to help formulate models, communicate with a wide variety of solvers, and examine solutions. AMPL allows modelers to create models with maximum productivity. By using AMPL's natural algebraic notation, even a very large, complex model can often be stated in a concise (often less than one page) understandable form. The AMPL CPLEX System combines the AMPL modeling language with the ILOG CPLEX Simplex Optimizers (see CPLEX).

To run on Windows: In College of Engineering Eos labs only.
Novell Application Launcher (NAL)
   -> Engineering Applications
   -> AMPL

To run on Solaris and Linux:

   add ilog
   ampl

ANSYS Finite Element Analysis
Mallett Technology, Inc.

ANSYS is a tool for analyzing finite-element engineering problems. Sample applications found in test programs include thermodynamic analysis (heat transfer, cooling analysis, temperature gradients, thermal responses) and structural analysis (torsion computation, vibration, stress analysis on various substances, elasticity). The package includes solid modeling/meshing, 3-D graphics, quality-analysis tools, and more.

To run on Windows: In College of Engineering Eos labs only.

Novell Application Launcher (NAL)
   -> Engineering Applications
   -> ANSYS

To run on Solaris and Linux:

   add ansys
   ansys90 -g (GUI)
   ansys90 (command line)

ARC/INFO Geographic Information System Toolkit
Environmental Systems Research Institute (ESRI)

ArcInfo is the most complete and extensible GIS available. It includes all the functionality of ArcView and ArcEditor and adds advanced geoprocessing and data conversion capabilities. Professional GIS users use ArcInfo for all aspects of data building, modeling, analysis, and map display for screen and output. A complete GIS out of the box, ArcInfo provides all the functionality for creating and managing an intelligent GIS.

To run on Windows:
Novell Application Launcher (NAL)
  -> Unity Applications
  -> GIS
  -> ArcInfo

**To run on Solaris:**

```
adarcinfo9
arc
arcdoc (to bring up documentation)
```

**ArcView Geographic Information System Toolkit**  
**Environmental Systems Research Institute (ESRI)**

ArcView is full-featured GIS software for visualizing, analyzing, creating, and managing data with a geographic component. Most data has a component that can be tied to a place: an address, postal code, global positioning system location, census block, city, region, country, or other location. ArcView allows you to visualize, explore, and analyze this data, revealing patterns, relationships, and trends that are not readily apparent in databases, spreadsheets, or statistical packages.

**To run on Windows:**

Novell Application Launcher (NAL)
  -> Unity Applications
  -> GIS
  -> ArcView

**To run on Solaris:**

```
ad arcview
arcview32
```

**ARENA Simulation System**  
**Rockwell Software, Inc.**

The Arena graphics simulation system is a complete and flexible modeling environment combined with an easy-to-use graphical user interface. It is designed for building computer models that accurately represent an existing or proposed application. Arena integrates all simulation-related functions--animation, input data analysis, model verification, and output analysis--into a single simulation modeling environment. New features of Arena 10 include the ability to place
multiple module connections during a single connection session, new options for the right-click menu, and assignable tank sensor locations.

**To run on Windows:** In College of Engineering Eos labs only.

Novell Application Launcher (NAL)
  -> Engineering Applications
  -> Arena

**AspenONE Engineering Suite**
**Aspen Technology, Inc.**

AspenONE solutions provide process manufacturers with a full complement of integrated software solutions, professional services, and program management. AspenONE enables them to move toward real-time management and decision making, and improve their operations based on a new set of capabilities that provide: an ability to monitor and analyze operational KPIs, perform root cause analysis and leverage models to facilitate optimal decision making; an ability to synchronize manufacturing plans with supply chain processes based on accurate insight into plant capabilities; and, an ability to detect and respond to unanticipated manufacturing and supply chain problems and opportunities.

**Not available in labs.**

AspenONE is available to specific classes via VCL.
Go to [http://vcl.ncsu.edu](http://vcl.ncsu.edu)

**AutoCAD Computer-Aided Design**
**Autodesk, Inc.**

AutoCAD is an industry-standard design and drafting package for the creation and manipulation of 2-D and 3-D line drawings and images. New features of AutoCAD 2006 include: the new dynamic blocks capability that allows you to quickly create, manipulate, and extract data from blocks; Mtext command and enhanced table features for creating and editing text and automatically updating table calculations; an enhanced user interface; and customizable tool palettes. View the AutoCAD 2006 Features and Benefits document for additional information. [http://images.autodesk.com/adsk/files/AutoCAD2006_FB.pdf](http://images.autodesk.com/adsk/files/AutoCAD2006_FB.pdf)

**To run on Windows:**

Novell Application Launcher (NAL)
  -> Unity Applications
-> CAD and Modeling
-> AutoCAD

Also in VCL. Go to http://vcl.ncsu.edu

**AutoMod Simulation Software**
**Brooks Automation, Inc.**

The AutoMod suite of simulation tools provides an environment for building highly accurate models for analysis and development, as well as for control system emulation. There are no limitations on model size, complexity, or level of detail for operational rules. AutoMod includes templates for accurate modeling of material movement, whether by conveyor, lift truck, operator, overhead crane, or automated vehicle. These templates give the user unlimited flexibility for movement modeling, and also help speed up model construction without compromising accuracy.

**To run on Windows:** In College of Engineering Eos labs only.

Novell Application Launcher (NAL)
-> Engineering Applications
-> AutoMod

**AVR Studio Microcontroller Development**
**Atmel Corporation**

AVR Studio is an Integrated Development Tool for the AVR family of microcontrollers. It enables the user to control execution of programs on the built-in AVR Instruction Set Simulator, or on an AVR In-Circuit Emulator. AVR Studio supports source-level execution of Assembly programs assembled with the AVR Assembler and other assemblers and compilers that support either UBROF or COFF as their object file format.

**To run on Windows:** In College of Engineering Eos labs only.

Novell Application Launcher (NAL)
-> Engineering Applications
-> Programming Tools
-> AVR Studio
Cadence Circuit Design Toolkit  
Cadence Design Systems, Inc.

Cadence is a collection of digital and analog electronic design and simulation tools. Cadence provides products and solutions for every aspect of electronic design and is used by the leading semiconductor, computer system, communications equipment, and consumer electronic companies in the world. It is a very powerful and large package and only runs on higher performance workstations.

**To run on Solaris and Linux:**

```
add cadence
various
cdsdoc -help (to bring up documentation)
```

CADRA Computer-Aided Design  
SofTech, Inc.

The CADRA family of CAD/CAM products includes CADRA Design Drafting a fast and highly productive mechanical design documentation tool; CADRA NC, a comprehensive 2 through 5 axis NC programming application; CADRA integration with SolidWorks, an integrated drawing production system and a 3D solid modeler. The CADRA family is rounded out by an extensive collection of translators and software options which make it a seamless fit into today's multi-platform and multi-application organizations.

**To run on Windows:** In College of Engineering Eos labs only.

Novell Application Launcher (NAL)  
- > Engineering Applications  
- > CADRA

**To run on Solaris:**

```
add cadra
cdra
```

COMSOL Multiphysics (formerly FEMLAB)  
COMSOL, Inc.

COMSOL Multiphysics is a modeling package for the simulation of any physical process you can describe with partial differential equations (PDEs). The Chemical Engineering Module deals with the couplings of fluid flow, diffusion and reaction processes as well as heat transport couplings found in systems of interest to
chemical engineers. The Electromagnetics Module gives users a comprehensive design and modeling tool for simulating systems and devices in the areas of electromagnetic fields and waves. It allows anyone to quickly and easily define and solve models in RF and microwave engineering, AC and DC electromagnetics, and even optics and photonics. COMSOL Script provides an interactive command-line interface that has all the modeling capabilities of COMSOL Multiphysics. This scripting language allows you to take complex COMSOL Multiphysics models built with the graphical user interface and save them as a script model M-file. COMSOL Script provides access to every COMSOL Multiphysics command-line function plus adds more than 500 commands for numerical analysis and visualization.

Not available in labs.

COMSOL Multiphysics is available to specific classes via VCL
Go to http://vcl.ncsu.edu

COSMOS Design Analysis for SolidWorks
SolidWorks Corporation

The COSMOS Design Analysis tools for SolidWorks include COSMOSWorks, COSMOSMotion, and FloWorks. COSMOSWorks is a finite element analysis program that allows you to analyze, optimize and revise designs without leaving the SolidWorks environment. You can define analysis inputs such as material, restraints, loads, mesh size, contact resistance, and geometric dimension as parameters or parametric equations. COSMOSMotion is a kinematics and motion analysis tool. It enables engineers to size motors/actuators, determine power consumption, layout linkages, develop cams, understand gear drives, size springs/dampers, and determine how contacting parts behave. COSMOSFloWorks is used for computational fluid dynamics and thermal analysis. You can conduct flow and heat transfer simulations on virtual prototypes. It gives you insight into parts or assemblies related to fluid flow of heat transfer and forces on immersed or surrounding solids.

To run on Windows:

Novell Application Launcher (NAL)
  -> Unity Applications
  -> CAD and Modeling
  -> SolidWorks

Also in VCL. Go to http://vcl.ncsu.edu
CPLEX Linear Optimizer  
ILOG, Inc.

ILOG CPLEX delivers high-performance, robust, flexible optimizers for solving linear, mixed-integer and quadratic programming problems in mission-critical resource allocation applications. Virtually every leading end-user and software provider in supply chain planning, telecommunication network design, and transportation logistics relies on the solving power of ILOG CPLEX. ILOG CPLEX solves problems with millions of constraints and variables, and consistently sets new records for mathematical programming software performance. The AMPL CPLEX System combines the AMPL modeling language with the ILOG CPLEX Simplex Optimizers (see AMPL).

To run on Windows: In College of Engineering Eos labs only.

Novell Application Launcher (NAL)
   -> Engineering Applications
   -> CPLEX

To run on Solaris and Linux:

   add ilog
cplex

Data Explorer Visualization and Analysis  
IBM, Inc.

Data Explorer (DX) is a full-featured graphical visualization tool used to analyze datasets. The DX graphical user interface allows end users to perform tasks at various levels of sophistication. For example, a user can use the user interface to apply data and adjust input values to an existing visualization process. A slightly more advanced user can construct a new visualization process, called a visual program, by connecting a network of DX modules. An expert programmer can create new modules, using C or FORTRAN, for use with the system modules. Besides the user interface, DX also provides a scripting language interface for users who want to build their own visualization functions in a more traditional programming style.

To run on Solaris:

   add dx
dx
Dreamweaver Web Editor
Adobe Systems Incorporated

Dreamweaver 8 is the industry-leading web development tool, enabling users to efficiently design, develop and maintain standards-based websites and applications. With Dreamweaver 8, web developers go from start to finish, creating and maintaining basic websites to advanced applications that support best practices and the latest technologies. Use a world-class design and code editor in one tool. Drag and drop Flash Video into Dreamweaver 8 to quickly incorporate video to websites and applications. The unified CSS panel provides a powerful and easy way to understand the cascade of styles applied to content as well as quick access to making changes without having to navigate a lot of code through trial and error. Simply point a web page to an XML file or a URL of an XML feed and Dreamweaver will introspect it to enable dragging and dropping the appropriate fields onto the page. The LIFT plug-in for Dreamweaver is also available to aid in the development of accessible content. It simplifies the process of compliance with W3C and Section 508 guidelines (see LIFT).

To run on Windows:

Novell Application Launcher (NAL)
   -> Unity Applications
   -> Graphics and WebTools
   -> Dreamweaver

Excel Spreadsheet
Microsoft Corporation

Microsoft Excel spreadsheet allows you to create, analyze, and share important data. Smart tags and task panes simplify common tasks, and collaborative enhancements streamline the information-review process. Data-recovery features protect work, and refreshable queries allow you to integrate live data from the Web or any other source. Excel 2003 offers enhancements in collinearity detection, calculations of sum of squared deviations, normal distributions and continuous probability distribution functions.

To run on Windows:

Novell Application Launcher (NAL)
   -> Unity Applications
   -> Office Applications
   -> Excel
Fireworks Web Graphics
Adobe Systems Incorporated

Fireworks 8 lets you balance maximum image quality with minimum compression size as you create, edit and optimize images for the web with precise control. Create animated rollovers and pop-up menus with Fireworks 8's intuitive visual tools, and utilize round-trip editing capabilities with Dreamweaver 8 and Flash Professional 8 for greater efficiency. Take creative control with seamless vector and bitmap editing in an integrated environment. Make graphics look their best under any delivery scenario with optimization features like export, preview, cross-platform gamma preview, and selective JPG compression. Slice up a Fireworks page layout and export the entire page, or selected slices (including graphics, HTML, and code for rollover effects) to an HTML editor (such as Dreamweaver or Microsoft FrontPage). Automatically generate graphics and JavaScript for buttons, interactive interfaces, and pop-up menus without learning how to write code.

To run on Windows:

Novell Application Launcher (NAL)
  -> Unity Applications
  -> Graphics and WebTools
  -> Fireworks

Flash Web Animation
Adobe Systems Incorporated

Flash Professional 8 is the industry's most advanced authoring environment for creating interactive websites, digital experiences and mobile content. With Flash Professional 8, you can design and author interactive content rich with video, graphics, and animation for engaging websites, presentations or mobile content.

To run on Windows:

Novell Application Launcher (NAL)
  -> Unity Applications
  -> Graphics and WebTools
  -> Flash

FORTRAN 90 and 95 NAGware Compilers
Numerical Algorithms Group (NAG)

The NAGWare f95 Compiler is derived from the world's first Fortran 90 Compiler from NAG. Available on a wide range of Unix and Windows platforms it accepts
fixed or free format Fortran 95 input, and many common Fortran 77 extensions are allowed. HPF code is also compiled and checked though only single processor output is generated. Release 5.0 brings further innovations and refinements in the areas of error detection, improved performance and more Fortran 2003 features. Fortran 2003 features include new object-oriented programming features of extensible types, polymorphic variables and type selection. Release 5.0 new features include: a new debugger with a graphical user interface; object-oriented programming support from the draft Fortran 2003 standard; other new features from the Fortran 2003 draft; revised and improved memory tracing facilities; additional checking facilities; and performance enhancements for complex intrinsic functions and array operations and array intrinsic functions.

**To run on Windows:** In College of Engineering Eos labs only.

Novell Application Launcher (NAL)
- > Engineering Applications
- > Programming Tools
- > NAGWare Fortran 95

**To run on Solaris and Linux:**

add nagf95
f95 source_file {options.....}

**FrameMaker Word Processor and Publisher**
Adobe Systems Incorporated

Adobe FrameMaker is an enterprise multi-channel publishing package that combines word processing with XML in a WYSIWYG authoring environment. You can author in either an unstructured word-processing and style-tagging mode, or in a fully structured environment optimized for the editing and production of valid XML. FrameMaker specializes in long-document support that includes book management features, sophisticated templates, equation-editing, and rich formatting options. It supports high-quality printing, the latest Adobe Portable Document Format (PDF) standards, and integration of Scalable Vector Graphics (SVG).

**To run on Windows:** In College of Engineering Eos labs only.

Novell Application Launcher (NAL)
- > Engineering Applications
- > Framemaker

**To run on Solaris:**
HSPICE Electronic Circuit Simulator
Synopsys, Inc.

HSPICE offers a high-accuracy circuit simulation environment that combines the most accurate and validated integrated circuit (IC) device models with advanced simulation and analysis algorithms. As IC geometries continue to shrink, the need for an accurate circuit simulator is critical. Designers require a highly accurate circuit simulator to precisely predict the timing, power consumption, and functionality of their designs. HSPICE provides the industry's most trusted and comprehensive circuit simulator engine and device models. HSPICE's simulator engine has been successfully used to design over one-million integrated circuits. Its advanced circuit simulation algorithms provide HSPICE with convergence characteristics that are superior to other tools. In addition to all basic SPICE models, a partial list of advanced models for HSPICE includes: MOSFETs--All revisions of BSIM3, BSIM4, Philips MOS9/11, EKV, and HiSIM; Bipolar transistors--All revisions of VBIC-95/99, MEXTRAM, HiCUM, MODELLA, and UCSD-HBT; Field effect transistors--Materka, Curtice, Statz, and TriQuint TOM1/2/3; Silicon on Insulator (SOI)--BSIM SOI 3.1 PD/FD/DD, UF-SOI, and SOSFET; Thin film transistors--All revisions of RPITFT and HP amorphous-Si; Special devices--Junction varactors, silicon MOS interface, IC resistors, and capacitors.

To run on Solaris and Linux:

```add synopsys_hspice
awaves (waveform view, Solaris only)
hspice (spice simulator)```

Interactive Chemical Process Principles
Richard M. Felder and Ronald W. Rousseau

Interactive Chemical Process Principles (ICPP) is a guide and toolkit for students taking the introductory chemical engineering course (material and energy balances), and it also contains reference materials that should be useful throughout the chemical engineering curriculum. It has been designed to accompany the text Elementary Principles of Chemical Processes by Richard M. Felder and Ronald W. Rousseau (3rd Edition, John Wiley & Sons, 2000). ICPP has the following components: 1. Tutorials. A set of six interactive instructional tutorials to be worked through at different points in the introductory course; 2. Physical Property Tables.
An on-line tabulation of many of the physical properties of chemical species (e.g., specific gravities, melting and boiling points, enthalpies, and latent heats) needed in the solution of many text problems; 3. E-Z Solve. A program for solving sets of algebraic or ordinary differential equations; 4. Visual Encyclopedia of Chemical Engineering Equipment. Pictures and descriptions of heat exchangers, process units referred to in the text and the chapter-end problems; 5. Index of Learning Styles. A self-scoring instrument to help students identify their preferences on four dimensions of learning style, and understand the strengths and potential difficulties associated with their preferences.

To run on Windows: In College of Engineering Eos labs only.

Novell Application Launcher (NAL)
  -> Engineering Applications
  -> ICPP

Java Development Kit (JDK)
Sun Microsystems, Inc.

Java(tm) 2 Platform, Standard Edition (J2SE) provides a complete, secure foundation for building and deploying network-centric enterprise applications ranging from the PC desktop computer up to the workgroup server. The JavaTM 2 Platform, Standard Edition (J2SE) has revolutionized computing with the introduction of a stable, secure and feature-complete development and deployment environment designed from the ground up for the Web. It provides cross-platform compatibility, safe network delivery, and smartcard to supercomputer scalability. It provides software developers with a platform for rapid application development and cross-platform compatibility, making it possible to deliver products to market in Internet time.

To run on Windows:

Novell Application Launcher (NAL)
  -> Engineering Applications
  -> Programming Tools
  -> Java Development Kit

To run on Solaris and Linux:

    add jdk50
    cd /ncsu/jdk50/bin
JMP Statistical Discovery Software
SAS Institute, Inc.

JMP (pronounced "jump") is a highly interactive environment for statistical visualization and exploratory data analysis. JMP presents statistics in an easily understood graphical environment. Data tables are presented clearly in spreadsheet form and are dynamically linked to related graphs and tables. JMP offers capabilities for performing univariate statistics, analysis of variance and multiple regression, nonlinear fitting, multivariate analysis, and nonparametric tests. It also features integrated capabilities for quality improvement and design of experiments, offering five types of classical designs for estimating the effect of one or more factors on a dependent variable. JMP also provides a variety of graphical tools designed for quality control, including Shewhart control charts and Pareto charts. New features of version 6 include data management features to streamline data analysis, control charts, and new graphics platforms. Additional descriptions of the new features can be found on the JMP 6 New Features page, http://www.jmp.com/software/jmp6new.shtml. The ABC Statistics Guide provides an alphabetical list of features, updated for version 6.0, http://www.jmp.com/support/abcguide/.

To run on Windows:

Novell Application Launcher (NAL)
  -> Unity Applications
    -> Math, Statistics, and Physics
    -> JMP

Also in VCL. Go to http://vcl.ncsu.edu

LIFT for Dreamweaver
UsableNet, Inc.

LIFT is a plug-in for Dreamweaver that aids in the development of accessible content. It simplifies the process of compliance with W3C and Section 508 guidelines. Monitor mode can be used to automatically evaluate web pages. The Fix Wizard helps you fix images, tables, forms, and more by providing a step-by-step tool to guide you through creating accessible content.

To run on Windows:

Novell Application Launcher (NAL)
  -> Unity Applications
    -> Graphics and WebTools
-> Dreamweaver

A LIFT menu is available in Dreamweaver 8

**LINDO/LINGO Optimization**  
**LINDO Systems, Inc.**

HyperLINDO is an interactive package designed to solve linear, quadratic and integer programming problems, evaluate the appropriateness of the results, make minor modifications to the data or parameters, and retest to obtain optimum output. As a general-purpose LP, QP, and IP optimizer, it recognizes general integer variables (not just 0/1), free variables, and bounded variables. LINGO is a language for developing large structured models. It is a general-purpose modeling language and optimizer with a built-in text editor. LINGO recognizes subscripted variables, sets, operations over sets, and general mathematical expressions. Commonly used trigonometric, mathematical, and statistical functions are also built in.

**To run on Windows:** In College of Engineering Eos labs only.

Novell Application Launcher (NAL)
-> Engineering Applications
-> Lindo
-> Lingo

**LSF Load-Sharing Facility**  
**Platform Computing, Inc.**

The LSF Suite (Load Sharing Facility) provides background batch processing for Eos/Unity. It is an industry-standard set of integrated products that transforms a distributed network into a single shared computing resource for robust load sharing and batch scheduling. Use LSF if you need to run long calculation-intensive programs that take longer to complete than you can remain in the lab; if your programs run longer than your AFS tokens and Kerberos tickets last and you must `kreset` often; or, if you have to lock the workstation in order to leave it for X number of hours while the program runs. Submit your job to LSF batch servers to automatically keep your AFS tokens and Kerberos tickets renewed until your program is complete. LSF will e-mail you when your program has completed with any output it has created. If your program saves all of its output to a file, the file can be created in your AFS file space. The e-mail will show any output that normally goes to the screen and will indicate to you whether your program run was successful.

**To run on Solaris:**
Maple Symbolic Math Computation
Maplesoft, a division of Waterloo Maple, Inc.

Maple is a comprehensive computer system for advanced mathematics. It includes facilities for interactive algebra, calculus, discrete mathematics, graphics, numerical computation and many other areas of mathematics. It also provides a unique environment for rapid development of mathematical programs using its vast library of built-in functions and operations.

To run on Windows:

Novell Application Launcher (NAL)
   -> Unity Applications
   -> Math, Statistics, and Physics
   -> Maple

To run on Solaris and Linux:

   add maple100
   xmaple

Also in VCL. Go to http://vcl.ncsu.edu

Mathcad Calculation and Documentation
Mathsoft, Inc.

Mathcad is an integrated environment for performing and communicating math-related work. Features include: Math operator display options for equals, partial derivatives, multiplication, assignments, and more; differential algebraic equation solving functions; over 17 arithmetic, 12 vector and matrix operators, and 4 summations and products operators, as well as customized user-defined operator support; and image manipulation functionality (zoom/pan/crop, brightness/contrast, rotate/flip/transpose, etc.)

To run on Windows: In College of Engineering Eos labs only.

Novell Application Launcher (NAL)
   -> Engineering Applications
   -> Mathcad

Also in VCL. Go to http://vcl.ncsu.edu
Mathematica  
Wolfram Research, Inc.

Mathematica seamlessly integrates a numeric and symbolic computational engine, graphics system, programming language, documentation system, and advanced connectivity to other applications. Uses include: handling complex symbolic calculations that often involve hundreds of thousands or millions of terms; loading, analyzing, and visualizing data; solving equations, differential equations, and minimization problems numerically or symbolically; doing numerical modeling and simulations, ranging from simple control systems to galaxy collisions, financial derivatives, complex biological systems, chemical reactions, environmental impact studies, and magnetic fields in particle accelerators; producing professional-quality, interactive technical reports or papers for electronic or print distribution; illustrating mathematical or scientific concepts for students from K-12 to postgraduate levels; typesetting technical information—for example, for U.S. patents. New features of version 5.2 include 64-bit computing, support for threading of numerical linear algebra over multiple-CPU or multicore computers, and new algorithms for symbolic differential equations that improve solvability of higher-order linear differential equations.

To run on Windows:

Novell Application Launcher (NAL)  
-> Unity Applications  
-> Math, Statistics, and Physics  
-> Mathematica

To run on Solaris and Linux:

add mathematica
mathematica

MathType Equation Editor for Office  
Design Science, Inc.

MathType is the professional version of the equation editor in MS Office. It will let you create a wider range of equations for a wider range of documents. MathType includes MathPage technology that enables you to transform an entire Word document into a web page with equations that print and display in any modern Windows, Macintosh, Unix or Linux browser.

To run on Windows:
MATLAB Numerical Matrix Computation
The MathWorks, Inc.

MATLAB is a high-performance language for technical computing. It integrates computation, visualization, and programming in an easy-to-use environment where problems and solutions are expressed in familiar mathematical notation. Typical uses include math and computation, algorithm development, modeling, simulation, prototyping, data analysis, visualization, scientific and engineering graphics, and application development, including Graphical User Interface building. MATLAB features a family of application-specific solutions called toolboxes. Toolboxes are comprehensive collections of MATLAB functions (M-files) that extend the MATLAB environment to solve particular classes of problems. Areas in which toolboxes are available include signal processing, control systems, neural networks, fuzzy logic, wavelets, simulation, and many others. Matlab 7.2 new features include new editing features in the Matlab editor; new regular expression features, including evaluation of MATLAB expressions to perform dynamic matching or replacing of text; and integration of the M-Lint code analyzer with the MATLAB Editor, providing continuous code checking and recommendations for improving performance and maintainability.

To run on Windows:

Novell Application Launcher (NAL)
   -> Unity Applications
   -> Math, Statistics, and Physics
   -> Matlab

To run on Solaris and Linux:

    add matlab72

    matlab

Also in VCL. Go to http://vcl.ncsu.edu
**Microstation**  
**Bentley Systems, Inc.**

Microstation is a comprehensive platform that enables architects and engineers to design, build, and operate a diverse range of infrastructure projects. It provides a comprehensive set of surface, solid, and mesh modeling and manipulation tools, as well as a broad range of rendering choices. It has multiple raster image support and multiple image display within one design file.

**To run on Windows:** In College of Engineering Eos labs only.

Novell Application Launcher (NAL)  
-> Engineering Applications  
-> Microstation

**Moldflow Plastics Advisers**  
**Moldflow Corporation**

Moldflow Plastics Advisers tools provide injection molding simulation and enable users to predict and solve injection molding manufacturing problems. The Moldflow Part Adviser module is a plastics flow simulation tool used to optimize part designs and check the impact of critical design decisions on the manufacturability and quality of the product. Users can work directly from 3D solid CAD models without the need to create or view a finite element mesh. If Moldflow Part Adviser analysis results identify design issues, the program provides design advice to help users address those issues. Moldflow Mold Adviser extends simulation capabilities beyond the part cavity to allow mold designers to create and optimize gate and runner systems for single cavity, multi-cavity and family molds.

**To run on Windows:** In College of Engineering Eos labs only.

Novell Application Launcher (NAL)  
-> Engineering Applications  
-> Mold Adviser  
-> Part Adviser

**NExS Scientific and Engineering Spreadsheet**  
**GreyTrout, Inc.**

NExS is an advanced spreadsheet designed specifically for the X Windows environment. It has an intuitive user interface and requires only a few keystrokes or mouse clicks to analyze data and present the results with graphs ranging from simple line plots to 3D surfaces. The NExS spreadsheet provides a flexible visual
environment in which to handle complex calculations and data manipulations. It calculates a full range of mathematical, statistical, matrix and string functions, all with the ease of a familiar spreadsheet format with point-and-click screen displays and pull-down menus. NExS is a step up to live action, capable of sending and receiving data and commands from other X Windows programs, even on other computers, and automatically recalculating sheets and graphs to reflect the changes. This capability allows NExS to monitor and display data from multiple sources as it is calculated and to pass this information to other programs in a real-time environment. Using the NExS application program interface (API), a client/server application can be fully integrated with the spreadsheet, appearing to the user as a single unified application. This Connections API lets a program remotely control all aspects of the spreadsheet, including drawing graphs, printing, and calculating.

**To run on Solaris and Linux:**

```bash
add nens
nens
```

**Office XP**

**Microsoft Corporation**

The world's leading suite of productivity software, Microsoft Office helps you complete common business tasks, including word processing, presentations, data management and analysis. Features like smart tags, task panes, document recovery, and send for review can help you work smarter. It includes Access, Excel, PowerPoint, Publisher, and Word.

**To run on Windows:**

Novell Application Launcher (NAL)

- Unity Applications
- Office Applications

**OPNET Network Management and Modeling**

**OPNET Technologies, Inc.**

OPNET software embeds expert knowledge about how network devices, network protocols, applications, and servers operate. This intelligence enables users in network operations, engineering, planning, and application development to optimize performance and availability of their networks and applications. Modeler is used for design and analysis of networks, network equipment, and communications pro-
Wireless Module extends the functionality of OPNET Modeler with high-fidelity modeling, simulation, and analysis of wireless networks. The MPLS specialized model offers performance predictions of networks that incorporate MPLS technology and traffic engineering policies. The UMTS specialized model is essential for design and operation of cost-efficient UMTS networks.

**To run on Solaris and Linux:**

```bash
add opnet
modeler
```

Also in VCL. Go to [http://vcl.ncsu.edu](http://vcl.ncsu.edu)

**Photoshop CS2 Image Design**

Adobe Systems Incorporated

Adobe Photoshop is the de facto standard for digital image enhancement, photo retouching, and image compositing. Photoshop allows the user to create original artwork, generate realistic or interpretive textures and backgrounds, correct color, retouch and composite scanned images, and prepare professional-quality separations and output for print or the Web. New features of Photoshop CS2 (Creative Suite) include: simplified file handling with Adobe Bridge, the next-generation File Browser, where you can process multiple camera raw images at once; Vanishing Point, which lets you clone, paint, and paste elements that automatically match the perspective of the surrounding image area; and multi-image digital camera raw file processing, to name a few (see Adobe Creative Suite 2).

**To run on Windows:**

Novell Application Launcher (NAL)

- Unity Applications
- Graphics and Web Tools
- Photoshop

**PowerPoint Presentation Graphics**

Microsoft Corporation

With its easy-to-use tools for creating professional presentations, Microsoft PowerPoint transformed the way people communicate ideas. Smart Tags, Task Panes, and improved technologies for working with diagrams, images, animations, and text streamline the process of creating presentations. Collaboration features make it easier to get input and share your final work, while improved data recovery allows you to spend your time creating, not re-creating. New features of PowerPoint 2003
include: preventing recipients from forwarding, copying, or printing important presentations by using information rights management (IRM) functionality; Package for CD that makes it easy to create all the files you need to burn your presentation to a CD and give it to someone else; and improved slide show presentations.

**To run on Windows:**

Novell Application Launcher (NAL)
- Unity Applications
- Office Applications
- PowerPoint

**Primavera Project Planner**  
**Primavera Systems, Inc.**

Primavera Engineering and Construction is a project management solution that provides tools to efficiently control project costs, schedules, procurement, contracts and changes. Primavera provides project schedulers with the basic tools to easily plan and control projects. Schedulers can quickly create optimum project plans, zero in to understand the critical path and easily create “what-if?” projects. Schedulers can examine an activity — and its predecessors and successors — with trace logic. Primavera also includes more than 100 industry standard reports.

**Not available in labs.**

Primavera is available to specific classes via VCL  
Go to [http://vcl.ncsu.edu](http://vcl.ncsu.edu)

**Pro/ENGINEER Wildfire**  
**Pro/MECHANICA Computer-Aided Design**  
**Parametric Technology Corporation**

Pro/ENGINEER Wildfire is a tool for delivering high-quality, accurate digital models. High fidelity digital models have full associativity, so that product changes made anywhere update deliverables everywhere. Pro/ENGINEER Wildfire can help you optimize: conceptual and industrial design; detailed part and assembly design; structural, thermal, and motion simulation/analysis; routed systems design; production planning and execution; and design collaboration. Pro/ENGINEER Simulation Software, powered by MECHANICA technology, provides powerful, scalable and usable analysis and simulation capabilities to enable non-FEA specialist engineers and designers to analyze designs for structural, dynamic, thermal, and durability performance. New features of Wildfire 3.0 include an option for dis-
playing set datums in 3-D, enhanced annotation features, and automatic filleting of corners for high-speed machining.

**To run on Windows:** In College of Engineering Eos labs only.

Novell Application Launcher (NAL)
  -> Engineering Applications
  -> Pro/Engineer Wildfire

**To run on Solaris and Linux:** (Pro/MECHANICA is not available for Linux)

```
add proewildfire30
proe
```

**Project**

**Microsoft Corporation**

Project is an application for planning and managing projects. You can set up projects quickly, assign resources to your tasks or make resource adjustments to resolve conflicts and over-allocations, track schedules, and generate reports. Existing task lists created in Excel 2003 or Outlook 2003 can be converted into project plans with Project 2003.

**To run on Windows:** In College of Engineering Eos labs only.

Novell Application Launcher (NAL)
  -> Engineering Applications
  -> Project

**RSLogix Logic Programming**

**Rockwell Software, Inc.**

The Rockwell Software's RSLogix offers 32-bit flexibility, reliability, and increased productivity to the industrial controls programming world. This software is designed to test and debug your ladder logic programs prior to use. It supports the Allen-Bradley SLC 500 and MicroLogix families of processors and incorporates the latest technologies to maximize performance and save development time.

**To run on Windows:** In College of Engineering Eos labs only.

Novell Application Launcher (NAL)
  -> Engineering Applications
  -> RSLogix

Also in VCL. Go to http://vcl.ncsu.edu
SAS Data Analysis Applications
SAS Institute, Inc.

SAS is an integrated applications system for data access, management, analysis and presentation. Programs within the SAS system may be used in operations research (models of distribution networks, resource allocation problems, scheduling, production systems), report writing and graphics, business forecasting and decision support, project management, and applications development.

To run on Windows:

Novell Application Launcher (NAL)
-> Unity Applications
-> Math, Statistics, and Physics
-> SAS

To run on Solaris:

```
add sas
sas
```

Also in VCL. Go to http://vcl.ncsu.edu

SlickEdit Editor
SlickEdit, Inc.

SlickEdit (renamed from Visual Slickedit) is a multi-platform, multi-language code editor that enables power programmers to create, navigate, modify, and debug code faster and more accurately. New features of version 11 include the ability to define templates, enhanced search and replace features, and comment wrapping.

To run on Windows:

Novell Application Launcher (NAL)
-> Engineering Applications
-> Programming Tools
-> Visual Slickedit

To run on Solaris and Linux:

```
add slickedit
vs
```
SolidWorks Computer-Aided Design
SolidWorks Corporation

SolidWorks, a standard in 3D modeling, is mechanical design automation software that takes advantage of the MS Windows graphical user interface. Mechanical designers can easily sketch out ideas, experiment with features and dimensions, and produce models and detailed drawings. Familiar Windows functions like drag-and-drop, point-and-click, and cut-and-paste allow you to create 3D models from existing 2D data with the best available transition tools. Design communication capabilities, including eDrawings, help you share 2D and 3D product design information.

To run on Windows:

Novell Application Launcher (NAL)
-> Unity Applications
-> CAD and Modeling
-> SolidWorks

Also in VCL. Go to http://vcl.ncsu.edu

StarOffice Office Applications
Sun Microsystems, Inc.

StarOffice software is an affordable alternative in office productivity suites that runs on multiple operating systems, including Solaris, Microsoft Windows, and Linux. The office suite has a simple, easy-to-use interface and contains full-featured applications, including word processing, spreadsheet, presentation, graphics and database capabilities. It is Sun's enhanced and supported version of the open-source software, OpenOffice. New features of StarOffice 7 include enhanced interoperability with MS Office applications, export capability to pdf format, enhanced accessibility features, and support for assistive technologies.

To run on Windows: In College of Engineering Eos labs only.

Novell Application Launcher (NAL)
-> Engineering Applications
-> StarOffice

To run on Solaris and Linux:

add staroffice
various
SuperPro Designer
Intelligen, Inc.

SuperPro Designer is a tool for engineers and scientists in process development, process engineering, and manufacturing that facilitates modeling, evaluation and optimization of integrated processes. It includes an extensive chemical component and mixture database and extensive equipment and resource databases. New features in version 6 include the ability to generate a fully-customizable process description commonly referred to as "batch sheet," new unit procedures for secondary pharmaceutical manufacturing, and an enhanced interface for specifying stoichiometry of reactions. A complete description of new features may be found at http://www.intelligen.com/superpro_newfeatures.shtml

To run on Windows: In College of Engineering Eos labs only.

Novell Application Launcher (NAL)
    -> Engineering Applications
    -> SuperPro Designer

Also in VCL. Go to http://vcl.ncsu.edu

SURFCAM Velocity II CAD/CAM
Surfware, Inc.

SURFCAM computer-aided design/manufacturing (CAD/CAM) software is built for the Microsoft Windows operating system environment. Designers, engineers, and machinists worldwide use it for 2D and 3D mechanical design, surface modeling, solid modeling, reverse engineering, prototyping, mold-making, pattern-making, and production machining. SURFCAM makes easy CNC programming of 2-, 3-, 4- and 5-axis mills, lathes, wire EDM, laser, plasma and water-jet machines a reality. It generates the toolpaths for computer controlled machines and interfaces with SolidWorks.

To run on Windows: In College of Engineering Eos labs only.

Novell Application Launcher (NAL)
    -> Engineering Applications
    -> SurfCAM
Symantec Norton AntiVirus Corporate Edition
Symantec Corporation

Symantec's Norton AntiVirus Solution provides anti-virus protection for individual systems up to large wide area networks. The scalable Symantec System Center management console offers real-time communication with clients and servers from a single point, allowing convenient distribution of new virus definition sets. It also scans and cleans instant message attachments as well as email messages.

Synopsys Digital Circuit Synthesis - University Tools
Synopsys, Inc.

Synopsys is a digital electronic circuit synthesis tool. It transforms a functional (register-transfer level) description of a module into a gate-level netlist. The Synopsys Design Analyzer is the graphic interface to the Synopsys family of synthesis tools. There is also a command-line interface, called dc_shell, in which you enter UNIX-style commands, arguments, and options.

To run on Solaris:

```
add synopsys
various
```

Tecplot Interactive Plotting
Tecplot, Inc.

Tecplot is a versatile and powerful interactive software package for visualizing technical data. With Tecplot, you can create XY plots, contour plots, vector plots, mesh plots, carpet plots, 3D stream ribbons, isosurfaces, light-source-shaded surfaces, etc. You can also visualize complex data defined in one, two, or three dimensions, or on its original non-rectangular grid (e.g., multi-block, curvilinear, triangular, quadrilateral, 8-node bricks, and tetrahedral), preserving its original variation of grid resolution and retaining exact grid boundaries. Version 10 includes new capabilities in plotting, data management, and the user interface.

To run on Windows: In College of Engineering Eos labs only.

Novell Application Launcher (NAL)
-> Engineering Applications
  -> Tecplot

To run on Solaris and Linux:
**Timberline Estimating Software**  
**Sage Software**

Timberline Estimating Software is a comprehensive package of tools for automating the estimating process. The Timberline Commercial Knowledgebase is included and contains pre-built models and comprehensive Smart Assemblies backed by RSMeans cost data. The application includes bill of material classes, Smart Assemblies, and thousands of items in industry-specific databases, such as Pre-Construction, Commercial GC, Commercial HVAC, and Residential Home Builder.

**Not available in labs.**

Timberline is available to specific classes via VCL  
Go to [http://vcl.ncsu.edu](http://vcl.ncsu.edu)

**TK Solver Plus Equation Solver**  
**Universal Technical Systems, Inc.**

TK is a rule-based declarative environment for creating mathematical models and solving them multidirectionally. It is a mathematical modeling tool for calculating, designing, testing and troubleshooting; a rule-based declarative programming environment; and a Web applications development tool which integrates well with databases, CAD/3-D solid modeling, Visual Basic "front ends," HTML or other hypertext environments, multimedia, and other tools to form Web-ready interactive knowledge bases for design, engineering, management and marketing.

**To run on Windows:** In College of Engineering Eos labs only.

Novell Application Launcher (NAL)  
- Engineering Applications  
- TKSolver

**Visio Professional**  
**Microsoft Corporation**

Visio is used to create professional looking diagrams. Its technical drawing tools handle the diagramming needs of engineers—simple to complex, rough to precise, general to specialized. Visio helps you define and visualize ideas, information, and systems. Visio 2003 enables easy assembly of diagrams through dragging pre-
defined Microsoft SmartShapes symbols coupled with powerful search capabilities to locate the right shape, whether it is on a computer or the Web.

**To run on Windows:** In College of Engineering Eos labs only.

Novell Application Launcher (NAL)
- -> Engineering Applications
- -> Visio

Also in VCL. Go to [http://vcl.ncsu.edu](http://vcl.ncsu.edu)

**VisualAge Smalltalk**
**IBM, Inc.**

VisualAge Smalltalk, IBM's award-winning enterprise application development tool, enables software developers to create highly portable, scaleable, multi-tier business applications using object-oriented technology. VisualAge Smalltalk also provides tools for application modeling and development, a robust persistence framework, and the ability to integrate existing legacy systems. VisualAge Smalltalk combines the power of a pure object-oriented environment with the ease of visual programming, adding B2B support through the new XML parser, a new level of VisualAge for Java integration, enhanced WebSphere integration, and the addition of the new Advanced Database feature for higher performance with DB2 applications. It enables enterprises to quickly construct line-of-business applications that are portable, highly scaleable, simple to maintain, and fit easily into existing infrastructures.

**To run on Windows:** In College of Engineering Eos labs only.

Novell Application Launcher (NAL)
- -> Engineering Applications
- -> Programming Tools
- -> Smalltalk

**Visual MODFLOW Pro**
**Waterloo Hydrogeologic, Inc.**

Visual MODFLOW Pro is a 3-D groundwater flow and contaminant transport modeling application. It includes MODFLOW, MODPATH, MT3DMS, RT3D, automatic model calibration using WinPEST, and built-in 3D visualization and animation using the Visual MODFLOW 3D-Explorer. The interface contains a logical menu structure that guides you through the steps required to build, calibrate and evaluate a groundwater flow and contaminant transport model. New features of
version 3.0 include support for MODFLOW-2000, the latest development by the USGS for running flow simulations, and Stream Routing Package (STR), used to simulate the interaction between surface streams and groundwater.

To run on Windows: In College of Engineering Eos labs only.

Novell Application Launcher (NAL)
  -> Engineering Applications
  -> Visual MODFLOW Pro

Visual Studio .NET Application Development
Microsoft Corporation

Visual Studio .NET is a development tool for creating the next generation of applications. It is a development environment built from the ground up for XML Web services. By allowing applications to share data over the Internet, XML Web services enable developers to assemble applications from new and existing code, regardless of platform, programming language, or object model.

To run on Windows: In College of Engineering Eos labs only.

Novell Application Launcher (NAL)
  -> Engineering Applications
  -> Programming Tools
  -> Visual Studio

WaterCAD Computer-Aided Design
Haested Methods

WaterCAD is a complete geographic information management system that enables engineers and decision makers to analyze and manage distribution networks. It provides a modeling environment for building the pipe network from scratch or using existing data sources. Models can be created, edited, and calculated within the GIS environment. WaterCAD provides the tools to conduct and manage constituent analysis. Reporting, graphics, and animation features are also included in the application.

To run on Windows: In College of Engineering Eos labs only.

Novell Application Launcher (NAL)
  -> Engineering Applications
  -> WaterCAD
**Word Document Processor**  
**Microsoft Corporation**

One of the most powerful programs ever built for creating documents, Microsoft Word is an important reason why Office is the world's most popular office productivity suite. New features of MS Word 2003 include: the ability to control distribution of sensitive documents using information rights management (IRM) functionality; enhanced mark-up features that make comments more visible and offer better ways to help you track and merge changes and read comments; and the Research task pane that brings electronic dictionaries, thesauri, and online research sites into Word 2003 so that you can quickly find information and incorporate it into your documents.

**To run on Windows:**

Novell Application Launcher (NAL)  
- Unity Applications  
- Office Applications  
- Word

**X-WIN32 X Windows Application Server**  
**Starnet Communications**

X-Win32 is StarNet's X terminal application for Windows desktop platforms--including Windows 95, 98, ME, XP, NT4.0, and 2000. It is similar to Hummingbird's eXceed program. X-Win32 allows Windows users to connect to campus remote-access servers and display full windowed Linux/Solaris applications back to their Windows machines. The applications are running remotely, but you interact with them on your Windows desktop just like you were sitting in front of a Solaris or Linux workstation in an Eos computer lab. X-Win32 can display multiple X applications with full graphical user interface, so you are not restricted to working from the command line. It also permits copying and pasting data between X and Windows applications. Two downloads are necessary: W-Win32 and PuTTY. You need to download and install PuTTY for SSH-encrypted access to Eos remote-access servers before you can use X-Win32.

**To run on Windows:** In College of Engineering Eos labs only.

Novell Application Launcher (NAL)  
- Engineering Applications  
- X-Win32 (Solaris remote access)
Glossary of Terms for Eos/Unity Computing

access control list (acl)  
a list that specifies what access privileges users have to a directory, specifically, the right to lookup, insert, delete, read, write, lock, or administer files in a directory (abbreviated as l, i, d, r, w, k, a).

alias  
an alternate name or abbreviation (usually short and easy to remember) that substitutes for a pathname, command, list, or expression (usually long and hard to remember).

Andrew File System (afs)  
a distributed file system that distributes, stores, and joins files on networked computers. It is a client-server architecture for file sharing, location independence, scalability, and transparent migration capabilities for data. Full AFS Glossary on p. 125.

argument  
information the shell needs to perform a command, usually the file(s) or entity that will be affected by a command. In a command statement, the argument follows the command, e.g., delete file, where delete is the command and file is the argument.

ASCII  
American Standard Code for Information Interchange, a standard computer code used to facilitate the exchange of information on various types of data-processing equipment. Files are produced in or converted to ASCII code to make them easier to move into or out of software applications running on different machines.

Athena Project  
the joint project of MIT, Digital Equipment Corporation, and IBM in the 1980s that developed a distributed academic network for the MIT campus.

authentication  
the recognition of a user as having a valid account on the system with legitimate access to its resources, usually determined during login by username and password.

background process (bg)  
program that runs without interfering with command entry and processing taking place in other windows. The & character added after a command will run that process in the background.

cache manager  
a program on a client machine that accesses files stored in AFS. When a user requests a file, the cache manager retrieves it from the appropriate file server and stores or "caches" a copy of it on the client workstation's local disk for the user to use.

cache memory  
a mechanism interposed in the memory hierarchy between main memory and the CPU to improve effective memory transfer rates and raise processor speeds.

cell  
an independently administered site running AFS and consisting of a collection of file server and client machines defined as belonging to the cell. A machine can belong to only one cell at a time.

client  
a program or machine that performs for a user, requesting files and information from a server program or computer in order to complete its function.
client/server  
a model for distributed network computing that relies on server computers to supply software and services to client computers that request them.

cluster  
a group of client workstations, usually close together, that connect off the same subnet.

command line interface  
terminal-type means for sending commands to the shell and entering data into the computer. The command line is indicated by a symbol, or prompt (e.g., >, %, $), showing the user where to enter commands. Unlike a graphical user interface, this interface requires that commands be typed in and written in a precise syntax in order for them to be interpreted correctly by the shell.

C shell (csh)  
a UNIX shell developed by the University of California at Berkeley

daemon  
a UNIX system task that runs as a background process (usually initiated at system boot time) to perform a particular system function. Common UNIX daemons control spooled printer output, accept incoming telnet requests, activate time-of-day scheduled tasks, etc.

default  
an automatic setting, mode, or action. Usually, there are alternative ways to perform any action in a computer program, but the default action is what will occur automatically if no other alternative is selected.

detached process  
a process that continues to run in the background after the user has logged out. Generally, a detached process is started when a user does not expect the process to finish during a session.

dialog box  
a small window-like box that opens after an operation has been selected. In it, you select options and settings to tailor the operation before it proceeds.

directory  
a special kind of file that points to or contains others files and directories. Directories can be nested to any depth. Some software may refer to directories and subdirectories by other names, such as, folders, lockers, drawers, cabinets, etc.

distributed file system  
a file system that joins together the file systems of individual machines. Files are stored (distributed) on different machines in a computer network but are accessible from all machines.

domain name system  
(DNS) a general-purpose distributed, replicated, data query service chiefly used on Internet for translating hostnames into Internet addresses.

dotfile  
see hidden file.

evironment variables  
global values or settings that determine the default operation of all shells and are also passed on to application programs. Environment variables contain information about your working environment. These are set by system administrators but can be changed by the individual user (printenv and setenv).

Eos  
name of the development project and the distributed AFS-based computing network in the NCSU College of Engineering. The technology is based on the Athena Project technology.
**Ethernet**
Network communications protocol developed and originally marketed by Xerox Corporation. This technology is designed to handle the communication procedures of separate devices, such as word processors, personal computers, file and print servers, etc. Ethernet uses a bus technology, that is, it connects all stations on the network through a single channel of coaxial cable called a bus.

**Executable**
a statement or procedural step in a programming language that calls for processing action by the computer, e.g., performing arithmetic, reading data from an external medium, making a decision, etc. An executable file is a file with its mode is set to executable, making it a file that performs a process rather than simply holding data.

**Expression**
a series of fundamental elements making up a command statement that a compiler can use to produce a value. Expressions have one or more operands and, usually, one or more operators.

**FDDI**
Fiber Distributed Data Interface, a standard for fiber-optics network technology that specifies a 100 Mbs (100 million bits per second) data rate.

**File**
a collection of information stored and retrieved under a single name.

**File server**
a computer used to store files and transfer requested files to client machines. Also, the AFS fs command stands for "file server."

**File system**
a set of many files organized in a hierarchical tree of directories and subdirectories.

**Filter**
a command that reformats or removes unwanted data from its input and writes the rest as output.

**Ftp**
Internet file transfer protocol for transferring files from one computer to another.

**Foreground process (fg)**
a process that engages the terminal so that it cannot be used for anything else until the foreground process has finished running. The shell must wait for the process to finish before prompting for another command.

**Gateway**
a device linking two networks that use different protocols. It accepts all packets from each network addressed to the other, buffers them, converts them to the next format, and re-transmits them to the other network.

**Graphical user interface (GUI)**
picture-based software, such as Windows, that employs window frames, icons, and pointers to interface with files and directories rather than commands. This graphical "front end" or GUI is designed to be easier for the user than issuing commands to the shell via the command line.

**Hesiod**
a name coined by Project Athena for the "name-server" services of the network, which keeps track of resources and translates a request for a logical destination to a physical location. Named after the Greek poet, Hesiod.
hidden file  
a file that does not appear in directory listing, unless the user invokes the -a option, i.e., ls -a. Names of hidden files begin with a period, e.g., .mylogin; also called a dotfile.

home directory (~)  
a directory in a file system owned by a single user and used by that person to store files that s/he creates or copies there. The home directory is the directory the user enters upon login. It is represented by the tilde (~) in commands.

hostname  
the unique name by which a computer is known on a network, used to identify it in electronic mail, web, or other forms of electronic information interchange.

HTML  

http  
Hypertext Transfer Protocol, the client-server TCP/IP protocol used on the World Wide Web for the exchange of HTML documents. It conventionally uses port 80.

hypertext  
information written, organized, and presented in an electronic "document" that has words or pictures linked to other documents. Hypertext is a document with embedded links that when selected connect the user to related text, graphics, or sound file.

icon  
a symbol or small picture on the display screen representing a software application or operation. Typically, a user points to or selects the icon with a pointing device, such as a mouse, to manipulate the program or operation in specific ways.

init process  
a process that begins execution when the system starts up and is responsible for creating login processes that wait for input from terminals. The init process is owned by the superuser and is controlled by the console.

Internet  
a worldwide complex of computer networks, communicating at high speeds using the TCP/IP protocol, which universities, companies, and governments use to exchange information, electronic mail, etc.

Kerberos  
a name coined by Project Athena for the authentication and security services of the network. Kerberos provides workstations and services with encrypted "tickets" to be used when requesting a service on the network. Named after Kerberos in Greek mythology, the three-headed dog that guards the gates of Hades.

kernel  
the central program and core of the operating system responsible for all machine-level work, including connecting to hardware devices. The kernel cannot be modified by the routine user.

LAN, Local Area Network  
a data communications network which is geographically limited (typically to a 1 km radius) allowing easy interconnection of terminals, microprocessors and computers within adjacent buildings. Ethernet and FDDI are examples of standard LANs.

locker  
a directory, often used to mean the collection of a main directory and the subdirectories and files under it.
login id
see username.

man(ual) pages
online reference documentation for UNIX, organized by command into individual pieces or pages of explanation. For example, the command, man ls, brings up the man page on the ls command, which is further subdivided into parts covering the command's name, syntax, description, options, restrictions, etc.

metacharacter
special characters that are not letters or numbers but have special meaning either to the shell or operating system, e.g., > and <, which perform redirection, and |, which "pipes" commands. For a metacharacter to be interpreted literally and not for its special meaning, it must be placed in quotation marks, e.g., ' '< '

mode bits
a set of access rights associated with a file or directory in the UNIX file system, which are shown with the ls -l command. The rights are read, write and execute (r,w,x). AFS combines their effect with AFS access rights in order to determine what type of access someone has to the files.

mount point
a special type of directory that connects a location in the AFS file space with a volume. A mount point looks like a standard UNIX directory. Listing the directory (ls) shows the contents of the volume.

multitasking
able to support the processing of numerous programs and computations at the same time. Programs process concurrently and, thus, more quickly, permitting the easy sharing and movement of data, graphics, and text among windowed applications on the screen.

operating system (os)
software (programs and data) that initiates the interaction of the electronic and electromechanical components of a computer so that they constitute a useful system for carrying out calculations; a set of instructions that tells a computer how to work. The operating system is the means for processing programs and sharing equipment and computer services among users.

operators
symbols that represent processes to be carried out.

option
an argument that controls how the shell executes a command, e.g., in the command ls -l, the -l is an option that tells the shell to do a special kind of directory listing, that is, a long listing of files.

partition
an area of a computer disk used for storage and further subdivided into volumes.

password
a unique, user-defined string of characters validating the user's system identity. The user must correctly enter the password in order to be authenticated by the system.

pathname
the location of a file or directory in the system hierarchy. Files may be referred to by absolute pathname (also called full or complete pathname) or relative pathname. An absolute pathname is the full specification of a path beginning with the root directory ( / ). A relative pathname is the location of the file or directory relative to the directory in which the user is located (the current working directory).

pid
abbreviation for Process Identification Number (see process).
pipe ( | )
used to represent a pipe between two processes in a shell command line.

pipeline
a sequence of one or more shell commands separated by a pipe symbol ( | ). The standard output of each command is sent as standard input to the next command. Each command is run as a separate process, but the shell waits for the whole series to finish before issuing a new prompt.

PostScript
a page description language that codes files for printing on PostScript printers.

process
a program running on a computer. All processes are assigned a unique reference number called a process identification number (PID). Every process on the system has a parent except the init process (see init process). The Task Manager lists processes on Windows. The ps command lists processes on UNIX.

protocol
a set of rules governing the communication and transfer of data between computers.

program
a logical sequence of coded instructions specifying the operations to be performed by a computer in solving a problem or in processing data; or, a series of operations which may be used to control the function of an electronic device.

prompt
a symbol, word, or message that the system displays to tell the user that it is ready for new input or commands, e.g., %, eos%, unity%.

quota
a limit set by a system administrator on such things as disk storage (measured in kilobytes) and printing.

redirection
the process of writing output from a command to a file using the right-angle bracket ( > ), or of reading input for a command from a file using the left-angle bracket ( < ).

remote access
connection to the network from outside the established realm of client and server machines.

root directory (/ )
the top-level directory in the system's directory hierarchy, represented by the "forward slash" symbol ( / ).

router
a dedicated computer that links, translates, and moves data in units called "packets" over networks.

server
a resource-sharing computer that shares its files and provides particular (usually specialized) support services to other computers on a network.

shell
a program that control user interactions with the kernel of the system by interpreting and executing commands. Sometimes called a command interpreter.

shell script
a file of shell commands, also known as a shell program or shell procedure. Files having the # character as the first character are interpreted as C shell scripts.
shell variable
A named storage location that contains a value. A value is assigned to a variable by using the `set` command. Shell variables work like environment variables, except that a set of shell variables is used by a single C shell only, and shell variables do not propagate to new shells or other programs.

standard input
Standard input (stdin) is the input stream into which text or other data can be entered into a program. Certain programs will use the standard input stream as a data source if not given a file to use as input.

standard output
Standard output (stdout) is the output stream into which data are written from a program. Data written to standard output are usually written to the screen unless redirected, such as to a file.

subdirectory
A directory that resides in another directory.

TCP/IP
Transmission Control Protocol/Internet Protocol, the formal rules (protocol) that the Internet uses to support such services as file transfer and mail.

terminal
The combined keyboard and monitor through which the user communicates with the computer system.

token
A set of data that indicates that a user has been authenticated and is authorized to request files and services on the system.

Unity
The NCSU computing environment, a network for distributed computing based on technology originally developed in MIT's Athena Project.

UNIX
A popular and mature operating system (of which there are many versions) that runs on many kinds of computers.

URL
Uniform Resource Locator is a standardized address for a resource (such as a document or image) on the Internet. It can be used to point to files and directories on any machine connected to the network.

username, userid
A short string of characters (usually 8), entered at login, that uniquely identifies a user. Also called the "login ID," the username is the first thing typed into the computer and, together with the password, is used to authenticate user accounts on the system.

variable
A symbol whose value can be set.

vi
A full-screen editor available to UNIX users.

volume
A container that keeps a set of related files and directories together on a disk partition (specific to AFS), e.g., a user's home directory or a course in Wolfware. A volume has its own quota and access control list.

wildcard
A metacharacter that can be used in place of other characters or words in filename arguments. The asterisk (*) and question mark (?) are wildcards.
**working directory**
the directory the user is currently working in. Typically, when users log in, they are placed in their home directories, which would be their working directory. On Solaris/Linux, the command `pwd` (path of working directory) tells what the user's working or current directory is.

**X11**
a network protocol and subroutine library used to create graphic images and windows.

**Zephyr**
a name coined by Project Athena for the rapid user-notification and message service on the system. Zephyr service was discontinued at NCSU on July 5, 2005.

**For AFS Terms**
See *AFS Glossary* on p. 125 of *AFS File Sharing*
# Index

## A
- accessibility 15, 42, 130
- accounts 1
  - activation 1
  - deactivation 1
  - password 17
  - policies 4
  - privileges 2
- Unity ID 3, 17, 19
- AFS 29, 81, 111-126
  - access control list 82, 115, 116, 118, 119, 121, 128
  - cache manager 114
  - cells 21, 30, 112, 144
  - client 158
  - glossary of terms 124
  - mount point 112
  - OpenAFS 124, 159, 160
  - paths 30, 82, 83
  - permissions 29, 82, 83, 115, 116, 118, 119, 121, 127
  - pts groups 119
  - security 115
  - tokens 21, 87, 115
  - user directories 29, 81, 114, 133, 143
  - volumes 29, 30, 82, 112, 114, 121, 133, 144
  - Windows 21, 34, 121
- AntiVirus 69, 71, 73, 74
- applications 37-44, 82, 152, 165-196
  - add 38, 43, 87, 155
  - commercial 44
  - documentation 44
  - Linux 26, 42, 99, 153
  - non-commercial 40, 44
  - realmlocate 40, 43
  - remote access 155
  - Solaris 25, 37, 99, 153
  - verify 42
  - Windows 25, 40

## B
- backup 133-146
- batch computing 157

## C
- client-server computing 111
- copyright 74

## D
- directories 81-92
  - commands 85
    - home 21, 29-36, 81, 83, 85, 112, 114, 121, 128, 133
    - paths 30, 82, 85
    - root 30, 33, 81, 82, 88, 112
    - working 30, 82, 85
- distributed file system 111
- drives
  - A 134
  - C 28, 34, 114, 133
  - CD 133, 139
  - DVD 140
  - floppy 133, 134
  - G 142
  - J 21, 28, 34, 82, 83, 123
  - K 21, 28, 29-36, 34, 83, 85, 121, 123, 133
  - L 21
  - M 21
  - USB 140, 142
  - zip 133, 137

## E
- E115 5, 26, 77, 88
- email 57-70, 80
  - attachments 66, 80
  - class mail 80
  - forwarding 67
  - IMAP 57, 133
  - POP 57
preferred address 66, 80
PureMessage 69
quota 57
smtp 67
spam 68
SquirrelMail 58
Symantec 69
virus 66, 68, 72
Webmail 57

**F**
file transfer 150, 151
files 93-98
backup 143, 144
commands 100
fvwm2 Window Manager 21, 24, 37

**G**
gaim 109
GNOME 21, 26, 99, 140

**H**
Help Desk 4, 74
HTML 130

**I**
interface 23-28
command 25, 27, 30, 92, 97, 99, 152
graphical 23, 25, 26, 34, 81, 92, 97, 99, 152
Linux 26, 34
Solaris 24
Windows 25, 34
Internet Service Provider 149

**L**
labs 11-16, 19
accessibility 15
college, department labs 16
Eos 14, 19, 99
other 15
policies 11, 14
Unity 11, 99, 147
Linux Realm Kit 16m 20, 26, 30, 34, 42, 52, 53, 85-88, 92, 97, 134-142, 151, 153, 165-67
lockers 29, 75, 81, 88
logging in 17, 19-22
logging out 17

**M**
Macintosh, 151, 153, 165-67
man page 105
messaging 109
mtools 134, 136, 138, 142

**N**
Nautilus File Manager 98
Novell 21, 25, 40

**O**
operating system 99

**P**
passwords 3, 17, 19, 21, 72, 73, 146, 151
policies 4, 74, 130, 147
Eos labs 14
Unity labs 11
printing 45-56
Acrobat Distiller 52, 67
Adobe Acrobat 52, 67
cancel print job 48, 54, 56
color 53
conserving quota 56
IOU 49
large-format 53
Linux 46, 52, 53
Portable Document Format 47, 52, 66, 67
PostScript 47
preview 55, 56
print variables 55
print.ncsu.edu 45
queues 48, 54
quota 45, 49, 55
report problems 50
screen capture 53
selected text 54
Solaris 46, 52, 53
to a file 47, 51, 54
Windows 45, 52
WolfCopy 45, 49
WolfPrint 45, 50, 150
processes 39
  background 39, 42
  child 39
  foreground 39, 42
  identification 39
  stopped 39
  Task Manager 42
  Windows 42
PureMessage, 69

Q
quota 6, 20, 29, 49, 57, 82, 112, 114, 121, 133, 134, 146
Quota Manager 6

R
Remedy call-tracking 9
remote access 17, 99, 143, 147-160
Remote Desktop Protocol (RDP) 156, 157
ResNet 74, 147
restore 143-146

S
scanning 53
security 4, 71-74
shell 25, 39, 99, 107, 108, 150
software
  see applications, operating system
Solaris, see UNIX
storage 82, 133-146
sysnews 6

U
UNIX 12, 13, 16, 20, 24, 30, 37-39, 52, 53, 85-88,
User Lookup 6, 20, 57

V
Virtual Computing Lab (VCL) 150, 153, 156-158
virus 42, 66, 68, 69, 72

W
web
  personal pages 32, 89, 127-132
Webmail 58-65
window manager 23, 37
Windows 12, 13, 16, 21, 25, 34, 40-42, 52, 89-91,
  96-97, 151, 154, 165-67
Windows Explorer 134
wireless 147, 148
WolfCall 20, 21, 159
Wolfware 75-80, 82, 150
  class mail 80
courses in 76
courses.ncsu.edu 75
  home page 77
message board 77
submit assignments 78
WRAP 77, 150

X
X Window System 24, 99, 153, 155
X-Win32 155

Z
Zephyr 109